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Safety precautions

The following precautions ensure the proper use of the printer and prevent the printer from being damaged.
Follow these precautions at all times.

e  Usethe power supply voltage specified on the label. Avoid overloading the printer's electrical outlet
with multiple devices.

e  Ensure that the printer is well-grounded. Failure to ground the printer may result in electrical shock, fire
and susceptibility to electromagnetic interference.

e Do not disassemble or repair the printer yourself. Contact your local HP Service Representative for
service, see Contact HP Support on page 163.

e  Use only the electrical cord supplied by HP with the printer. Do not damage, cut or repair the power
cord. A damaged power cord can cause fire or electric shock. Replace a damaged power cord with an HP-
approved power cord.

e Do not allow metal or liquids (except those used in HP Cleaning Kits) to touch the internal parts of the
printer. Doing so may cause fire, electric shock or other serious hazards.

e  Turn off the printer and unplug the power cord from the power outlet in any of the following cases:
° When placing your hands inside the printer
° If there is smoke or an unusual smell coming from the printer
° If the printer is making an unusual noise not heard during normal operation

° A piece of metal or a liquid (not part of cleaning and maintenance routines) touches internal parts
of the printer

° During a thunderstorm

° During a power failure

HP Start-Up Kit

The HP Start-Up Kit is the CD that comes with your printer; it helps you to download the printer’s software
and documentation from the Internet. You need an active Internet connection for this purpose.

Using this document

This document can be downloaded from http://www.hp.com/go/Z5400ps/manuals.

Introduction

This chapter provides a brief introduction to the printer and its documentation for new users.

Use and maintenance
These chapters help you carry out normal printer procedures and include the following topics.

° Installing the software on page 12

Setting up the printer on page 20

Personalizing the printer on page 28

Paper handling on page 33
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° Working with two rolls on page 48

° Printing on page 50

° Web-connected printing on page 64

° Job queue management on page 65

° Color management on page 72

° Practical printing examples on page 83

° Retrieving printer usage information on page 92

° Handling ink cartridges and printheads on page 96

° Maintaining the printer on page 106

Troubleshooting
These chapters help you solve problems that may occur while printing and include the following topics.

° Troubleshooting paper issues on page 117

° Troubleshooting print-quality issues on page 129

° Troubleshooting ink cartridge and printhead issues on page 144

° Troubleshooting general printer issues on page 151

° Front-panel error messages on page 157

Accessories, support and specifications

The chapters Accessories on page 111, HP Customer Care on page 160, and Printer specifications
on page 164 contain reference information, including customer care, the printer specifications and part
numbers for paper types, ink supplies and accessories.

Glossary

The Glossary on page 168 contains definitions of printing and HP terms used in this documentation.

Index

In addition to the table of contents, there is an alphabetical index to help you to find topics quickly.

Warnings and Cautions

The following symbols are used in this manual to ensure the proper use of the printer and to prevent the
printer from being damaged. Follow the instructions marked with these symbols.

/\ WARNING! Failure to follow the guidelines marked with this symbol could result in serious personal injury
or death.

A CAUTION: Failure to follow the guidelines marked with this symbol could result in minor personal injury or
damage to the printer.

ENWW Using this document 3
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The printer’s main features

Your printer is a color inkjet printer designed for printing high-quality images on paper up to 1118 mm (44 in)
wide. Some major features of the printer are shown below:

Print resolution of up to 2400 x 1200 optimized dpi, from a 1200 x 1200 dpi input, using the Best print-
quality option, the Maximum Detail option and photo paper

The printer can be controlled from its front panel or from a remote computer using the Embedded Web
Server or the HP Utility

Touch-sensitive front panel in color, with an intuitive graphical user interface

Job previews in the front panel

Job previews on remote computers

Includes Web-connected features such as automatic firmware updates and HP ePrint

Driverless printing: Files in common graphical formats can be printed directly without needing a printer
driver. Just insert a USB flash drive or connect a laptop computer containing your files.

Paper flexibility and automatic easy load, see Paper handling on page 33, with information and
presets accessible from the front panel and the HP Utility

Handles cut-sheet and roll paper
Six-ink system
Accurate and consistent color reproduction with automatic color calibration

Color emulations, see Printer emulation on page 75

Economode for printing economically

Two rolls loaded at once provide fast and easy switching between different rolls, or long runs of
unattended printing

High productivity features such as job previewing and nesting using the HP Utility or the printer's
Embedded Web Server

Ink and paper usage information available from the Embedded Web Server, see Access the Embedded
Web Server on page 29

Access to the online HP Knowledge Center (see Knowledge Center on page 161)

Chapter 1 Introduction ENWwW



The printer’s main components

The following front and rear views of the printer illustrate the main components.

Front view

1. Inkcartridge

2. Inkcartridge slots

3. Bluelever

4. Window

5. Front panel

6. Printhead carriage

7.  Printhead

8. Outputtray

9. Paper alignment lines

10. Basket

ENWW The printer’'s main components 5



Rear view

1. Roll cover

2. Communication ports
3. Power switch

4. Power socket

5. Spindle

6. Spindle stop

7. Paperroll
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Communication ports

1. Hi-Speed USB device port, to connect a computer
2. Gigabit Ethernet port, to connect to a network
3. Diagnostic LEDs, to be used by service engineers
4. Hi-Speed USB host port, intended for connecting an accessory
There is another Hi-Speed USB host port on the other side of the printer, beside the front panel, intended for
connecting a USB flash drive.
The wall spacers

If you place the printer with its back against a wall, lower the two wall spacers at the rear of the printer to
ensure that the rear of the printer is a minimum distance from the wall. Otherwise, you may experience paper
advance problems.
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The front panel

The front panel is located on the front right of the printer. It gives you complete control of your printer: from
the front panel, you can print, view information about the printer, change printer settings, perform
calibrations and tests, and so on. The front panel also displays alerts (warning and error messages) when
needed.

A Hi-Speed USB host port, intended for connecting a USB flash drive, which can provide files to be
printed. When a USB flash drive is inserted, a USB icon is displayed on the front panel's home
screen.

The front panel itself: a touch-sensitive screen with a graphical user interface.

The Power key, with which you can turn the printer on or off. The key is illuminated when the printer is
on. It flashes when the printer is in transition between on and off.

HP DESIGNIET

e

USB drive Direct print

s < m @

use Jobs Applications

The front panel has a large central area to display dynamic information and icons. On the left and right sides
you can see up to six fixed icons at different times. Normally they are not all displayed at the same time.

Left and right fixed icons

8 Chapter 1

Press [@A] to return to the home screen.

Press [ to view help about the current screen.
Press ] to go to the previous item.

Press[Jto go to the next item.

Press =] to go back to the previous screen. This does not discard any changes made in the current
screen.

Press i to cancel the current process.
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Home screen dynamicicons
The following items are displayed only on the home screen.

®  Press ﬂ to view information about printer status, change printer settings, or initiate actions such as

loading paper or replacing ink supplies. A smaller warning icon appears if there are actions that need to
be performed.

e  Totheright of the above button is a message showing the printer status or the most important current
alert. Press this message to see a list of all current alerts, with an icon indicating the severity of each
alert.

-
Press to print a file from a USB flash drive, or Q to print from a computer. See Printing

on page 50.

®  Press to view information about the USB flash drive(s). This icon appears only when one or more
USB flash drives are inserted.

®  Press E to view and manage the job queue. A smaller warning icon appears if there are jobs on hold.
See Job queue management on page 65.

While a PostScript or PDF job is printing, the Adobe PDF icon nyhg is displayed; pressing it has no effect.

If the printer is left idle for some time, it goes into sleep mode and switches off the front-panel display. To
change the time that elapses before sleep mode, press ﬂ, then , then Setup > Front panel options >
Sleep mode wait time. You can set a time between 1 and 240 minutes; the default time is 30 minutes.

The printer wakes from sleep mode and switches on the front-panel display whenever there is some external
interaction with it.

Information about specific uses of the front panel can be found throughout this document.

Printer software

The following software is provided with your printer:
e  PostScript drivers for Windows, Mac 0S X, and Linux

° HP Instant Printing PRO gives you an easy way to print some specific file types without using an
application or a printer driver

e  The Embedded Web Server and (alternatively) the HP Utility allow you to:
° Manage the printer from a remote computer
° View the status of the ink cartridges, the printheads and the paper

° Access the HP Knowledge Center, see Knowledge Center on page 161

° Update the printer's firmware, see Update the firmware on page 108

° Perform calibrations and troubleshooting
° Submit print jobs

° Manage the job queue, see Job queue management on page 65

° View job accounting information, see Retrieving printer usage information on page 92

ENWW Printer software



° Change various printer settings
° Manage email notifications
° Change permissions and security settings

See Access the Embedded Web Server on page 29 and Access the HP Utility on page 29.

=?NOTE: New versions of all printer software can be expected to appear from time to time. In some cases,
when you receive your printer there may already be later versions available on HP's website of some of the
software provided with it.

Web Services

Your printer can be connected to the Internet and the Web, providing various benefits:

e  Automatic firmware updates (see Update the firmware on page 108)

e  Print to your printer by sending it an email message with the file to be printed as an attachment. PDF,
TIFF, and JPG files are supported.

To take advantage of these benefits, your printer must be connected to the Internet.

For the latest information, see http://www.hp.com/go/designjeteprinters.

Turn the printer on and off

_{}_ TIP: The printer can be left powered on without wasting energy. Leaving it on improves response time and
= overall system reliability. When the printer has not been used for a certain period of time (the default time is
determined by Energy Star), it saves power by going into sleep mode. However, any interaction with the
printer's front-panel display, or sending a new job to print, returns it to active mode, and it can resume
printing immediately. To change the sleep mode time, see Change the sleep mode setting on page 30.

?‘ NOTE: Insleep mode, the printer performs maintenance service to the printheads from time to time. This
avoids long preparation times after long idle periods. Therefore, it is strongly recommended to leave the
printer powered on or in sleep mode to avoid wasting ink and time.

If you wish to turn the printer on or off or reset the printer, the normal and recommended method is to use
the Power key on the front panel.

However, if you plan to store the printer for a long period or the Power key does not seem to work, you are
recommended to turn it off using the power switch at the rear.

'\.\‘
To turn it back on, use the power switch at the rear.

When the printer is powered back on, it takes about three minutes to initialize and check and prepare the
printheads. Preparing the printheads takes about 75 seconds. However, if the printer has been off for six
weeks or more, preparing the printheads could take up to 45 minutes.
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The printer’s internal prints

ENWW

The internal prints give various kinds of information about your printer. They can be requested from the front
panel.

Before requesting any internal print, check that the printer and the paper are ready for printing.

The loaded paper should be at least A3 landscape—420 mm (16.53in) wide—otherwise the print may
be clipped.

The front panel should be displaying the Ready message.

To print any internal print, press i then , then scroll down to Internal prints and press it, then
select the internal print you want. The following internal prints are available.

Demo prints: show some of the capabilities of the printer

° Print drawing demo

° Print rendering demo

° Print GIS map

Configuration: shows all the current front-panel display settings

Usage report: shows estimates of the total number of prints, number of prints by paper type, number of
prints by print-quality option and total amount of ink used per color (the accuracy of these estimates is
not guaranteed)

HP-GL/2 palette: shows the color or grayscale definitions in the currently selected color palette
Service information: provides information needed by service engineers

PostScript font list: shows PostScript fonts available

The printer’s internal prints
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2 Installing the software

° Choose which connection method to use

° Connect the printer to your network

° Connect a computer to the printer by network (Windows)

e  Connect a computer to the printer by USB cable (Windows)

e  Uninstall the printer software (Windows)

e  Connect a computer to the printer by network (Mac 0S X)

e  Connect a computer to the printer by USB cable (Mac 0S X)

e  Uninstall the printer software (Mac 0S X)

12 Chapter 2 Installing the software ENWW



Choose which connection method to use

The following methods can be used to connect your printer.

Connection type Speed Cable length Other factors
Gigabit Ethernet Very fast; varies according  Long: 100 m (328 ft) Requires extra equipment (switches)
to network traffic
Jetdirect print server Moderate; varies Long: 100 m (328 ft) Requires extra equipment (switches)
(optional accessory) according to network
traffic Provides additional features

See http://www.hp.com/go/jetdirect for more
details

Hi-Speed USB Very fast Short: 5m (16 ft) A certified Hi-Speed USB cable is necessary for
reliable communication.

E’%NOTE: The printer provides a single RJ-45 connector port for a network connection. In order to meet Class A

limits, the use of shielded I/0 cables is required.

E”%NOTE: The speed of any network connection depends on all components used in the network, which can

include network interface cards, routers, switches and cables. If any one of these components cannot
operate at high speed, you will have a low-speed connection. The speed of your network connection can also
be affected by the total amount of traffic from other devices on the network.

Connect the printer to your network

The printer is able to configure itself automatically for most networks, in a similar way to any computer in
the same network. The first time you connect it to a network, this process may take a few minutes.

Once the printer has a working network configuration, you can check its network address from the front

panel: press [J[[J then .

Network configuration

For more details about the current network configuration, go to the front panel and press [, then ,

then Connectivity > Network connectivity > Gigabit Ethernet > Modify configuration; or, for Jetdirect,
Connectivity > Network connectivity > Jetdirect EIO > Modify configuration. From here it is possible,
though not normally necessary, to change the settings manually; this can also be done remotely using the
Embedded Web Server or the HP Utility.

_‘{?'_ TIP:  You may find it helpful to print out the full printer network configuration on paper. This can be done

"*" from the front panel: press ) then , then Internal prints > Service information prints > Print

connectivity config. If you do not print out the full network configuration, consider making a note of the
printer's IP address and network name.

If you accidentally misconfigure the printer’s network settings, you can restore the network settings to their
factory values from the front panel: press [J[iJ then , then Connectivity > Network connectivity >

Gigabit Ethernet > Restore factory settings; or, for Jetdirect, Connectivity > Network connectivity >
Jetdirect EI0 > Restore factory settings. Then you must restart the printer. This automatically provides a
working network configuration for most networks. The printer’s other settings remain unchanged.

Choose which connection method to use
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Using IPv6

Your printer supports almost all network connectivity features using IPv6, just as it does using IPv4. To make

full use of IPv6, you may need to connect your printer to an IPv6 network in which there are IPv6 routers and
servers.

In most IPv6 networks, the printer will configure itself automatically as follows, and no user configuration is
necessary:

1.  The printer assigns itself a link-local IPv6 address (which starts with “fe80::").
2. The printer assigns itself stateless IPv6 addresses as indicated to it by any IPv6 routers on the network.

3. If nostateless IPv6 addresses can be assigned, the printer will try to obtain IPv6 addresses using
DHCPv6. It will also do so if the routers instruct it to do so.

The stateless and DHCPv6 IPv6 addresses can be used to access the printer, and in most IPv6 networks this
will be appropriate.

The link-local IPv6 address works only in the local subnet. Although it is possible to access the printer using
this address, it is not recommended.

Itis possible to assign a manual IPv6 address to the printer, using the front panel or the Embedded Web
Server. It is also possible to disable IPv6 completely in the printer. However, it is not possible to disable IPv4
in the printer, and therefore it is not possible to configure the printer as IPv6-only.

= NOTE: In typical IPv6 use, your printer will have multiple IPv6 addresses, although it has only one IPv4
address.

-‘SI}'- TIP: You will generally find it easier to use IPv4 unless you have a specific need to use IPv6.

Most of the current PC operating systems and HP printing and imaging devices have IPv6 enabled by default.

Using IPSec
Your printer supports IPSec.

However, successful IPSec configuration requires advanced network expertise, and is beyond the scope of
this document. For IPSec to work, the printer’s IPSec configuration must exactly match that of the other
devices in your network. Any discrepancy will prevent communication with your printer until the
configuration is corrected or IPSec is disabled. For more information on IPsec configuration, download the file
IPsec_Admin_Guide.pdf from http://www.hp.com/qo/Z5400ps/manuals.

Connect a computer to the printer by network (Windows)

The following instructions apply if you intend to print from software applications using a printer driver. See
Printing on page 50 for alternative ways of printing.

Before you begin, check your equipment:
e  The printer should be set up and on.
e  The Ethernet switch or router should be on and functioning correctly.

e  The printer and the computer should be connected to the network (see Connect the printer to your
network on page 13).

Now you can proceed to install the printer software and connect to your printer.
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Printer software installation

1.

Make a note of the printer's IP address from the front panel (see Access the Embedded Web Server
on page 29).

Insert the HP Start-up Kit CD into your computer. If the CD does not start automatically, run the
setup.exe program in the root folder of the CD.

When the Z5400 window appears on your screen, click Software and then Install.

Your Web browser opens to display the rest of the software installation procedure. You must select
Windows or Mac 0S X software, and choose which specific software you want to install (by default, all of
it).

If your computer fails to find any printers on the network, the Printer Not Found window is displayed, which
helps you to try to find your printer. If you have a firewall in operation; you may have to disable it temporarily
in order to find the printer. You also have the options of searching for the printer by its hostname, IP address
or MAC address.

In some cases, when the printer is not in the same sub-net as the computer, specifying the printer's IP
address may be the only successful option.

Connect a computer to the printer by USB cable (Windows)

You can connect your printer directly to a computer without going through a network, by using the printer's
built-in Hi-Speed USB device port.

:0-TIP: A USB connection may be faster than a network connection, but the cable is limited in length and it is

‘s

" more difficult to share the printer.

E‘/f’NOTE: The use of non-certified USB cables can lead to connectivity problems. Only cables certified by the
USB Implementor's Forum (http://www.usb.org/) should be used with this printer.

Printer software installation

The following instructions apply if you intend to print from software applications using a printer driver. See
Printing on page 50 for alternative ways of printing.

1.

ENWwW

Do not connect the computer to the printer yet. You must first install the printer software on the
computer, as follows.

Insert the HP Start-up Kit CD into your CD drive. If the CD does not start automatically, run the
setup.exe program in the root folder of the CD.

When the Z5400 window appears on your screen, click Software and then Install.

Your Web browser opens to display the rest of the software installation procedure. You must select
Windows or Mac 0S X software, and choose which specific software you want to install (by default, all of
it).

In some cases, you may see a message warning you that the installer would need to communicate
through the firewall in order to search the network for printers. As you have no need to do this, you can
check the box Continue installation without searching the network.

If you see a list of networked printers, select Help me find my printer (including network, USB or
parallel connected printers).

Connect a computer to the printer by USB cable (Windows) 15
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7. Select USB Cable.

|‘__*:"’49N0TE: You can connect your printer and complete the installation later if you prefer. To do so, check
the box marked | want to connect my printer after completing the setup wizard.

8. When prompted to do so, connect your computer to the printer with a certified USB cable. Ensure that
the printer is turned on.

:{;’. TIP: If you would like to share the printer with other people connected to your network, press the Printer
* Properties button in the Ready to Install window, set Printer Name to the name under which the printer will
be shared, then set Shared to Yes.

Printer sharing considerations

e  Any other users sharing your directly connected printer will be able to send print jobs, but will not be
able to receive information from the printer—which affects alerts, status reports, paper management,
administration and troubleshooting.

e Any other users sharing your directly connected printer will be unable to use the printer's own print
preview facility, although the application’s print preview will still be available. See Preview a print
on page 57.

:{?'_ TIP: The best way to share the printer over a network is to connect the printer not to any computer, but to
* the network. See Connect a computer to the printer by network (Windows) on page 14.

Uninstall the printer software (Windows)

Use the Control Panel to uninstall the software, in the same way as you can uninstall any other software.

Connect a computer to the printer by network (Mac 0S X)

You can connect your printer to a network under Mac 0S X by using the following methods:
° Bonjour

e TCP/IP

@’NOTE: The printer does not support AppleTalk.

The following instructions apply if you intend to print from software applications using a printer driver. See
Printing on page 50 for alternative ways of printing.

Before you begin, check your equipment:
e  The printer should be set up and on.
e  The Ethernet switch or router should be on and functioning correctly.

e  The printer and the computer should be connected to the network (see Connect the printer to your
network on page 13).

Now you can proceed to install the printer software and connect to your printer.
Bonjour connection

Go to the front panel and press [JJ[iJ, then 5

]
, then . Note the mDNS service name of your

printer.

2. Insert the HP Start-up Kit CD into your CD drive.
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9.

Open the CD icon on your desktop.
When the Z5400 window appears on your screen, click Software and then Install.

Your Web browser opens to display the rest of the software installation procedure. You must select
Windows or Mac 0S X software, and choose which specific software you want to install (by default, all of
it).

When the software has been installed, the HP Printer Setup Assistant starts automatically, to set up a
connection to your printer. Follow the instructions on your screen.

When you reach the Select Printer screen, look for your printer's mDNS service name (which you noted
in step 1) in the Printer Name column.

e If you find the right name, scroll sideways if necessary to see the Connection Type column, and
check that it shows Bonjour. Then highlight that line. Otherwise, continue searching further down
the list.

e If you cannot find your printer's name with a Bonjour connection type, check the box My printer is
not in the list.

Click Continue.

Continue following the instructions on the screen. When you reach the Printer Queue Created screen,
click Quit to exit, or Create New Queue if you want to connect another printer to the network.

When the HP Printer Setup Assistant has finished, you can remove the CD from the CD drive.

If the printer driver is already installed, the HP Printer Setup Assistant can be run at any time from the CD.

TCP/IP connection

1.  Go to the front panel and make a note of the printer's URL (see Access the Embedded Web Server
on page 29).

2. Insert the HP Start-up Kit CD into your CD drive.

3. Openthe CDicon on your desktop.

4. When the Z5400 window appears on your screen, click Software and then Install.

5. Your Web browser opens to display the rest of the software installation procedure. You must select
Windows or Mac 0S X software, and choose which specific software you want to install (by default, all of
it).

6. When the software has been installed, the HP Printer Setup Assistant starts automatically, to set up a
connection to your printer. Follow the instructions on your screen.

7.  When you reach the Select Printer screen, look for your printer's URL (which you noted in step 1) in the
Printer Name column.

e If you find the right name, scroll sideways if necessary to see the Connection Type column, and
check that it shows IP Printing. Then highlight that line. Otherwise, continue searching further
down the list.

e [f you cannot find your printer's name with an IP Printing connection type, check the box My
printer is not in the list.

Click Continue.

8. Continue following the instructions on the screen. When you reach the Printer Queue Created screen,
click Quit to exit, or Create New Queue if you want to connect another printer to the network.

9. When the HP Printer Setup Assistant has finished, you can remove the CD from the CD drive.

ENWw
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If the printer driver is already installed, the HP Printer Setup Assistant can be run at any time from the CD.

Connect a computer to the printer by USB cable (Mac 0S X)

You can connect your printer directly to a computer without going through a network, by using the printer's
built-in Hi-Speed USB device port.

Printer software installation

The following instructions apply if you intend to print from software applications using a printer driver. See
Printing on page 50 for alternative ways of printing.

1.

2.

6.

1.

Make sure the printer is either turned off, or disconnected from the computer.
Insert the HP Start-up Kit CD into your CD drive.

Open the CD icon on your desktop.

When the Z5400 window appears on your screen, click Software and then Install.

Your Web browser opens to display the rest of the software installation procedure. You must select
Windows or Mac 0S X software, and choose which specific software you want to install (by default, all of
it).

Make sure that the printer is turned on and connected to the computer with a certified USB cable.

E’/{’NOTE: The use of non-certified USB cables can lead to connectivity problems. Only cables certified by

the USB Implementor's Forum (http://www.usb.org/) should be used with this printer.

Shortly afterwards, a print queue is created automatically for your printer.

Sharing the printer

If your computer is connected to a network, you can make your directly connected printer available to other
computers on the same network.

1.

2.

Double-click the System Preferences icon on the Dock menu bar on your desktop.

To enable printer sharing, go Sharing, select Printer Sharing, and then check the printer(s) that you
want to share.

Your printer now automatically appears in the list of shared printers displayed by any other computer
running Mac 0S X and connected to your local network.

Please bear in mind the following considerations.

Any other users wishing to share your printer must install the printer software on their own computers.

Anyone sharing your directly connected printer will be able to send print jobs, but will not be able to
receive information from the printer—which affects alerts, status reports, paper management,
administration and troubleshooting.

You may find that sharing your directly connected printer with other users will slow down your
computer unacceptably.

*A- TIP:  The best way to share the printer over a network is to connect the printer not to any computer, but to

.
]

" the network. See Connect a computer to the printer by network (Mac 0S X) on page 16.

Uninstall the printer software (Mac 0S X)

Open the downloaded software and click Uninstall.
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To delete the print queue, select the Print & Fax dialog from the system preferences. Select the name of the
printer and click the = button.

ENWW Uninstall the printer software (Mac0S X) 19



3 Setting up the printer

° Introduction

e  Setupyour Web-connected printer

° Web Services manual configuration

° Paper suitability options

e  Turn nesting on and off

e  Turnusage information on and off

e  Turn email notifications on and off
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Introduction

This chapter describes various printer settings that the printer administrator may wish to control as soon as a
new printer is assembled and ready for use.

Set up your Web-connected printer

Your printer can connect to the Internet to benefit from the following Web Services (see also Web Services
on page 10):

e  Automatic firmware updates
e  Use HP ePrint to print by email
To set up your printer for Web Services, please follow these steps, explained in more detail below:

1. Make sure that your printer is correctly connected to the Internet.

2. Run the Connectivity Wizard: At the front panel, press [ then , then Connectivity >
Connectivity wizard.

If you cannot find the Connectivity Wizard in the menu, please update your firmware and then try again.

If the Wizard downloads new firmware, the printer may need to restart.

:{?'_ TIP: When the Wizard displays your printer code and email address, you are recommended to make a
* note of them.

3. Ifyou are the printer administrator, you can log in at the HP ePrint Center (http://www.hp.com/go/
eprintcenter) to customize your printer’s email address.

Congratulations, you now have completed Web Services setup. HP ePrint is ready to use.

For the latest information, support, and terms of use of the HP ePrint Center, see http://www.hp.com/go/
eprintcenter.

Web Services manual configuration

The Connectivity Wizard (see Set up your Web-connected printer on page 21) is normally sufficient for Web
Services configuration, but there are also facilities for manual configuration if you wish to use them.

Configure the printer’s Internet connection

You can configure the printer's Internet connection from the Embedded Web Server or from the front panel.

E’%NOTE: If an administrator password has been set, it will be required to change these settings. Thus, the
administrator can prevent the printer from being connected to the Internet, if desired.

e  Inthe Embedded Web Server: select Setup > Internet connection.

®  Using the front panel: press “ then , then Connectivity > Internet connectivity.
The following settings are available:

e  Enable Internet connection: The default value is Yes.

e  Proxy > Enable proxy: Enable or disable a proxy server.

e  Proxy > Address: Enter the proxy address, empty by default.
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Proxy > Primary port: Enter the proxy port number, zero by default.

Proxy > Restore factory settings: Return to the initial default settings.

If you have trouble with your Internet connection, see Cannot connect to the Internet on page 154.

Configure firmware updates

You can choose from the Embedded Web Server or from the front panel whether and how to download
firmware updates.

?‘ NOTE: If an administrator password has been set, it will be required to change these settings.

In the Embedded Web Server: select Setup > Firmware update.

Using the front panel: press [, then , then Updates > Firmware update.

The following settings are available:

Check: If you select Automatically (the default setting), the printer will check automatically every week
(or after the printer has been restarted seven times, whichever happens first) whether new firmware is
available. If you select Manually, the printer will not check automatically; you can check manually
whenever you like.

Download: If you select Automatically (the default setting), the printer will automatically download
new firmware whenever it becomes available. If you select Manually, you will be asked to approve each
download.

E‘%"NOTE: Downloading the firmware does not mean that you have installed it in your printer. To install

the new firmware, you must confirm the installation manually.

Firmware update information: Information about the firmware currently installed

Firmware update history: A list of firmware versions that have been installed in the printer. It is usually
possible to reinstall the version immediately before the version that is currently installed, if you have
some problem with the current version.

Set remote printing preferences

At the front panel, press “ then , then Setup > Printing preferences to define the default
properties of jobs sent to your printer from remote locations.

Printer margins: Choose between Clip from contents and Add to content.
Color: Choose between Color and Grayscale printing.
Print quality: Choose between Best, Normal, and Fast.

Roll: Choose between Roll 1, Roll 2, and Save paper, which automatically chooses the narrowest roll on
which the print will fit.

Jobs: Choose between On hold and Direct print. By default, jobs from the cloud are On hold. If you
choose Direct print, the front panel will not ask for permission before printing.
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Paper suitability options

Paper mismatch action

If the paper currently loaded in the printer is not suitable for a particular job, the printer can either put the job
on hold until some suitable paper is loaded, or it can ignore the problem and print the job on the unsuitable
paper. There are several ways in which the loaded paper may be considered unsuitable:

e  The paper type is not as specified for the job
e  The papersource (roll 1, roll 2 or sheet) is not as specified for the job
e  The paper size is smaller than specified for the job

You can set the printer's behavior in such cases from the front panel.

®  Press [ then , then Setup > Job management options > Paper mismatch action > Print

anyway if you want such jobs to print on whatever paper is loaded. This is the default option when
printing from a software application or from the Embedded Web Server; but it does not work when
printing from a USB flash drive, nor when copying.

®  Press [ then , then Setup > Job management options > Paper mismatch action > Put job on
hold if you want such jobs to be put on hold. The printer will send an alert whenever a job is put on hold.

When a job is put on hold for paper, it is kept in the printer queue until some suitable paper is loaded (in
which case, all jobs waiting for that paper type can be printed). Meanwhile, other jobs with different
requirements can continue printing.

Roll switching options

If two rolls are loaded, both of which are suitable for the job, the roll will be chosen according to your
preferences. These can be set from the front panel: press [J[[J then , then Setup > Printing
preferences > Paper options > Roll switching options.

e  Minimize paper waste. If this option is chosen, the printer will choose the narrowest roll that meets all
the criteria, to avoid wasting paper due to trimming. This is the default option.

e  Minimizeroll changes. If this option is chosen, the printer will choose the roll that is currently active, to
avoid wasting time with a roll switch.

e  Use roll with less paper. If this option is chosen, the printer will choose the roll that has the least paper.

;“—“‘ NOTE: This option is effective only if you have enabled Printing paper info (see Printing paper info
on page 45). Otherwise, it has the same effect as Minimize paper waste.

E”%NOTE: In order to switch from one roll to another, the printer needs to cut the active roll. Therefore,

automatic roll switching is not possible when the active roll cannot be cut by the automatic cutter.

Turn nesting on and off

ENWW

Nesting means automatically printing images or document pages side by side on the paper when feasible,
rather than one after the other. This is done to avoid wasting paper. See Nest jobs to save roll paper

on page 60.

To turn nesting on or off, you must first make sure that the job queue is enabled (see Turn off the job queue
on page 67 or Turn off the job queue on page 71) and the start of printing is set to After Processing (see
Select when to print a job in the queue on page 65 or Select when to print a job in the queue on page 69).
Then:

Paper suitability options
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e  Inthe HP Utility for Windows: select Settings > Job Management > Nest.

e Inthe HP Utility for Mac 0S X: select Configuration > Printer Settings > Configure Printer Settings >
Job Management > Nest.

e Inthe Embedded Web Server: select Setup > Printer settings > Job management > Nest.

®  Using the front panel: press i then , then Setup > Job management > Nest options > Enable
nesting.

In each case, you will see the following options:

e Inorder: pages are nested in the order in which they are sent to the printer. The nested pages are
printed as soon as one of three conditions is met:

° The next page will not fit on the same row as the other pages already nested.

° No page has been sent to the printer during the specified wait time.

° The next page is incompatible with the pages already nested (see Nest jobs to save roll paper
on page 60).

° Optimized order: pages are not necessarily nested in the order in which they are sent to the printer.
When it receives an incompatible page, the printer holds it and waits for compatible pages to complete
the nest. The nested pages are printed as soon as one of three conditions is met:

° The next page will not fit on the same row as the other pages already nested.
° No page has been sent to the printer during the specified wait time.

° The incompatible-page queue is full. The printer can queue up to six incompatible pages while
nesting compatible pages. If it receives a seventh incompatible page, the nest is printed as it is.

° Off: nesting is disabled. This is the default option.

The nesting wait time can be set at the front panel: press “, then , then Setup > Job management >
Nest options > Select wait time.

_‘"?'_ TIP: Optimized order uses the minimum amount of paper; however, it may take longer to print because the
* printer waits for compatible pages to arrive.

Turn usage information on and off

The printer can send usage information periodically by email. You can request this in the following ways:
e  Inthe HP Utility for Windows: select Settings > Accounting.

e Inthe HP Utility for Mac 0S X: select Configuration > Printer Settings > Configure Printer Settings >
Accounting.

e Inthe Embedded Web Server: select Setup > Printer settings > Accounting.

In each case, you must set the following options:

e  Send accounting files: On (the default is Off)

e  Send accounting files to: a valid email address

e  Send accounting files every: choose a number of days (1-60) or a number of prints (1-500)

You must also ensure that the email server has been configured. To configure the email server using the
Embedded Web Server, select Setup > Email server, and fill in the following fields:
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e  SMTP server: the IP address of the outgoing mail server (SMTP) that will process all email messages
from the printer. If the mail server requires authentication, email notifications will not work.

e  Printer email address: each email message sent by the printer must include a return address, which
does not need to be a real, functional email address, but it should be unique, so that recipients of the
message can identify the printer that sent it.

Turn email notifications on and off

In order to receive email notifications from the printer, you must have configured the email server (see Turn
usage information on and off on page 24).

You can turn specific email notifications on or off by selecting Netifications from the Setup tab of the
Embedded Web Server.

Turn alerts on and off (Windows only)

Printer alerts warn you when there is a printer problem that you can correct by taking action, or when one of
your printing jobs changes its status. The alerts are displayed by the printer's front panel, by the HP Utility, by
the printer driver and by the Embedded Web Server.

You can tell the printer which kinds of alerts you would like to see (if any). To access the alert settings:
e  Select Alert Settings in the Device List page of the HP Utility for Windows.

e  Select Alert Settings in any alert page displayed by the HP Utility for Windows.

e  Right-click the system tray icon of the HP Utility for Windows, and select Alert Settings.

You can change the settings in the following ways:

e  Turnall alerts on or off.

e  Turnjob status alerts on or off.

e  Turnon or off printer alerts for problems that stop the printer from printing.

e  Turnon or off printer alerts for problems that do not stop the printer from printing.

e  Turnon printer alerts in all circumstances, or only when you are trying to print to the printer affected by
the problem.

Control access to the printer

Front-panel security settings

From the front panel, you can press “ then , then Setup > Security, to control some of the features
of the printer.

e  USBdrive: Enable or disable the use of a USB flash drive.
e  Firmware upgrade from USB: Enable or disable firmware updates from a USB flash drive.

° Enable Internet connection: Enable or disable the Internet connection.

=7 NOTE: If you disable it, you also disable automatic firmware updates.

e  Printer access control: Enable, disable, or change the administrator password.

If an administrator password has been set, it must be given in order to perform the following operations:
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e  Change the security settings (including the administrator password itself)

e  (Change the configuration of the Internet connection

e  (Change the Automatic Firmware Update configuration

e  Enable or disable automatic downloading and/or installation of automatic firmware updates
e  Restore an earlier firmware version

e  Reset factory defaults

@’NOTE: The administrator password can contain only characters that appear on the front panel's on-screen
keyboard. If you set a new password with the Embedded Web Server, it will reject characters that do not
appear in that limited character set.

Embedded Web Server security settings

From the Embedded Web Server, you can select the Security tab to control access to the printer in various
ways:

e  Specify separate administrator and guest passwords to control access to the Embedded Web Server
° Enable or disable Ethernet and USB connections to the printer
e  Enable or disable various groups of front panel operations

e  Use the same security settings that are available in the front panel (see above)

@’NOTE: An administrator password may be required.

?‘ NOTE: For more information, see the Embedded Web Server's online help.

Disable your HP ePrint Center connection

You can disable the connection to the HP ePrint Center if required for security. At the front panel, press “
then , then Connectivity > HP ePrint Center > HP ePrint Center settings > HP ePrint Center
connectivity and select Disable.

Disable just puts the remote printing function on hold. If you want to resume using it, you just need to re-
enable it in the same menu. No more setup steps are required.

If you want to disable remote printing permanently, select Disable permanently, which erases your printer
from your HP ePrint Center account. To use remote printing again, you will need to set it up again from
scratch (see Set up your Web-connected printer on page 21).

@’NOTE: You can prevent non-administrators from changing these options by setting an administrator
password in the Embedded Web Server (Setup > Security).

Require account ID

If you want to keep records of printer usage by different user accounts, you can set your printer to require an
account ID for each job.

e Inthe HP Utility for Windows: select Settings > Accounting > Require account ID.

e  Inthe HP Utility for Mac 0S X: select Configuration > Printer Settings > Configure Printer Settings >
Accounting > Require account ID.
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If this setting is turned on, the account ID field will be mandatory and jobs with no account ID will be kept "on
hold for accounting”.

The account ID can be set in the printer driver when sending the job. If the job is set "on hold for accounting”
by the printer, you can introduce the account ID in the HP Utility by going to the Job Center > Job Queue and
clicking the job that is on hold. A window with a text box will be displayed and you can enter the account ID
into it.

Set Windows driver preferences

You can change some default settings in your printer driver according to your own preferences, for instance
to set color emulation or paper-saving options. To do this, press the Start button on your computer's screen,
then select Printers and Faxes. In the Printers and Faxes window, right-click on your printer's icon, and select
Printing Preferences. Any settings you change in the Printing Preferences window will be saved as default
values.

ENWW Set Windows driver preferences 27



28

Personalizing the printer

Change the language of the front-panel display

Access the HP Utility

Access the Embedded Web Server

Change the language of the HP Utility

Change the lanquage of the Embedded Web Server

Change the sleep mode setting

Turn the buzzer on and off

Change the front-panel display brightness

Change the units of measurement

Configure network settings

Change the graphic language setting

Manage Printer's security

Change your printer’s email address

Chapter 4 Personalizing the printer

ENWwW



Change the language of the front-panel display

There are two possible ways to change the language of the front-panel menus and messages.

®  If you can understand the current front-panel display language, press “, then , then Setup >
Front panel options > Select language.
e If you cannot understand the current front-panel display language, start with the printer powered off.

Press the Power key to turn it on. When you see icons appear on the front panel, press f@] and then 5.
The front panel acknowledges this sequence by turning the icons on and off rapidly.

Whichever method you used, the language selection menu should now appear on the front-panel display.
Press your preferred language.

Access the HP Utility

The HP Utility enables you to manage your printer from a computer with a USB, TCP/IP or Jetdirect
connection.

e  Under Windows, start the HP Utility from your desktop shortcut or from Start > All Programs > HP >
HP Utility > HP Utility. This launches the HP Utility, showing the printers installed on your computer.

e  Under Mac 0S X, launch the HP Utility from your dock shortcut or by selecting STARTUP_DISK > Library
> Printers > hp > Utilities > HP Utility. This launches the HP Utility, showing the printers installed on
your computer.

When you select your printer in the left pane, everything that appears in the right pane is specific to that
printer.

If you have followed these instructions but failed to get through to the HP Utility, see Cannot access the HP
Utility on page 153.

Access the Embedded Web Server

ENWW

The Embedded Web Server enables you to manage your printer remotely using an ordinary Web browser
running on any computer.

To access the Embedded Web Server directly, you must have a TCP/IP connection to your printer. However,
you can access the Embedded Web Server indirectly through the HP Utility, if you connect to your printer with
a USB connection.

The following browsers are known to be compatible with the Embedded Web Server:
e Internet Explorer 7 for Windows XP, and later

e  Safari 3 for Mac 0S X 10.5, and later

e  Firefox 3.6 and later

e  Google Chrome 7 and later

The Adobe Flash plugin version 7 or later is recommended for viewing job previews.

To access the Embedded Web Server on any computer, open your Web browser and give the IP address of
your printer.

You can see your printer's IP address on the front panel by pressing “ and then .

Change the language of the front-panel display
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If you have followed these instructions but failed to get through to the Embedded Web Server, see Cannot
access the Embedded Web Server on page 154.

Change the language of the HP Utility

The HP Utility can work in the following languages: English, Portuguese, Spanish, Catalan (Windows only),
French, Italian, German, Russian, Simplified Chinese, Traditional Chinese, Korean and Japanese.

e Under Windows, select Tools > Set Language and select a language from the list.

e  Under Mac 0S X, the language is changed as for any other application. In System Preferences, select
International and re-launch the application.

Change the language of the Embedded Web Server

The Embedded Web Server can work in the following languages: English, Portuguese, Spanish, Catalan,
French, Italian, German, Russian, Simplified Chinese, Traditional Chinese, Korean and Japanese. It uses
whichever language you have specified in your Web browser's options. If you have specified a language that
it cannot support, it works in English.

To change the language, you must change your Web browser's language setting. For example, in Internet
Explorer version 6, go to the Tools menu and select Internet Options, Languages. Then ensure that the
language you want is at the top of the list in the dialog box.

Change the sleep mode setting

If the printer is left switched on but unused for a certain period of time, it goes automatically into sleep mode
to save power. To change the time the printer waits before it goes into sleep mode, go to the front panel and

press [ then , then Setup > Front panel options > Sleep mode wait time. Select the wait time you
want and then press 0K; you can set the time from 30 to 240 seconds. The default time is 30 seconds.

Turn the buzzer on and off
To turn the printer's buzzer on or off, go to the front panel and press “ then , then Setup > Front
panel options > Enable buzzer, and select on or off. By default, the buzzer is set to on.

Change the front-panel display brightness

To change the brightness of the front-panel display, press [J[[J then , then Setup > Front panel

options > Select display brightness, and select a value you want. Press OK to set the value. The default
brightness is set to 50.

Change the units of measurement
To change the units of measurement in the front-panel display, press “, then , then Setup > Front

panel options > Select units, and select English or Metric. By default the units are set to metric.

Configure network settings

You can view and configure the network settings from the Embedded Web Server, the HP Utility or the front
panel.

To do so with the Embedded Web Server, select the Setup tab, then Networking.
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With the HP Utility under Windows, select the Settings tab, then Network Settings. Under Mac 0S X, select
Configuration > Network Settings.

The following settings are available.

e IP Configuration method: Specify the way to set an IP address, selecting BOOTP, DHCP, Auto IP or
Manual.

e  Host name: Specify the IP name of the printer. The name may contain up to 32 ASCll characters.

e IP address: Specify the IP address of the printer. Duplicate IP addresses on a TCP/IP network will cause
communication to fail.

Q TIP: Make sure that the combination of IP address, subnet mask and default gateway is valid. If these
* three fields are inconsistent, you may not be able to connect to the printer at all until you fix the
problem from the front panel.

TIP: If you change the current IP address and click Apply, the browser loses the current connection to
the printer because it is pointing to the old address. To reconnect, browse to the new IP address.

e  Subnet mask: Specify a subnet mask, which determines which bits specify the network and which bits
uniquely specify the node within the network.

e Default gateway: Specify the IP address of a router or computer that is used to connect to other
networks or sub-networks. If none exist, use the IP address of the computer or the IP address of the
printer.

e  Domain name: Specify the name of the DNS domain in which the printer resides (for example,
support.hp.com).

=¥ NOTE: The domain name does not include the host name: it is not the fully qualified domain name,
such as printer1.support.hp.com.

e Idle timeout: Specify the time that an idle connection is allowed to remain open when a remote
computer is waiting for the printer. The default value is 280 seconds. If set to zero, the timeout is
disabled and the connection is allowed to remain open indefinitely.

e  Default IP: Specify the IP address to use when the printer is unable to obtain an IP address from the
network when powered on or when reconfigured to use BOOTP or DHCP.

e  Send DHCP requests: Specify whether DHCP requests are transmitted when a legacy default IP address
or a default Auto IP is assigned.

To configure the same network settings from the front panel, press “ then , then Connectivity >
Network connectivity > Gigabit Ethernet > Modify configuration.

You have various other options available from the Connectivity > Network connectivity > Advanced menu.

e 1/0 timeout: Specify the time that an idle connection is allowed to remain open when the printer is
waiting for a remote computer. The default value is 30 seconds. If set to zero, the timeout is disabled
and the connection is allowed to remain open indefinitely.

e  Allow SNMP: Specify whether SNMP is permitted.

e Embedded Web Server > Allow EWS: Specify whether the Embedded Web Server is enabled.

e  Web Services > HP Utility software: View the HP Utility software settings.

e  Web Services > Color and paper management: View the color and paper management settings.

e  Restore factory settings: restore the initial default values of the network settings.
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Change the graphic language setting

You can change the graphic language setting from the HP Utility with the following steps.

1. Under Windows, select the Settings tab then Printer settings > Printing preferences.

Under Mac 0S X, select Configuration then Printer settings > Configure printer settings > Printing
preferences.

2. Select one of the following options.

Select Automatic to let the printer determine which type of file it is receiving. This is the default
setting; it works for most software applications. You should not normally need to change it.

Select HP-GL/2 only if you are sending a file of that type directly to the printer, without going
through a printer driver.

Select PDF only if you are sending a file of that type directly to the printer, without going through a
printer driver.

Select PostScript only if you are sending a file of that type directly to the printer, without going
through a printer driver.

Select TIFF only if you are sending a file of that type directly to the printer, without going through
a printer driver.

Select JPEG only if you are sending a file of that type directly to the printer, without going through
a printer driver.

You can change the graphic language setting from the front panel. Press “ then , then Setup >
Printing preferences > Graphics language. Select the desired option.

=7 NOTE:

If the graphic language is set from the HP Utility, it overrides the front panel setting.

Manage Printer's security

When you have set up Web Services, the printer is in unlock mode. In unlock mode, anyone who knows your
printer's email address can print to your printer by just sending a file to it. Although HP provides a spam
filtering service, you should be careful about giving out your printer's email address, as everything sent to
that address may be printed on your printer.

If you are the printer administrator, you can manage Printer security or change your printer status to lock
mode by visiting the HP ePrint Center at http://www.hp.com/go/eprintcenter. You can also customize your
printer's email address and manage print jobs from there. At your first visit, you will need to create an
account in the HP ePrint Center.

Change your printer’s email address

You can change your printer's email address at the HP ePrint Center: http://www.hp.com/go/eprintcenter.
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Paper handling

° General advice

° Load aroll onto the spindle

° Load a roll into the printer

° Unload aroll

° Load a single sheet

° Unload a single sheet

° Sensitive-paper mode

e View information about the paper

° Paper presets

° Printing paper info

° Move the paper

° Maintain paper

° Change the drying time

e  Turn the automatic cutter on and off

° Feed and cut the paper
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General advice
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A CAUTION: Before starting a paper loading process, ensure you have enough room around the printer, both
in front and behind.

A CAUTION: Make sure the printer wheels are locked (the brake lever is pressed down) to prevent the printer
from moving.

A CAUTION: All paper must be 280 mm (11 in) or longer. A4 and letter paper cannot be loaded in landscape
orientation.

*O-TIP:  For photo paper wear cotton gloves to avoid transferring oils onto the paper.

A CAUTION: Keep the basket closed throughout the loading process.

Load a roll onto the spindle

1. Opentheroll cover.
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2. Remove the black end of the spindle from the printer, then the blue end.

A CAUTION: Besure to remove the black end first. Removing the blue end first could damage the black
end.

A WARNING! Do notinsert your fingers into the spindle supports during the removal process.

[ ]

-l |

3. Thespindle has a stop at each end to keep the roll in position. The blue stop can be removed to mount a
new roll; it slides along the spindle to hold rolls of different widths. Remove the blue paper stop from

the end of the spindle.

4. Iftherollis long; rest the spindle horizontally on a table and load the roll on the table.

:{;’. TIP:  You may need two people to handle a large roll.
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5. Slide the new roll onto the spindle. Make sure the paper type is oriented as shown. If it is not, remove
theroll, turn it 180 degrees and slide it back on to the spindle. There are labels on the spindle showing
the correct orientation.

|*__*:"’49N0TE: From the back of the printer, the blue stopper is inserted into the right-side holder.

Ensure both ends of the roll are as close to the spindle stops as possible.

6. Put the blue paper stop on to the open end of the spindle, and push it towards the end of the roll.

7. Ensure the blue paper stop is pushed in as far as it goes; until both ends are against the stoppers.

If you are a regular user of different paper types, you can change rolls more quickly if you preload rolls of
different paper types on different spindles. Extra spindles are available for purchase, see Accessories

onpage 111.

Load a roll into the printer

To start this procedure, you must have a roll loaded on the spindle. See Load a roll onto the spindle
on page 34.

:{;’. TIP: Do not try to open both roll covers at once; this may cause problems. Always close one cover before
° opening the other.

%’NOTE: The first three steps below are optional: you can start with step 4. However, in this case the printer
will not keep track of the length of the roll, and will print no barcode on the roll when it is next unloaded. So
you are recommended to follow all the steps, starting with step 1, unless you have turned off the Printing
paper info option. See Printing paper info on page 45.

1. From the front panel, press [ then the roll icon, then Load.
Alternatively, press [J[iJ§ then , then Paper > Paper load > Load roll 1 or Load roll 2.

If the roll you have selected is already loaded, you have to wait while it is automatically unloaded.
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2.

3.

4.

5.

6.

7.

ENWw

=7 NOTE: If the loaded paper cannot be automatically cut by the printer, you are asked to unload it

manually.

You should stand behind the printer when loading the lower roll (roll 2). You may stand behind or in
front of the printer when loading the upper roll (roll 1).

A CAUTION: If your height is less than 1.6 m (5 ft 3 in), loading a roll while standing in front of the

printer may cause back pain or other physical problems.

If you start to load roll 1 while roll 2 is already loaded, roll 2 is withdrawn to the standby position, so
that it can be printed on again without reloading whenever required.

=7 NOTE: If roll 2 cannot be automatically cut by the printer, it is not moved to the standby position;

instead, you are asked to unload it manually.

2% NOTE: If at any time you open a roll cover while that roll is in the standby position, the roll is

unloaded, and you will have to reload it the next time you want to print on it.

Open theroll cover, if it is not already open.

Rest the spindle's black end on the left side roll holder. Do not put the end completely into the roll
holder.

'sl

Mt iy

Rest the blue end of the spindle on the right side roll holder.

2

A .
\
Mitia iy

With both hands, push the spindle into both roll holders at the same time.

If the edge of the rollis not straight or torn (sometimes due to tape used to hold end of the roll), pull the
paper slightly and cut a straight edge.
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8. Insert the edge of the paper into the printer.

A WARNING! Do not push your fingers inside the printer's paper path.

_:{?:_ TIP:  When loading the upper roll, avoid inserting roll paper into the cut-sheet slot. If you do so, the
* printer beeps and the front panel asks you to remove the paper.

)

-
|
W\
9. Roll the paper into the printer until you feel resistance and the paper flexes slightly. When the printer
detects the paper, it feeds it in automatically.

AN

10. If the leading edge of the paper has a barcode, the printer reads and then cuts off the barcode; you
should remove and discard the cut strip of paper.

11. If the leading edge of the paper has no barcode, the front panel prompts you to select the paper
category and type.

{} TIP: If you have loaded a paper type whose name does not appear in the paper list, see The paper type
* isnotin the driver on page 119.
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12. If the Printing paper info option is enabled, the front panel may ask you to specify the length of the
roll. See Printing paper info on page 45.

13. The printer checks the alignment and measures the width, then the front panel prompts you to close
theroll cover.

If the rollis not correctly aligned, follow the instructions on the front-panel display.

Uncuttable paper (canvas)

Some paper types, such as canvas, cannot be cut by the automatic cutter. This has the following
consequences:

e  The automatic cutter is automatically disabled.

e  The front panel reports on the home screen and in the paper tab that automatic cutting is not available.

e  Theroll cannot be moved to the standby position.
e  Theroll cannot be unloaded automatically: it must be unloaded manually.

e  Automatic roll-switching is disabled, and any job sent to a standby roll is put on hold for paper until the
uncuttable rollis unloaded.

e  The Printing paper info option is automatically disabled; see Printing paper info on page 45.

E‘%NOTE: If you have an unexpected issue at any stage of the paper loading process, see The paper cannot be
loaded successfully on page 118.

Unload aroll

Before unloading aroll, check whether there is paper on the roll or if the roll is out of paper, and follow the
appropriate procedure as described below.

Quick procedure with paper on the roll

If there is paper on the roll, just open the roll cover, and the roll is unloaded automatically, unless the roll is
uncuttable (in which case, see Manual unload procedure on page 40).

E‘/,"NOTE: When the roll is unloaded in this way, no barcode is printed on it, so the printer will not know the
length of the roll when it is next loaded. See Printing paper info on page 45.

E’%NOTE: If you open the cover of roll 1 while a sheet is loaded, the sheet is also unloaded.

Front panel procedure with paper on the roll
If there is paper on the roll, you can unload it from the front panel.
1. Press [[iJ§ then the rollicon, then Unload.

Alternatively, press [J[iJ§ then , then Paper > Paper unload > Unload roll 1 or Unload roll 2.

2.  You may need to open the roll cover.

3. Ifthe paperis uncuttable, see Manual unload procedure on page 40.

Roll out of paper procedure

If the end of the paper is no longer attached to the core, use the following procedure.
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1.  If you have already started the unload process, press [Jl on the front panel to cancel that procedure.
2.  Lift the blue lever on the left. If the front panel displays a warning about the lever, ignore it.

3.  Pull out the paper from the printer. Pull from wherever the paper is accessible; the back of the printer is
recommended. You may need to open the roll cover.

4. Lower the blue lever.

Manual unload procedure
Paper types that cannot be cut by the automatic cutter must be unloaded manually.
1. Opentheroll cover.
2.  Lift the blue lever on the left.
3. Rewind the paper by turning the spindle manually, until the paper is removed from the printer.
4. Lower the blue lever.

5. Close theroll cover.

Load a single sheet

1.  Ensure that the cover of roll 1 is closed. If it is opened while a sheet is loaded, the sheet will be
immediately unloaded.

2. Atthe front panel, press JJ[iJ then the roll 1 icon, then Load > Load sheet.
Alternatively, press [JJ[iJ§ then , then Paper > Paper load > Load sheet.

3. Ifarollis already loaded, you have to wait while it is withdrawn to the standby position; it can be
printed on again without reloading as soon as the sheet paper has been unloaded.

E”%NOTE: If at any time you open a roll cover while that rollis in the standby position, the roll will be
automatically unloaded, and you will have to reload it the next time you want to print on it.

E’/{’NOTE: If the rollis uncuttable, the front panel gives instructions for unloading it manually.

4. Select your paper category and type.

_‘{?'_ TIP: If you have loaded a paper type whose name does not appear in the paper list, see The paper type
* isnotin the driver on page 119.
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5. When prompted by the front panel, insert the sheet into the cut-sheet slot on the right side of the
printer.

Load your sheet aligned with the load line and insert until the paper will not continue; with thicker
sheets, you feel resistance.

A WARNING! Do not push your fingers inside the printer's paper path.

6. Press the OK key on the front panel to feed the paper into the printer. Guide the sheet into the printer;
this is especially important with thicker papers.

7. The printer checks the alignment and measures the sheet.

=7 NOTE: Depending on the length of the sheet, it feeds out the front of the printer.

8. If the length of the sheet is more than 600 mm (23 in), the front panel prompts you to check that the
rear of the sheet is hanging backwards over the roll cover (and not forwards over the printer window).

9. Ifthesheet is not correctly aligned, you may be asked to correct the alignment. Please follow the
instructions on the front-panel display.

E"/"’NOTE: If you have an unexpected problem at any stage of the paper loading process, see The paper cannot
be loaded successfully on page 118.

Unload a single sheet

To unload a single sheet after printing, you can simply pull the sheet free from the front of the printer.

To unload a sheet without printing, go to the front panel and press [J[{J then the roll 1 icon, then Unload >
Unload sheet.

Alternatively, press [J[iJ§ then , then Paper > Paper unload > Unload sheet.

The sheet unloads out of the front of the printer; either catch it manually or allow it to fall into the basket.
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Sensitive-paper mode

The printer’s sensitive-paper mode is designed to ensure the highest-quality prints on paper particularly
vulnerable to deformations or scratches, such as film.

Sensitive-paper mode can be enabled in two different ways:
e  Whenyou load a roll, by using the Load roll 1/2 as sensitive paper front-panel options

e  When therollis already loaded, by using the Treat roll 1/2 as sensitive paper front-panel options.

Oplions

Load roll 1
Unload roll 2

Load sheet

Load roll 1 as sensitive paper

Treat roll2 as sensitive paper

The front panel guides you through a step-by-step process. At the end, you are asked to keep the roll cover
open while sensitive-paper mode is active. Apart from that, you can print on the selected roll as usual.

Sensitive-paper mode remains active until the roll runs out of paper, or until it is unloaded in the usual way.

When sensitive-paper mode is active, it is indicated with an icon [g] on the front panel’s paper information
screen.

Paper information B

HP Universal ID Gloss
Size: 610 mm . y
' Status: Sensitive paper mode e o
&

Status. Disabled

1 S

Notes
e  Sensitive-paper mode cannot be enabled on two rolls at the same time.

e  Whenarollis loaded or treated as sensitive paper, it cannot be parked by the printer. This means that
no other paper will be available for printing as long as sensitive-paper mode is active.

e [fasecondrollis loaded while sensitive-paper mode is active:
° The second roll is indicated as temporarily disabled on the front panel’s paper information screen.
° Any job to be printed on the disabled roll will be kept in the job queue as “on hold for paper”.

° The disabled roll is enabled when the sensitive-paper roll is unloaded.

View information about the paper
To view the loaded paper information, press [J[iJ then the roll icon.

The following information is displayed on the front panel:
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e  Paper type you have selected

e  Rollorsheet status

e  Width of the paper in millimeters (estimated)

e  Length of the paper in millimeters (estimated)

If no paper is loaded, the message Out of paper is displayed.

The same information is displayed in the HP Utility for Windows (Overview tab > Supplies Status tab), the HP
Utility for Mac 0S X (Information group > Printer Status > Supplies Details) and the Embedded Web Server
(upper-right corner).

Paper presets

Each supported paper type has its own characteristics. For optimum print quality, the printer changes the
way it prints on each different paper type. For example, some may need more ink and some may require a
longer drying time. So the printer must be given a description of the requirements of each paper type. This
description is called the paper preset. The paper preset contains the ICC profile, which describes the color
characteristics of the paper; it also contains information on other characteristics and requirements of the
paper that are not directly related to color. Existing paper presets for your printer are already installed in the
printer's software.

However, as it is inconvenient to scroll through a list of all paper types available, your printer contains paper
presets only for the most commonly used paper types. If you have a paper type for which your printer has no
preset, you cannot select that paper type in the front-panel display.

There are two ways to assign a preset for a new paper type.

e Import a paper preset that you have downloaded from the Web. See To install a downloaded paper
preset on page 43.

e  (reate your own paper preset using the HP Color Center. See To create your own paper preset
on page 44.

E‘/{’NOTE: You can use a maximum of 30 custom and additional paper types. To delete a custom or additional
paper preset, go to the Color Center and select Paper Preset Management > Delete Paper Preset. Paper
presets provided with your printer cannot be deleted.

To install a downloaded paper preset

1.  After finding the right paper preset at http://www.hp.com/go/Z5400ps/paperpresets or at the paper
manufacturer's Web site, click the Download Now button and save the paper preset (“.oms” file) on
your computer.

=¥ NOTE: If you do not find the paper preset you want on the Web, you may find that it has been added to
the latest firmware for your printer. You can check the firmware release notes for information, see
Update the firmware on page 108.

2. Before starting to install the new preset, make sure that the printer is idle and the print queue is
stopped. Installing a new paper preset will interrupt any printing that is in progress.

3.  Start the HP Utility or the Embedded Web Server.
e Inthe HP Utility, select the Color Center and then Import Paper Preset.

e Inthe Embedded Web Server, select the Setup tab, then Paper preset management, then the
Import tab.

4. Onthelmport page, select the paper preset file that you downloaded in step 1.
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5. Click the Update button and wait for the update process to finish. It may take some time. The printer
will automatically restart when the update is complete; wait until it has restarted and the front panel
indicates that it is ready.

6. Check that the new paper type appears in the Additional paper or Custom paper category in your
printer's front panel.

7. Under Mac 0S X only, synchronize the new paper type with the driver by opening the HP Utility. Select
your printer, then the Color Center tab, then Paper Preset Management and Synchronize Paper
Presets ((¢]|button).

Now that you have imported the paper preset, you can select the paper type from the front panel and from
the Mac 0S X driver. The ICC profile for the new paper type is ready to use by your application.

To create your own paper preset

Before using a custom paper type with your printer, you should add a paper preset for the new paper. You
can create a new paper preset using the HP Color Center in the HP Utility.

The paper preset name will appear in the printer driver and the front panel.
To create a paper preset, you can follow this simple procedure:

1. Goto the Color Center tab in the HP Utility for Windows, or to the HP Color Center group in the HP Utility
for Mac 0S.

2. Select Create New Paper Preset.

3. Enter your paper's name.

-‘SI?'- TIP: The paper's commercial name is likely to be the most understandable for other users of the
° printer.

4. Select a paper category from the drop-down menu. The paper category determines the amount of ink
used and other basic printing parameters. For more information, see the online help ] in the Color
Center, and http://www.hp.com/go/Z5400ps/paperpresets. The available categories are:

e  Bond and Coated Paper: Fiber-based, thin papers with a matte surface. These papers use matte
black ink, relatively low ink limits and high carriage position.

o  Photo Paper: Photo-base, relatively thick papers with a variety of finishing from matte to satin to
glossy. These papers use photo black ink, with the exception of Photo Matte Papers, relatively
high ink limits and low carriage position, with the exception of Baryte and Photo Matte Papers.
Generally they will print with the starwheels up.

e  Proofing Paper: A variety of papers from matte to satin and glossy used to simulate commercial
printing with high color accuracy requirements.

o  Fine Art Material: Canvas, matte and paper-base photo materials used for high-quality fine art
printing. These papers use matte black ink, with the exception of Canvas Satin and Pearl papers,
which use photo black. They all use high carriage position with high ink limits.

e  Film: Synthetic film-base materials that generally use photo black, with relatively low ink limits
and high carriage position.

e  Backlit: Synthetic translucent materials that use photo black with high ink limits, high carriage
position and starwheels up.

5.  Click Next under Windows, Continue under Mac OS.

6. Load your custom paper, see Load a roll into the printer on page 36 or Load a single sheet on page 40.
You will find the paper name in the Custom paper category in the front panel.
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7. Choose the ICC profile name in the Color Center. This is the name you will use to select the profile in
your application.

If you wish, use the Change Printing Properties button to change the following properties:

e  Paper Thickness: This is relevant to carriage height or platen gap. You should choose High if your
paper weighs over 250 g/m? or if it does not have a plastic coating.

e  Dry Time: The recommendation is to use Automatic by default and move to Extended if needed.
e  Starwheels: Print with the starwheels up or down.

e  Cutter: Enable or disable the cutter.

e  Global Ink Limit: Initially it can be left as it is and modified later on, based on printing results.

Some paper types are available with different ink limits (less/normal/more ink). Ink limits are
generally proportional to color gamut volume, but a higher ink limit can cause printing artifacts
(bleed, coalescence, etc.) in some cases. HP papers have fine-tuned ink limits while other papers
use generic ink limits.

=2 NOTE: When an option is grayed out, that means that it is not available for the selected paper type.

8.  Click Next under Windows, Continue under Mac 0S.
9. If the paper type permits, the printer performs a color calibration (about 10 minutes).

Now that you have created the paper preset, you will be able to select the paper type from the front panel
and from the Mac 0S X driver under the Custom paper category. The ICC profile for the new paper type will be
ready to use by your application.

You can export the new paper preset to your computer and use it on other HP DesignJet Z5400 printers. In the
Color Center, select Paper Preset Management > Export Paper Preset, then follow the instructions on the
screen. To install the preset on another printer, see To install a downloaded paper preset on page 43.

Printing paper info

ENWW

Enable the Printing paper info option to record the printer’s estimate of the remaining roll length, paper
width and type. The information is a combination of barcode and text that is printed on the leading edge of
the roll when the paper is unloaded from the printer.

a IR 0l

138 feet (42.1 m.) of 42 inch (1067 mm.) Photo Gloss Paper

@NOTE: The paper-length estimate is available only if the printer registered the amount of paper that was on

the roll when you loaded it. To provide this information to the printer, specify the roll length on the front
panel when loading the paper, or load a roll that has the paper-data barcode printed on it.

E%NOTE: The barcode and text are printed on the roll only when the loading and unloading processes are

started from the front panel's Paper menu.

@NOTE: This option can be expected to work only with papers that are completely opaque and cuttable. It

may fail with transparent or translucent papers; it is disabled when an uncuttable paper type is loaded.

To enable the Printing paper info option, go to the front panel and press “ then , then Setup >
Printing preferences > Paper options > Enable printing paper info.

E‘%NOTE: Enabling this option slightly changes the paper loading and unloading procedures.
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Move the paper

If the printer is idle (ready to print), you can move the paper forwards or backwards from the front panel. You
may want to do this in order to have more or less white space between the last print and the next one.

To move the paper, press [J[iJ then , then Paper > Move paper.

Maintain paper
To maintain paper quality, follow the recommendations below.
e  Storerolls covered by another piece of paper or cloth
e  Store cut sheets covered and clean or brush them before loading them in the printer
e  (leaninput and output platens

e  Always keep the window of your printer closed

=7 NOTE: Photo and coated paper requires careful handling, see The print is scuffed or scratched
on page 133.

Change the drying time

You may wish to change the drying time setting to suit special printing conditions such as multiple prints
where time is of higher importance or when you need to be sure ink is dry before handling.

Press [ then , then Setup > Print retrieval > Select drying time. You can select:

e  Extended, to set a longer than recommended time to ensure ink is completely dry
e  Optimal, to set the default and recommended time for your selected paper (this is the default setting)
e  Reduced, to set a shorter than recommended time when quality is of lower importance

e None, to disable the drying time and remove your print as soon as it finishes printing

A CAUTION: If the ink is not dry when the print is removed it could leave ink in the output tray and marks on
the print.

?‘ NOTE: If you cancel the drying time during a print, the printer may not feed and cut the paper right away
due to the printhead maintenance, which runs in parallel. If the dry time is zero, the printer cuts the paper
and then performs the printhead maintenance. However, if the dry time is greater than zero, the printer does
not cut the paper until after the printhead maintenance has completed.

Turn the automatic cutter on and off

To turn the printer's paper cutter on or off:

e  From the HP Utility for Windows, select the Settings tab and change the Cutter option in Printer
Settings > Advanced.

e  From the HP Utility for Mac 0S X, select Configuration > Printer Settings > Advanced and change the
Cutter option.
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e  Fromthe Embedded Web Server, select the Setup tab, then Printer Settings > Advanced, and change
the Cutter option.

®  From the front panel, press “ then , then Setup > Print retrieval > Enable cutter and change
the cutter option.

The default setting is On.

r__*:")f’NOTE: If the cutter is turned off, it will not cut the paper between jobs, but it will continue to cut the paper
on loading, unloading and switching between rolls.

E‘%NOTE: The printer knows that some paper types, such as canvas, cannot be cut by the automatic cutter;
and it will not try to cut them even if the cutter is turned on.

_‘{?'_ TIP: To cut roll paper while the automatic cutter is disabled, see Feed and cut the paper on page 47.

®

Feed and cut the paper

If you go to the front panel and press “ then , then Paper > Form feed and cut, the printer

advances the paper and makes a straight cut across the front edge. There are several possible reasons why
you might want to do this.

e  Totrim the leading edge of the paper if it is damaged or not straight.
e Tofeed and cut the paper when the automatic cutter has been disabled.

e  Tocancel the waiting time and print the available pages immediately, if the printer is waiting to nest
more pages.

E‘%NOTE: The printheads are serviced after each print, and the paper cannot be cut until the process
completes, so you may notice a delay.

%?NOTE: Some paper types cannot be cut by the automatic cutter. In this case, the printer advances the paper
without trying to cut it.

A CAUTION: Remove the cut piece from the output tray. If strips or short prints are left in the output tray the
printer could jam.

r__*:")f’NOTE: Photo and coated paper requires careful handling, see The print is scuffed or scratched
on page 133.

_‘Q'_ TIP: To move the paper without cutting it, see Move the paper on page 46.
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6 Working with two rolls

° The uses of a multiroll printer

° How the printer allocates jobs to paper rolls

The uses of a multiroll printer

A multiroll printer can be useful in several different ways:
e  The printer can automatically switch between different paper types according to your needs.

e  The printer can automatically switch between different paper widths according to your needs. This
enables you to save paper by printing smaller images on narrower paper.

e Ifyouload two identical rolls into the printer, you can leave it printing unattended for a long time,
because it can switch from one roll to the other automatically when the first is exhausted. See
Unattended printing/overnight printing on page 62.

The current status of both rolls is shown on the front panel if you press [

=7 NOTE: Bear in mind that a protected roll is protected from use unless the roll number or its paper type are
specifically requested. See Roll protection on page 62.

=—?NOTE:  If the active roll cannot be cut by the automatic cutter, automatic switching is disabled, and jobs sent
to the standby roll are put on hold for paper until the uncuttable roll is manually unloaded.

@’NOTE: When you print from a USB flash drive, multiroll printing is considerably simplified: either you
specify manually which roll you want to use, or you can select Save paper, in which case the printer chooses
the narrowest roll on which the print will fit. You cannot specify the paper type.

How the printer allocates jobs to paper rolls

When you submit a print job from the Embedded Web Server or the printer driver, you can specify (using the
Paper type or Type is option) that you want it to be printed on a particular paper type; you can even specify
(using the Paper source, Source is or Paper Feed option) that you want it to be printed on a particular roll (1
or 2). The printer will try to satisfy these requirements, and it will also look for a paper roll large enough to
print the image without clipping.

e If bothrolls are suitable for the job, the roll will be chosen according to the roll switching policy. See Roll
switching options on page 23.

e Ifjust one of therolls is suitable for the job, it will be printed on that roll.

e If neither rollis suitable for the job, it will be put on hold for paper, or printed on an unsuitable roll,
depending on the paper mismatch action. See Paper mismatch action on page 23.

The printer driver for Windows will tell you which paper types and widths are currently loaded in the printer,
and on which rolls.
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Here are some settings that may be used in typical situations.

E’%NOTE: The Type is and Source is settings are in the printer driver and the Embedded Web Server; the Roll
switching policy is set in the front panel.

e  With different paper types loaded:
° Typeis: select the paper type you require
° Source is: Automatically select / Predetermined
° Roll switching policy: doesn't matter
e  With different paper widths loaded:
° Typeis: Use Printer Settings
° Source is: Automatically select / Predetermined

° Roll switching policy: Minimize paper waste

_‘"?'_ TIP: You can also save paper in some cases by rotating or nesting your images. See Use paper
* economically on page 60.

e  Withidentical rolls loaded:
° Type is: Use Printer Settings
° Source is: Automatically select / Predetermined

° Roll switching policy: Minimize roll changes
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° Introduction

° Print from a USB flash drive

° Print from a computer using the Embedded Web Server or HP Utility

° Print from a computer using a printer driver

° Advanced print settings
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Introduction

You can choose to print in the following different ways, depending on your circumstances and preferences.

Print a TIFF, JPEG, HP-GL/2, RTL, PDF, or PostScript file directly from a USB flash drive. See Print from a
USB flash drive on page 51.

Print a file that is already in the job queue. See Reprint a job from the queue on page 66.

Print a TIFF, JPEG, HP-GL/2, RTL, PDF, or PostScript file directly from a computer connected to the
printer, using the Embedded Web Server or the HP Utility. See Print from a computer using the
Embedded Web Server or HP Utility on page 52.

Print any kind of file from a computer connected to the printer by network or USB cable, using a
software application that can open the file, and a printer driver supplied with your printer. See Print
from a computer using a printer driver on page 53.

Print from a USB flash drive

ENWW

1.

Insert a USB flash drive containing one or more TIFF, JPEG, HP-GL/2, RTL, PDF, or PostScript files into
one of the printer's USB ports.

= NOTE:  The use of USB flash drives with your printer may be disabled by the administrator: see Control

access to the printer on page 25.

At the front panel, go to the home screen and press

Select the file to be printed. Files that can be printed are indicated with [i; files that cannot be printed
are indicated with [&3]. You can press folders to browse their contents.

The default print settings are displayed. If you want to change them, press Settings. The following
settings are available:

e  Sizeallows you to resize the print in two different ways: to a percentage of its original size, or to
fit a particular paper size. The default is 100% (its original size).

e  (Color allows you to choose color or grayscale printing.
e  Print quality allows you to set the print quality to Best, Normal or Fast.

e  Roll allows you to specify printing on roll 1 or roll 2, or you can choose Save paper, which
automatically chooses the narrowest roll on which the print will fit.

e  Rotation allows you to rotate the print by any multiple of 90°, or you can choose Automatic,
which rotates the print automatically if that will save paper.

=7 NOTE: If you change the settings in this way, the changed settings apply to the current job but are not

saved permanently. You can change the default settings by pressing “, then , then Print from
USB preferences.

To display a preview of the printed job on the front panel, press .
When the preview is displayed, you can press it to zoom in on it. Press it again to zoom out.

When you are satisfied with the print settings, press Start.
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7. Iftworolls are loaded, you can choose to print on either roll, or you can let the printer choose
automatically.

E’%NOTE: The printer will automatically rotate the image by 90° if it can save paper by doing so.

8.  After printing, you can choose to print another file or go to the job queue. If you print another file
immediately without returning to the home screen, the temporary settings used for the previous file are
used again.

Print from a computer using the Embedded Web Server or HP
Utility

You can print files in this way from any computer that can access the printer's Embedded Web Server. See
Access the Embedded Web Server on page 29.

From the Embedded Web Server, select the Main tab and then Submit job. From the HP Utility, select Job
Center > Submit Job. You will see the window below.
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Press the Add files button to choose the files from your computer that you want to print. The files must be in
one of the following formats:

o HP-GL/2
e RIL

o TIFF

e JPEG

e PDF

° PostScript

%NOTE: When you print to a file, the file should be in one of the above formats, but its name may have an
extension such as .plt or .prn.

If the files are not in one of these formats, they will not be printed successfully.

If the jobs have been generated with the appropriate settings (such as page size, rotation, resizing and
number of copies), you can just press the Print button and they will be sent to the printer.

If you need to specify printing settings, go to the Job settings section and select the options you need. Each
option has explanatory text on the right, so that you can understand the behavior of each setting. Remember
that, if you leave the setting as Default, the setting saved in the job will be used. If the job contains no
setting, the setting in the printer will be used.

If you have chosen some non-default settings and expect to reuse the same group of settings in the future,
you can save them all under a single name from the Manage presets tab, and recall them using that name
later.
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Print from a computer using a printer driver

This is the traditional way of printing from a computer. The correct printer driver must be installed on the
computer (see Installing the software on page 12), and the computer must be connected to the printer by
network or USB cable.

When the printer driver has been installed and the computer is connected to the printer, you can print from a
software application by using the application's own Print command and selecting the correct printer.

Advanced print settings

The rest of this chapter explains the various print settings that you can use when printing with a printer
driver, the Embedded Web Server or the HP Utility. These methods offer a relatively large number of settings
in order to satisfy all requirements.

_‘{?'_ TIP: Ingeneral you are recommended to use the default settings unless you know that they do not meet
° your requirements.

TIP: If youintend to reuse a particular group of settings repeatedly, you can save those settings under a
name of your own choice and recall them later. A saved group of settings is known as a 'quick set' in the
Windows printer driver, and as a 'preset’ in the Embedded Web Server.

Select print quality

The printer has various print-quality options because best-quality printing requires some loss of speed, while
fast printing implies some reduction in print quality.

Therefore, the standard print-quality selector is a slider that allows you to choose between quality and
speed. With some paper types, you can choose a compromise position between the two.

Alternatively, you can select from the custom options: Best, Normal and Fast. If you select Fast, you can also
select Economode, which uses a lower rendering resolution and consumes less ink. It therefore increases
printing speed even further, but reduces print quality. Economode can be selected only from the custom
options (not from the slider).

There is also a supplementary custom option that may have an effect on print quality: Maximum detail. See
High-quality printing on page 58.

E’/{’NOTE: In the Windows driver dialog, the rendering resolution for your job is displayed in the Custom Print
Quality Options dialog box (select Custom options and then Settings). In the Mac 0S X Print dialog, it is
displayed in the Summary panel.

You can select print-quality options in the following ways:

e  Inthe Windows driver dialog: go to the Paper/Quality tab and look at the Print Quality section. If you
select Standard Options, you will see a simple slider with which you can select speed or quality. If you
select Custom Options, you will see the more specific options described above.

e Inthe Mac OS X Print dialog: go to the Paper/Quality panel and look at the Quality Options section. If
you select Standard quality options, you will see a simple slider with which you can select speed or
quality. If you select Custom quality options, you will see the more specific options described above.

e  Onthe Embedded Web Server's Submit Job page: select Basic settings > Print quality. If you then
select Standard options, you can choose between Speed and Quality. If you select Custom options,
you will see the more specific options described above.

®  Using the front panel: press “ then , then Setup > Printing preferences > Print quality.

?‘ NOTE: If the print quality is set from your computer, it overrides the print-quality setting in the front
panel.
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=2 NOTE: You cannot change the print quality of pages that the printer is already receiving or has already
received (even if they have not started to print yet).

Select paper size

The paper size can be specified in the following ways.

@’NOTE: The paper size specified here should be the paper size in which the document was created. It is
possible to rescale the document to a different size for printing. See Rescale a print on page 56.

° In the Windows driver dialog: select the Paper/Quality tab, then select your paper size from the
Document Size list.

e Inthe Mac 0S X Page Setup dialog: select your printer from the Format for list, then select your paper
size from the Paper Size list.

E‘%NOTE: If your application offers no Page Setup dialog, please use the Print dialog.

e  Onthe Embedded Web Server's Submit Job page: select Advanced settings > Paper > Page size >
Standard.

®  Using the front panel: press “ then , then Setup > Printing preferences > Paper options >
Select paper size.

E‘/f’NOTE: If the paper size is set from your computer, it overrides the paper size setting in the front
panel.

Custom paper sizes

If you want to choose a paper size that is not included in the list of standard paper sizes, there are various
different ways to specify it.

Use the Windows printer driver
1.  Select the Paper/Quality tab.
2.  Pressthe Custom button.
3. Enter the name and dimensions of your new paper size.
4. Press OK. The new paper size is automatically selected.
A custom paper size created in this way has the following characteristics:
e  The paper size is permanent. It will not disappear if the driver is closed or the computer is turned off.

e The papersizeis local to the printer queue. It will not be seen from other printer queues in the same
computer.

e In Domain server networks, the paper size is local to the computer. It will not be seen from other
computers sharing the printer queue.

e In Workgroup networks, the paper size will be shared among all the computers sharing the printer
queue.

e |If the printer queue is deleted, the paper size is deleted with it.

Use Windows forms
1.  From the Start menu, or from the Control Panel, select Printers and Faxes.

2. From the File menu, select Server Properties.
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1.

In the Forms tab, check the Create a new form box.

Enter the name and dimensions of your new paper size. Leave the margins as 0.00.
Press the Save Form button.

Go to the printer driver, and select the Paper/Quality tab.

Select More... from the drop-down list of paper sizes.

Select your new paper size from the group of Custom sizes.

A custom paper size created in this way has the following characteristics:

The paper size is permanent. It will not disappear if the driver is closed or the computer is turned off.

Restricted users cannot create paper forms. The “manage documents” role in the Windows Active
Directory is the minimum required.

The paper size is local to the computer. It will be seen in all the printer queues that have been created
on the computer and that support paper of that size.

If a printer queue is shared, this paper size will appear in all the client computers.

If a printer queue is shared from another computer, this paper size will not appear on the driver’s
document size list. A Windows form in a shared queue needs to be created in the server.

If the printer queue is deleted, the paper size is not deleted.

Use the Mac 0S X printer driver

1.

2.

Go to the Page Setup dialog.

=2 NOTE: If your application offers no Page Setup dialog, please use the Print dialog.

Select Paper Size > Manage Custom Sizes.

Use the Embedded Web Server

1.

2.

Go to the Submit Job page.

Select Advanced settings > Paper > Page size > Custom.

Select margins options

ENWW

By default, the printer leaves a 5 mm margin between the edges of your image and the edges of the paper

(increased to 17 mm at the foot of cut-sheet paper). However, you can change this behavior in several ways.

In the Windows driver dialog: select the Paper/Quality tab and then the Margins/Layout button.
In the Mac 0S X Print dialog: select the Margins/Layout panel.

On the Embedded Web Server's Submit Job page: select Advanced settings > Paper > Layout/
Margins.

You will then see at least some of the following options.

E”%NOTE: Under Mac 0S X, the available margins options depend on the paper size selected. For instance, for

borderless printing you must select a paper size name that includes the words “no margins”.

Advanced print settings
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Standard. Your image will be printed on a page of the size you have selected, with a narrow margin
between the edges of the image and the edges of the paper. The image should be small enough to fit
between the margins.

Oversize. Your image will be printed on a page slightly larger than the size you have selected. If you cut
off the margins, you will be left with a page of the size you selected, with no margins remaining
between your image and the edges of the paper.

Clip Contents By Margins. Your image will be printed on a page of the size you have selected, with a
narrow margin between the edges of the image and the edges of the paper. In this case, if the image is
the same size as the page, the printer assumes that the extreme edges of the image are either white or
unimportant, and do not need to be printed. This may be useful when your image already contains a
border.

Borderless. Your image will be printed on a page of the size you have selected, with no margins. The
image is slightly enlarged to ensure that no margin is left between the edges of the image and the
edges of the paper. If you select Automatically by Printer, this enlargement is done automatically. If
you select Manually in Application, you must select a custom page size slightly larger than the page on
which you intend to print. See also Print with no margins on page 59.

Print on loaded paper

To print a job on whichever paper is loaded in the printer, select Use Printer Settings in the Paper Type
option of your printer driver.

In the Windows driver dialog: select the Paper/Quality tab, then select Use Printer Settings in the
Paper Type drop-down list.

In the Mac 0S X Print dialog: select the Paper/Quality panel, then select Use Printer Settings in the
Paper Type drop-down list.

=7 NOTE: Use Printer Settings is the default Paper Type selection.

Rescale a print

You can send an image to the printer at a certain size but tell the printer to rescale it to a different size
(normally larger). This may be useful:

If your software does not support large formats

If your file is too large for the printer's memory—in this case, you can reduce the paper size in your
software and then scale it up again using the front-panel option

You can rescale an image in the following ways:

In the Windows driver dialog: go to the Features tab and look at the Resizing Options section.

° The Print document on option adjusts the image size to the paper size you have selected. For
example, if you have selected ISO A2 as the paper size and you print an A3-sized image, it is
enlarged to fit the A2 paper. If the ISO A4 paper size is selected, the printer reduces a larger image
to fit the A4 size.

° The % of actual size option enlarges the printable area of the original paper size (the page minus
the margins) by the percentage indicated, then adds the margins to create the output paper size.

In the Mac 0S X Print dialog: select the Finishing panel, then Print document on, and select the paper
size to which you want to scale the image. For example, if you have selected ISO A2 as the paper size
and you print an A3-sized image, it is enlarged to fit the A2 paper. If the ISO A4 paper size is selected,
the printer reduces a larger image to fit the A4 size.

On the Embedded Web Server's Submit Job page: select Advanced settings > Resizing.
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The Standard and Custom options adjust the image size to the standard or custom paper size you
have selected. For example, if you have selected ISO A2 as the paper size and you print an A4-size
image, it is enlarged to fit the A2 paper. If the ISO A3 paper size is selected, the printer reduces a
larger image to fit the A3 size.

The % of actual size option enlarges the printable area of the original paper size (the page minus
the margins) by the percentage indicated, then adds the margins to create the output paper size.

®  Using the front panel: press ﬂ then , then Setup > Printing preferences > Paper options >
Resize.

If you are printing to a single sheet, you must ensure that the image can actually fit onto the sheet, otherwise
the image will be clipped.

Change the treatment of overlapping lines

E’%NOTE: This topic applies only when printing an HP-GL/2 job.

The merge option controls the overlapping lines in an image. There are two settings:

e  Off: where the lines cross, only the color of the top line is printed. This is the default setting.

° On: where the lines cross, the colors of the two lines merge.

To turn merge on, go to the front panel and press ﬂ, then , then Setup > Printing preferences > HP-

GL/2 options > Enable merge. You can set the merge option from your software in some applications.
Settings in your software override the front-panel settings.

Preview a print

Print a draft

ENWW

Previewing a print on the screen allows you to check the layout of the print before printing, which may help
you to avoid wasting paper and ink on a bad print.

e  Topreview a print under Windows, you have the following options:

o

Use your application’s print preview option.

Check the Show preview before printing option, which you can find in the driver's Paper/Quality
tab and Features tab. This preview is provided by the Embedded Web Server and will appearina
Web browser window.

e  Topreview a print under Mac 0S X, you have the following options:

o

Use your application's print preview option.

Click the Preview button at the bottom of the Print dialog box. This is the basic print preview
provided by Mac 0S X.

Check the Show print preview option, which you can find in the driver's Printing dialog, in the
Finishing panel. This preview is provided by the Embedded Web Server and will appear in a Web
browser window.

E%NOTE: This option does not work if the printer is connected by USB cable to a different computer

(printer sharing).

e  Topreview a print using the Embedded Web Server, select Basic settings > Hold for preview.

You can specify fast draft-quality printing in the following ways:

Advanced print settings

57



58

In the Windows driver dialog: go to the Paper/Quality tab and look at the Print Quality section. Move
the print-quality slider to the extreme left ('Speed').

In the Mac 0S X Print dialog: go to the Paper/Quality panel and move the print-quality slider to the
extreme left ('Speed).

On the Embedded Web Server's Submit Job page: select Basic settings > Print quality > Standard
options > Speed.

Using the front panel: press [, then , then Setup > Printing preferences > Print quality >
Select quality level > Fast.

You can specify even faster draft-quality printing by using Economode, as follows. This is intended mainly for
documents containing only text and line drawings.

In the Windows driver dialog: go to the Paper/Quality tab and look at the Print Quality section. Select
Custom Options, then set the quality level to Fast and check the Economode box.

In the Mac 0S X Print dialog: go to the Paper/Quality panel and set the quality options to Custom, then
set quality to Fast and check the Economode box.

On the Embedded Web Server's Submit Job page: select Basic settings > Print quality > Custom. Set
Quality level to Fast, and Economode to On.

Using the front panel: press [J[iJ], then , then Setup > Printing preferences > Print quality >
Enable economode.

=¥ NOTE: If the print quality is set from your computer, it overrides the print-quality setting in the front panel.

High-quality printing

You can specify high-quality printing in the following ways:

In the Windows driver dialog: go to the Paper/Quality tab and look at the Print Quality section. Move
the print-quality slider to the extreme right (‘Quality’).

In the Mac 0S X Print dialog: go to the Paper/Quality panel and move the print-quality slider to the
extreme right ('Quality’).

On the Embedded Web Server's Submit Job page: select Basic settings > Print quality > Standard
options > Quality.

Using the front panel: press [, then , then Setup > Printing preferences > Print quality >
Select quality level > Best.

=¥ NOTE: If the print quality is set from your computer, it overrides the print-quality setting in the front panel.

If you have a high-resolution image

If your image has a resolution greater than the rendering resolution (which you can see in the Custom Print
Quality Options box under Windows), print sharpness may be improved by selecting the Maximum Detail
option. This option is available only if you are printing on glossy paper and you have selected Best print
quality.
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e Inthe driver dialog (Mac 0S X Print dialog): select Custom instead of Standard print-quality options,
then check the Maximum Detail box.

e  Onthe Embedded Web Server's Submit Job page: select Basic settings > Print quality > Custom. Set
Quality level to Best, and Maximum detail to On.

®  Using the front panel: press [J[iJ then , then Setup > Printing preferences > Print quality >
Enable maximum detail.

%?NOTE: The Maximum Detail option results in slower printing with photo papers, but it does not increase the
amount of ink used.

Print in gray shades

You can convert all colors in your image to shades of gray: see Printing in grayscale on page 76.

Print with no margins

Printing with no margins (to the edges of the paper) is known as borderless printing. This can be done only on
rolls of glossy paper.

In order to be sure of leaving no margins, the printer prints slightly past the edges of the paper. Any ink
deposited outside the paper is absorbed by the sponge situated in the platen.

You can request printing with no margins in the following ways:

e Inthe Windows driver dialog: select the Paper/Quality tab and press the Margins/Layout button.
Then select Borderless.

e Inthe Mac 0S X Page Setup dialog: select a paper size name that includes the words “no margins”.
Then, in the Print dialog, select Margins/Layout > Borderless.

=¥ NOTE: If your application offers no Page Setup dialog, please use the Print dialog.

e  OntheEmbedded Web Server's Submit Job page: select Advanced settings > Paper > Layout/Margins
> Borderless.

When you select Borderless, you must also select one of the following Image Enlargement options:

e  Automatically by printer means that the printer automatically enlarges your image slightly (normally
by a few millimeters in each direction) in order to print over the edges of the paper.

e  Manually in application means that you must enlarge the image yourself in your application, and select
a custom paper size that is slightly larger than the actual paper size.

E‘/f’NOTE: If the first print job after loading paper is a borderless job, the printer may trim the leading edge of
the paper before printing.

At the end of a borderless print, the printer normally cuts the print slightly inside the image area to ensure
that the print is borderless. It then cuts the paper again so that no residual part of the image is included in the
next print. However, if the job is cancelled, or if there is white space at the bottom of the image, only a single
cut is made.

Print with crop lines

Crop lines indicate where the paper should be cut to reduce it to your selected page size. You can print crop
lines with individual jobs in the following ways:
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e Inthe Windows driver dialog: select the Features tab, then Crop lines.
e Inthe Mac 0S X Print dialog: select the Finishing panel, then Crop lines.

e  Onthe Embedded Web Server's Submit Job page: select Advanced settings > Roll options > Enable
crop lines > Yes.

Alternatively, you can choose to print crop lines with all jobs by default:

e Inthe Embedded Web Server: select Setup > Printer settings > Job management > Use crop lines
when printing > On.

®  Using the front panel: press [i]] then , then Setup > Printing preferences > Paper > Enable
crop lines > On.

To print crop lines with nested jobs (see Nest jobs to save roll paper on page 60), you must select a
different option:

e Inthe Embedded Web Server: select Setup > Printer settings > Job management > Use crop lines
when nest is enabled > On.

®  Using the front panel: press J[i]] then , then Setup > Job management > Nest options > Enable
crop lines > On.

Use paper economically

Here are some recommendations for making economical use of paper:

e Ifyou are printing relatively small images or document pages, you can use nesting to print them side by
side instead of one after another. See Nest jobs to save roll paper on page 60.

e  Youmay be able to save some roll paper by using the following options:

° In the Windows driver dialog: select the Features tab and then Remove top/bottom blank areas
and/or Rotate by 90 degrees or Autorotate.

° In the Mac 0S X Print dialog: select the Finishing panel, then Remove Top/Bottom Blank Areas
and/or Rotate by 90 degrees.

° On the Embedded Web Server's Submit Job page: select Advanced settings > Roll options >
Remove top/bottom blank areas and/or Rotate.

e If you check the print preview on your computer before printing, you can sometimes avoid wasting
paper on prints containing obvious mistakes. See Preview a print on page 57.

Nest jobs to save roll paper

Nesting means automatically printing images or document pages side by side on the paper, rather than one
after the other. This is done to avoid wasting paper.

60 Chapter 7 Printing ENWW



1. Direction of paper flow
2. Nesting off
3. Nestingon

4. Paper saved by nesting

When does the printer try to nest pages?
When both of the following are true:
e  The printer is loaded with roll paper, not sheet paper.

e  The printer's Nest option is turned on. See Turn nesting on and off on page 23.

What pages can be nested?

All pages can be nested, unless they are so large that two of them cannot fit side by side on the roll, or unless
there are too many of them to fit into the remaining length of the roll. A single group of nested pages cannot
be split between two rolls.

Which pages qualify for nesting?
In order to be in the same nest, the individual pages must be compatible in all of the following ways:
e  All pages must have the same print quality setting (Economode, Fast, Normal or Best).
e  The Maximum Detail setting must be the same on all pages.
e  The Layout/Margins setting must be the same for all pages.
e  The Mirror Image setting must be the same for all pages.
e  The Rendering Intent must be the same for all pages.
e  The Cutter setting must be the same for all pages.

e  The color adjustment settings must be the same for all pages. See Color adjustment options
on page 75.

e  Pages must be all color, or all grayscale: not some in color and some in grayscale.

e  All pages must be in one or other of the following two groups (the two groups cannot be mixed in the
same nest):
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° HP-GL/2, RTL, TIFF, JPEG
° PostScript, PDF

e  JPEG and TIFF pages with resolutions greater than 300 dpi may not nest with other pages in some
cases.

How long does the printer wait for another file?

So that the printer can make the best nest possible, it waits after a file has been received to check whether a
subsequent page will nest with it or with pages already in the queue. This waiting period is the nest wait time;
the factory default nest wait time is 2 minutes. This means that the printer waits for up to 2 minutes after the
last file is received before printing the final nest. You can change this waiting time from the printer's front

panel: press [ then , then Setup > Job management options > Nest options > Select wait time.
The available range is 1 to 99 minutes.

While the printer is waiting for nesting to time out, it displays the remaining time on the front panel.

Use ink economically
Here are some recommendations for making economical use of ink.

e  For draft prints, use plain paper and move the print-quality slider to the left end of the scale (‘Speed’).
For further economy, select custom print quality options, then select Fast and Economode.

e  (lean the printheads only when needed, and clean only those printheads that need cleaning. Cleaning
the printheads can be useful, but it uses a small amount of ink.

e  Leave the printer permanently turned on so that it can maintain the printheads in good condition
automatically. This regular printhead maintenance uses a small amount of ink. However, if it is not
done, the printer may need to use much more ink later to restore the health of the printheads.

e  Wide prints make more efficient use of ink than narrow prints, because printhead maintenance uses
some ink, and its frequency is related to the number of passes made by the printheads. Therefore,
nesting jobs can save ink as well as saving paper (see Nest jobs to save roll paper on page 60).

Roll protection

If you choose to protect a roll, jobs will be printed on it only if the job explicitly specifies the roll number or
the paper type loaded on the roll. This may be useful, for example, in the following cases.

e  Tostop people from accidentally printing unimportant jobs on expensive paper.

e  Toavoid printing on a particular roll when printing from AutoCAD without interacting with the HP printer
driver.

To protect aroll, go to the front panel and press “ then , then Setup > Printing preferences >
Paper options > Roll protection.

i.“—“‘ NOTE: If you protect aroll, then later unload the current roll and load a new one, the new roll remains
protected. You are protecting the roll number, not one specific roll of paper. That roll number will remain
protected until you cancel the protection.

_‘{}: TIP: If you print without specifying a roll number or paper type, you will not be able to print on any
° protectedroll.

Unattended printing/overnight printing

The printer is well suited to long, unattended print jobs, having multiple rolls plus robust and consistent
image quality.
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Here are some recommendations to help you deal with a long queue of printing jobs.
e  |[f feasible, use brand-new long rolls of paper.

e If you want to print on partly-used rolls, you can check the paper type and the remaining length in the
Embedded Web Server or in the front panel, to confirm that you have enough paper to print all your
jobs.

= NOTE: Information on the remaining length is available only if you told the printer the length of the
roll when you loaded it, or if the printer read the length of the roll from the barcode printed on it.

e Loadtwo rolls of paper suitable for your jobs. If the printer finishes one roll, it will automatically switch
to the other.

e Ifyouintend to use two rolls, avoid using uncuttable paper (such as canvas) for the first roll, because
then the printer will be unable to switch to the other roll.

e  Check that you have paper wide enough to print all of your jobs. Any jobs that are too wide may be put
on hold for paper if the paper mismatch action is set to Put job on hold (see Paper mismatch action
on page 23).

e  Check the ink levels remaining in your ink cartridges.

e  When you have submitted your print jobs, you can use the Embedded Web Server from a remote
location to monitor their status.

e  Drying time should be set to Optimal.

®  Press ﬂ then , then Setup > Printing preferences > Paper options > Roll switching options >
Minimize roll changes or Use roll with less paper.

We recommend the following settings, depending on the paper type and what kind of prints you are making.

Table 7-1 Recommended settings for unattended printing

Print type Print mode Max Detail Drying time Paper types

Lines Normal Off Optimal Coated, Bond,
Heavyweight Coated,
Glossy

Lines and fills Normal Off Optimal Coated, Bond,
Heavyweight Coated,
Glossy

Maps Best Off Optimal Coated, Heavyweight
Coated, Glossy

Renderings, Best Off Optimal Coated, Heavyweight

photographs Coated, Glossy
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63



64

Web-connected printing

Your printer can be connected to the Web, providing various benefits:

e  Automatic firmware updates (see Update the firmware on page 108)

e  Print to your printer by sending it an email message with the file to be printed as an attachment. PDF,
TIFF, and JPG files are supported.

For the latest information, see http://www.hp.com/go/designjeteprinters.

Print by email

After you have enabled Web Services, you can print to your printer by email. Just check the Web Services
menu or the ePrint menu for the email address of your printer, then send the file you want to print to that
email address as an attachment.

In this way, you can print from anywhere with an Internet connection, without needing any printer driver.
There are a few limitations that you should bear in mind:

e  The attached files to be printed must be in PDF, JPEG, or TIFF format.
e  The maximum file size is 10 MB, but your email server may have a lower limit.

e  Files are printed in the original document size (at 100% scale), in normal quality, in color, and normally
in portrait orientation (some printers may offer autorotation).

e  The paper type is set to plain paper. If some other paper type is loaded, the printer may either print it
anyway or put it on hold, depending on the paper mismatch action (see Paper mismatch action
on page 23).
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Job queue management

° The job queue in the front panel

° The job queue in the Embedded Web Server or HP Utility

The job queue in the front panel

To see the job queue on the front panel, press |33 on the home screen.

Job queue page

The job queue page shows all jobs that are available in the job queue. It includes jobs that are being received,
parsed, rendered, printed and already printed.

Each line shows the name of the job and its status. For more information on a particular job, including a
preview of the job, press the line showing the job.

Jobs that cannot be completed for any reason appear at the top of the queue.

Job preview

The printer generates a JPEG file for each incoming job, which can be displayed as a preview of the job. Job
preview is available once the job is processed.

E‘%NOTE: Do not try to preview a job with more than 64 pages, which may cause software problems.

To preview a job, first press the name of the job in the job queue. The front panel displays a page of
information about the job. Then press [{e§l to see the preview.

r__f"%NOTE: Previews may be blocked by an administrator, in which case you will not be able to see them.

When the preview is displayed, you can press it to zoom in on it. Press it again to zoom out.

You can also press [] to preview the previous job, or [J to preview the next job.

Select when to print a job in the queue

ENWw

r__f%NOTE: The When To Start Printing options cannot be used with PostScript jobs.

You can select at what point you want to print a file you have in the queue. Press i then , then
Setup > Job management options > When to start printing.

There are three options you can select:

The job queue in the front panel

65



e  When After Processing is selected, the printer waits until the whole page has been processed and then
it starts to print. This is the slowest setting but ensures the best print quality in large or complex prints.

e  When Immediately is selected, the printer prints the page as it is processed. This is the quickest setting,
but the printer may stop halfway through a print to process data. This setting is not recommended for
complex images with dense color.

e  When Optimized is selected (this is the default setting), the printer calculates the best time to begin
printing the page. It is usually the best compromise between the After Processing and Immediately
settings.

Prioritize a job in the queue

You can select a job in the queue and make it the next one to be printed. After selecting the job, press Move
to front.

If nesting is turned on, the prioritized job may still be nested with others. If you really want this job to be
printed next, and not nested with others, first turn nesting off and then move it to the front of the queue as
described above.

In the following cases, the Move to front button is not displayed:

e Thejobis already at the front of the queue.

e Thejobis on hold—in this case the Resume printing button is displayed instead.
e  Thejob has finished—in this case the Reprint button is displayed instead.

e  Thejob has some error condition.

Pause a job in the queue

If you select the job in the queue that is currently printing, you will see a Pause button, which you can press
to pause printing. The Pause button then changes to a Resume button, which you can press to resume
printing.

Alternatively, you can press the Options button at the top right of the job queue screen, and then press
Pause printing.

Reprint a job from the queue
To reprint an already-printed job, select the job from the queue, then select Reprint.

When reprinting a print job, you cannot change the print settings, because the job has already been
rasterized.

Delete a job from the queue

Under normal circumstances, there is no need to delete a job from the queue after printing it, as it will just
fall off the end of the queue as more files are sent. However, if you have sent a file in error, and want to avoid
printing it, you can simply select the job and then press Delete.

= NOTE: If an administrator password has been set, it will be required.

In the same way, you can delete a job that has not been printed yet.

If the job is currently being printed (its status is printing), you can press Cancel and then Delete.
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Delete all jobs

To delete all jobs in a queue, press the Options button at the top right of the job queue screen, and then
press Delete all jobs.

|*__*:"’49N0TE: If an administrator password has been set, it will be required.

Turn off the job queue

To turn off the job queue, press [ then , then Setup > Job management options > Enable queue >
Off.
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The job queue in the Embedded Web Server or HP Utility

The HP Utility provides a different way of accessing the Embedded Web Server's job management facilities,
but the facilities are exactly the same whether you use the Embedded Web Server or the HP Utility.

To see the queue in the Embedded Web Server, select Job queue in the Main tab.

Job queue page

By default, access to the job queue is open to all users. An administrator can set a password so that users are
required to enter a password for:

e  Seeing job previews
e  (anceling or deleting jobs

The job queue page shows all jobs that are available in the print queue. The print queue includes jobs that are
being received, parsed, rendered, printed and already printed.

The Embedded Web Server displays the following information for each print job:

e  Preview: Click the icon to see the job preview. The job preview is available once the job is processed.
e  File name: Click the file name to see the properties of the job.

e  Status: Gives the current job status.

e  Pages: Number of pages in the job.

e  (Copies: Number of copies printed.

e Date: Date and time the printer received the job.

e  User: The user's name.

Jobs in the queue can be sorted by any of the information items (except Preview) by clicking on the title of
the corresponding column. You can perform the following operations on one or all jobs in the queue:

e  Cancel: Cancels the selected jobs. You are asked to confirm before the job is canceled. The job remains
stored in the printer, but will not be printed unless you click Reprint.

e  Hold: Holds the select jobs until you click Continue to print.

e  Continue: All selected jobs, which are on hold, continue printing.

e  Reprint: Prints more copies of a job. Type the number of copies (default 1, maximum 99) and click Print.
e  Move to front: Sends all selected jobs to the top of the job queue.

e  Delete: Deletes selected jobs from the job queue. You are asked to confirm before the job is deleted.

E’/{’NOTE: The Delete operation can be disabled by an administrator.

Refresh: Refreshes the page, ensuring the information is updated.

E‘/f’NOTE: The job queue page does not automatically update.

Job preview

68

The printer generates a JPEG file for each incoming job, which can be displayed as a preview of the job. Job
preview is available once the job is processed.
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E‘%"NOTE: Do not try to preview a job with more than 64 pages, which may cause software problems.

To reach the preview page, click the magnifying glass icon, which appears in the Preview column on the job
queue page. The preview page shows the following job details along with a thumbnail preview of the job:

° File name: The file name of the job.
e Loaded paper: The type of paper loaded in the printer.
e Job dimensions: The dimensions of the job.

To see a larger preview of the job, click either the job thumbnail or the magnifying glass icon, which appears
on the right-hand side of the printer image.

E‘/{’NOTE: Browsers without the Adobe Flash plug-in show the job image as yellow shaded. Browsers that have
the Adobe Flash plug-in version 7 and above show an enhanced preview of the job image inside the paper
loaded in the printer.

Select when to print a job in the queue

E’/{’NOTE: The When To Start Printing options cannot be used with PostScript jobs.

You can select at what point you want to print a file you have in the queue. Select the Setup tab, then Printer
settings > Start printing.

There are three options you can select:

e  When After Processing is selected, the printer waits until the whole page has been processed and then
it starts to print. This is the slowest setting but ensures the best print quality in large or complex prints.

e  When Immediately is selected, the printer prints the page as it is processed. This is the quickest setting,
but the printer may stop halfway through a print to process data. This setting is not recommended for
complex images with dense color.

e  When Optimized is selected (this is the default setting), the printer calculates the best time to begin
printing the page. It is usually the best compromise between the After Processing and Immediately
settings.

Prioritize a job in the queue

You can select any job in the queue and make it the next one to be printed. After selecting the job, click
Reprint.

If nesting is turned on, the prioritized job may still be nested with others. If you really want this job to be
printed next, and not nested with others, first turn nesting off and then move it to the front of the queue as
described above.

Delete a job from the queue

Under normal circumstances, there is no need to delete a job from the queue after printing it, as it will just
fall off the end of the queue as more files are sent. However, if you have sent a file in error, and want to avoid
printing it, you can simply select the job and then select Delete.

In the same way, you can delete a job that has not been printed yet.

If the job is currently being printed (its status is printing), you can select Cancel and then Delete.

Reprint or copy a job in the queue

To reprint or make extra copies of any job in the queue, select the job in the Embedded Web Server and click
the Reprint icon, then specify the number of copies you want. The job will be moved to the top of the queue.
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To make more than one print of a non-printed job in the queue from the front panel, select the job and
choose Copies, then specify the number of copies required. This overrides any value set by your software.

=7 NOTE: If Rotate was On when you sent the file, every copy will be rotated.

=¥ NOTE: You cannot use this method for PCL3 jobs. To reprint old jobs that are PCL3, you may be able to use
your operating system's printer spooler, if you have already set the spooler to save old jobs. This facility
depends on your operating system.

=2 NOTE: When reprinting a print job, you cannot change the print settings, because the job has already been
rasterized.

Job status messages

These are the possible job status messages, approximately in the order in which they may be seen:

Receiving: the printer is receiving the job from the computer

Waiting to process: the job has been received by the printer and is waiting to be rendered (for jobs
submitted through the Embedded Web Server only)

Processing: the printer is parsing and rendering the job
Preparing to print: the printer is performing writing system checks before printing the job
Waiting to print: the job is waiting for the print engine to become free to proceed with printing

Waiting for nest: the printer is set up with Nesting=0n and is waiting for other jobs in order to complete
the nest and proceed with printing

On hold: the job was sent with the on hold for preview option and is on hold

E‘/f’NOTE: Do not send a job for preview with more than 64 pages, this may cause the driver software to
crash.

E”%’NOTE: If the printer hangs up while printing a job, and the queue facility is turned on, the partially
printed job will appear in the queue as on hold when the printer is next turned on. When you resume the
job, it will start printing at the page at which it was interrupted.

On hold for paper: the job cannot be printed because the right paper is not loaded in the printer, or
because the active roll is uncuttable and so the printer cannot automatically switch to the standby roll.
Load the required paper, see Paper handling on page 33, and click Continue to resume the job.

On hold for accounting: the job cannot be printed because the printer requires all jobs to have an
account ID: enter the account ID and then click Continue to resume the job

"ﬂl?" TIP: TosetanaccountID, see Require account ID on page 26.

Printing

Drying

Cutting paper

Ejecting page

Canceling: the job is being canceled, but will remain in the printer job queue
Deleting: the job is being deleted from the printer

Printed

Canceled: the job has been canceled by the printer
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e  (Canceled by user

e  Empty job: the job does not contain anything to print

Reactivate a job on hold

When the printer puts a job on hold you receive an alert, see Alerts on page 155, which explains why the job
is on hold. Follow the instructions on the screen to remove the hold and continue printing.

Turn off the job queue

To turn off the job queue, select the Setup tab, then Printer settings > Job management > Queue and select
Off.
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Introduction

Your printer has been engineered with advanced hardware and software features to ensure predictable and
dependable results.

e  (Color calibration for consistent colors.
e  Onegray and two black inks provide neutral grays on all paper types.
e  The Photo Black ink provides pure blacks when printing on photo papers.

e  (olor emulation of other HP DesignJet printers.

How colors are represented

All devices that display color use a color model to represent color in numerical terms. Most monitors use the
RGB (Red-Green-Blue) color model, while most printers use the CMYK (Cyan-Magenta-Yellow-blacK) color
model.

An image can be converted from one color model to another, but in general the conversion is not perfect.
Your printer uses the RGB color model: the same color model that is used by your monitor.

This simplifies but does not completely solve the problem of matching colors. Each device represents colors
a little differently from another device, even if they use the same color model. However, software can adjust
the colors in an image according to the characteristics of the particular device, using a color profile of the
device, in order to achieve correct colors.

A summary of the color management process

To get the accurate and consistent colors that you want, you should follow these steps for each paper type
that you use.

1. Color-calibrate the paper type, for consistent colors. Calibration should be repeated every now and then
(see Color calibration on page 73). In addition, you may wish to calibrate immediately before a
particularly important print job for which color consistency is vital.

2. When printing, select the correct color preset for the paper type you are using.

Color calibration

ENWW

Color calibration enables your printer to produce consistent colors with the particular printheads, inks and
paper type that you are using, and under your particular environmental conditions. After color calibration,
you can expect to get similar prints from any two different printers situated in different geographical
locations.

Some paper types cannot be calibrated. For all other paper types, calibration should be done in any of the
following circumstances:

e  Whenever a printhead is replaced

e  Whenever a new paper type is introduced that has not yet been calibrated with the current set of
printheads

e  Whenever the environmental conditions (temperature and humidity) change significantly

You can check the color calibration status of the currently loaded paper at any time by pressing “ and
then on the front panel. The status may be one of the following:

e Recommended: the paper has not been calibrated.
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E”%NOTE: Whenever you update the printer's firmware, the color calibration status of all papers is reset
to Recommended.

e  Obsolete: the paper has been calibrated, but the calibration is now out of date because a printhead has
been replaced, and should be repeated.

e Done: the paper has been calibrated, and the calibration is up to date.

e  Disabled: this paper cannot be calibrated.

E}'"NOTE: Color calibration cannot be performed on plain paper, nor on any kind of transparent material.

You can also check the color calibration status by using the HP Utility.
You can start color calibration in the following ways:

e  From the HP Utility for Windows: select Color Center > Calibrate paper, and choose the paper to be
calibrated.

e  From the HP Utility for Mac 0S X: select Paper Preset Management from the HP Color Center group,
choose the paper to be calibrated, press the [ ¢ | button and select Calibrate Paper.

®  From the front panel: press [J[{J then , then Image quality maintenance > Calibrate color.

The calibration process is fully automatic and can be performed unattended after you have loaded paper of
the type you wish to calibrate—which should be A4 or any larger size. If you have more than one roll loaded,
the printer will ask which roll you want to use for the calibration.

The process takes about 3—-5 minutes and consists of the following steps.

1. Acalibration chart is printed, which contains patches of each ink used in your printer.
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2. Thechartis allowed to dry for a period of time that depends on the paper type, so that the colors have
time to stabilize.

3. Thechartis scanned and measured.

4. From the measurements, the printer calculates the necessary correction factors to apply for consistent
color printing on that paper type. It also calculates the maximum amount of each ink that can be applied
to the paper.

Color management from printer drivers

Color management options

The aim of color management is to reproduce colors as accurately as possible on all devices: so that, when
you print an image, you see very similar colors as when you view the same image on your monitor.

There are two basic approaches to color management for your printer:
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e Application-Managed Colors: in this case your application program must convert the colors of your
image to the color space of your printer and paper type, using the ICC profile embedded in the image
and the ICC profile of your printer and paper type.

e  Printer-Managed Colors: in this case your application program sends your image to the printer without
any color conversion, and the printer converts the colors to its own color space. The details of this
process depend on the graphics language that you are using.

° PostScript: the PostScript interpreter module performs the color conversion using the profiles
stored in the printer and any additional profiles sent with the PostScript job. This kind of color
management is done when you are using the PostScript driver and you specify printer color
management or when you send a PostScript, PDF, TIFF or JPEG file directly to the printer through
the Embedded Web Server. In either case you have to select the profiles to use as default (in case
the job doesn't specify any) and the rendering intent to apply.

° Non-PostScript (PCL3, HP-GL/2, RTL): the color management is done using a set of stored color
tables. ICC profiles are not used. This method is somewhat less versatile than the alternatives, but
is a little simpler and faster, and can produce good results with standard HP paper types. This kind
of color management is done when you send a PCL3, HP-GL/2, or RTL file directly to the printer
through the Embedded Web Server.

E%NOTE: The printer can convert only the following color spaces to its own color space using the
stored color tables: Adobe RGB and sRGB if you are using Windows, Adobe RGB if you are using Mac
0S X.

You are recommended to consult the Knowledge Center (see Knowledge Center on page 161) to see how to
use the color management options of your particular application.

To choose between Application-Managed Colors and Printer-Managed Colors:
e  Inthe Windows driver dialog: select the Color tab.
e  Inthe Mac OS X Print dialog: select the Color Options panel.

e Insome applications: you can make this choice in the application.

Printer emulation

If you want to print a particular job and to see approximately the same colors that you would get from
printing the same job on a different HP DesignJet printer, you can use the emulation mode provided by your
printer.

E‘/{’NOTE: This option is available only when printing an HP-GL/2, PostScript, or PDF job. It will work correctly
only when printing on plain, coated or heavyweight coated paper.

e  Inthe Windows driver dialog: select the Color tab, then Printer Managed Colors, then select Printer
Emulation from the Source Profile list. You can then select from the Emulated Printer list.

e Inthe Mac 0S X Print dialog: select the Color Options panel, then select from the Printer Emulation list.

Color adjustment options
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The aim of color management is to print accurate colors. If you perform color management correctly, then
you should be able to print accurate colors with no need of any manual color adjustments.

However, manual adjustments may be useful in the following situations:
e If your color management is not working correctly for some reason

e If you want colors that are subjectively pleasing rather than accurate
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The printer driver provides different adjustment facilities depending on whether you are printing in color or in
grayscale.

Printing in color
You can adjust the colors of your print under Windows:

e Inthe Windows driver dialog: select the Color tab, ensure that the Advanced color adjustments box is
checked, then press the Settings button beside it.

You can then make adjustments using a lightness slider and three color sliders.
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e  Thelightness slider simply makes the whole print lighter or darker.

e  The color sliders can be used to fade or emphasize each of the primary colors in the print. The primary
colors may be red, green and blue; or cyan, magenta and yellow; depending on the color model used in
the image.

The Reset button restores each slider to its default central position.

Printing in grayscale
You can convert all colors in your image to shades of gray in the following ways:
e Inyour application program: many programs provide this option.

e Inthe Windows driver dialog: go to the Color tab and look at the Color Options section. Select Print in
Grayscale.

e Inthe Mac 0S X Print dialog: go to the Color Options panel and select Grayscale from the Mode drop-
down list.

e  Onthe Embedded Web Server's Submit Job page: select Color, then set Color/Grayscale to Print In
Grayscale.

You can adjust the gray balance of your print under Windows:

e Inthe Windows driver dialog: select the Color tab, ensure that the Advanced color adjustments box is
checked, then press the Settings button beside it.

You can then make adjustments using separate controls for highlights, midtones, and shadows.

76 Chapter 10 Color management ENWW



Advanced Lightness and Gray Balance Adjustments 2l
~Lightness ~Freview
i J
.o [ . Befors:
50 50
~Gray Balance
- Zane Definitions
Highlights = |
o 100
Pidtone: 50 )'
o 100
Shadow: |—75 )'
o T T After:
[~ Highlight Midtone Shade
% & 3 2 e 7
— = 8 ) = -
L e i} 10 =i U e
i ¥ v
¥ Apply midtone adjustrments to &l

e  The lightness slider simply makes the whole print lighter or darker. This slider is available in the same
window as the other grayscale controls.

e  The zone definition sliders can be used to define what you mean by highlight, midtone, and shadow.

e  The other controls for highlight, midtone, and shadow can be used to adjust the gray balance of
highlights, midtones, and shadows respectively.

The Reset button restores each control to its default setting.

Color management from the printer driver

HP Professional PANTONE Emulation
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When you use a named PANTONE color in an image, your application will normally send to the printer a CMYK
or RGB approximation to that color. But the application does not take the printer or the paper type into
account, it merely produces a generic approximation of the PANTONE color, which will look different on
different printers and on different papers.

HP Professional PANTONE Emulation can do a much better job by taking into account the characteristics of
the printer and the paper type. The results look as similar to the original PANTONE colors as is possible on a
given printer using a given paper type. This technology is designed to produce emulations similar to those set
up manually by prepress professionals.

To use HP Professional PANTONE Emulation, all you have to do is to turn it on. In fact, it is normally on by
default.

e  Inthe Windows driver dialog: go to the Color tab and select HP Professional PANTONE Emulation.

e Inthe Mac 0S X Print dialog: go to the Color Options panel and select HP Professional PANTONE
Emulation.

You can also use the Embedded Web Server to print a swatch book showing emulations of PANTONE colors as
made by your printer, together with a measure of the color difference (AE) between each emulation and the
original PANTONE spot color. So HP Professional PANTONE Emulation not only provides the closest match
that can be achieved on your printer; it also gives clear information on how close the emulation is to the
original spot color. See Printing PANTONE swatch books on page 80.
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Color emulation

Your printer can emulate the color behavior of other devices: RGB devices such as monitors, and CMYK
devices such as presses and printers.

You can set color emulation in the following ways:
e Inthe Windows driver dialog: select the Color tab, and Printer Managed Colors.

e Inthe Mac 0S X Print dialog: select the Color Options panel, then select Printer from the Color
Management list.

For a good emulation, the printer needs a specification of the colors these devices can reproduce. The
standard way of encapsulating such information is in ICC profiles. As part of the solution, we provide the
most common standards for the different devices.

The options are as follows.

CMYK color emulation

A traditional workflow defines color in the CMYK space. For best results, the colors must be adjusted to the
printer, because different printers will produce different colors from the same CMYK data. If the image file
you are printing was not created specifically for your printer, it will require some readjustment, which can be
done using one of the following options provided with your printer.

e None (Native): no emulation. The printer will use its default internal conversion from CMYK to RGB,
without following any color standard. This does not imply that results will be bad

e IS0 Coated 2-ECl is based on the characterization dataset FOGRA39L.txt, applicable to the following
reference printing conditions according to the international standard ISO 12647-2:2004/Amd 1:
commercial and specialty offset, paper type 1 and 2, gloss or matt coated paper, positive plates, tone
value increase curves A (CMY) and B (K), white backing.

e (Coated GRACoL 2006-15012647 provides GRACoL proofing and printing on Grade 1 coated paper, ISO
12647-2 Paper type 1.

e  PSO Uncoated 1S012647-ECl is based on the characterization data set FOGRA47L.txt, applicable to the
following reference printing condition according to the international standards ISO 12647- 2:2004 and
ISO 12647-2:2004/Amd 1:2007: commercial and specialty offset, paper type 4, uncoated white paper,
positive plates, tone value increase curves C (CMY) and D (K), white backing.

e  PSOLWCImproved-EClis based on the characterization data set FOGRA45L.txt, applicable to the
following reference printing condition according to the international standards ISO 12647-2:2004 and
ISO 12647-2:2004/Amd 1:2007: commercial and specialty offset, improved LWC paper (light weight
coating), positive plates, tone value increase curves B (CMY) and C (K), white backing.

e Web Coated SWOP 2006 Grade 3 provides SWOP® proofing and printing on U.S. Grade 3 coated
publication paper.

e Web Coated SWOP 2006 Grade 5 provides SWOP® proofing and printing on U.S. Grade 5 coated
publication paper.

e U.S. Sheetfed Coated 2 uses specifications designed to produce quality separations using U.S. inks
under the following printing conditions: 350% total area of ink coverage, negative plate, bright white
offset stock.

e U.S. Sheetfed Uncoated 2 uses specifications designed to produce quality separations using U.S. inks
under the following printing conditions: 260% total area of ink coverage, negative plate, uncoated white
offset stock.

e U.S. Web Coated (SWOP) 2 uses specifications designed to produce quality separations using U.S. inks
under the following printing conditions: 300% total area of ink coverage, negative plate, coated
publication-grade stock.
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U.S. Web Uncoated 2 uses specifications designed to produce quality separations using U.S. inks under
the following printing conditions: 260% total area of ink coverage, negative plate, uncoated white
offset stock.

Euroscale Uncoated 2 uses specifications designed to produce quality separations using Euroscale inks
under the following printing conditions: 260% total area of ink coverage, positive plate, uncoated white
offset stock.

Japan Web Coated (Ad) uses specifications developed by the Japan Magazine Publisher Association for
digital proofing of images in the Japanese magazine/advertising market.

Japan Color 2001 Coated uses the Japan Color 2001 specification for type 3 (coated) paper. It is
designed to produce quality separations using 350% total ink coverage, positive film and coated paper.

Japan Color 2001 Uncoated uses the Japan Color 2001 specification for type 4 (uncoated) paper. It is
designed to produce quality separations using 310% total ink coverage, positive film and uncoated

paper.

Japan Color 2002 Newspaper uses the Japan Color 2002 for Newspapers specification. It is designed to

produce quality separations using 240% total ink coverage, positive film and standard newsprint paper.

Japan Color 2003 WebCoated is for type 3 coated paper. It is designed to produce quality separations
for standard I1SO printing using 320% total ink coverage, positive film, and coated paper on heat-set
web offset presses.

JMPA: Japanese standard for offset press.
Toyo is designed to produce quality separations for Toyo printing presses.

DIC is designed to produce quality separations for Dainippon Ink Company printing presses.

E‘%"NOTE: These options have no effect if the application is defining its own CMYK space, known as calibrated
CMYK or CIEBasedDEFG in PostScript terminology.

RGB color emulation

Your printer is provided with the following color profiles:

None (Native): no emulation, for use when the color conversion is done by the application or operating
system, and therefore the data arrive at the printer already color-managed.

sRGB IEC61966-2.1 emulates the characteristics of the average PC monitor. This standard space is
endorsed by many hardware and software manufacturers, and is becoming the default color space for
many scanners, printers and software applications.

ColorMatch RGB emulates the native color space of Radius Pressview monitors. This space provides a
smaller gamut alternative to Adobe RGB (1998) for print production work.

Apple RGB emulates the characteristics of the average Apple monitor, and is used by a variety of
desktop publishing applications. Use this space for files that you plan to display on Apple monitors, or
for working with old desktop publishing files.

Adobe RGB (1998) provides a fairly large gamut of RGB colors. Use this space if you need to do print
production work with a broad range of colors.

Color management from the Embedded Web Server

Submit Job options

ENWwW

When you send jobs to the printer using the Embedded Web Server's Submit Job page, you have the
following color management options.

Color management from the Embedded Web Server
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If you leave an option set to Default, the setting saved in the job will be used. If the job contains no setting,
the front-panel setting in the printer will be used.

All jobs
e  Color/Grayscale: you can choose to print in color or in shades of gray.

e  Default RGB source profile: you can choose from a selection of RGB source profiles recognized by the
printer.

e  Printer emulation: you can choose to emulate a different HP DesignJet printer. Default: Off (no printer
emulation).

PostScript or PDF jobs only

e  Default CMYK source profile: you can choose from a selection of CMYK source profiles recognized by
the printer. Default: US Coated SWOP v2.

e  Rendering intent: you can select the rendering intent.
e  Black point compensation: you can turn black point compensation on or off.

e  HPProfessional PANTONE Emulation: you can turn HP Professional PANTONE Emulation on or off.

Rendering intent

Rendering intent is one of the settings used when doing a color transformation. As you probably know, some
of the colors you want to print may not be reproducible by the printer. The rendering intent allows you to
select one of four different ways of handling these so-called out-of-gamut colors.

e  Saturation (graphics): best used for presentation graphics, charts or images made up of bright,
saturated colors.

e  Perceptual (images): best used for photographs or images in which colors blend together. It tries to
preserve the overall color appearance.

e  Relative colorimetric (proofing): best used when you want to match a particular color. This method is
mainly used for proofing. It guarantees that, if a color can be printed accurately, it will be printed
accurately. The other methods will probably provide a more pleasing range of colors but do not
guarantee that any particular color will be printed accurately. It maps the white of the input space to the
white of the paper on which you are printing.

e  Absolute colorimetric (proofing): the same as relative colorimetric, but without mapping the white.
This rendering is also used mainly for proofing, where the goal is to simulate the output of one printer
(including its white point).

Perform black point compensation

The black point compensation option controls whether to adjust for differences in black points when
converting colors between color spaces. When this option is selected, the full dynamic range of the source
space is mapped into the full dynamic range of the destination space. It can be very useful in preserving
shadows when the black point of the source space is darker than that of the destination space. This option is
allowed only when the Relative colorimetric rendering intent is selected (see Rendering intent on page 80).

Printing PANTONE swatch books

You can use the Embedded Web Server or the HP Utility to print a swatch book showing emulations of
PANTONE colors as made by your printer, together with a measure of the color difference (AE) between each
emulation and the original PANTONE spot color.

To print a swatch book, select the Embedded Web Server's Main tab, then HP Professional PANTONE
Emulation. Select the PANTONE stock to emulate, and one or more strips of PANTONE colors that you want
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to print. You can select color strips from more than one PANTONE stock. When you have selected all the
colors you want, press the Next button. The next window displays your selection; you can press Print to print
that selection, or Back to change the selection.

hp HP Sangie Prnier hp HP Sangle Priner

PANTONE BGB 2522425 PANTONE BGB 246 207 243
Yollom € 77
b 13z aE 2em

Color management from the front panel

You can color-calibrate the loaded paper type from the front panel by pressing “ then , then Image
quality maintenance > Calibrate color. See Color calibration on page 73.

The other color options in the front panel can all be found by pressing i then , then Setup >
Printing preferences > Color options.

E%NOTE: These front panel settings can all be overridden by the printer driver or Embedded Web Server job
submission settings.

All jobs

Color/Grayscale: you can choose to print in color or in shades of gray. Default: Print in color.

Select RGB source profile: you can choose from a selection of RGB source profiles recognized by the
printer. Default: SRGB (HP).

Emulate printer: you can choose to emulate a different HP DesignJet printer. Default: Off (no printer
emulation).

:{;’. TIP: If you have old HP-GL/2 or PostScript files made for a different HP DesignJet printer, you can
* send them to the printer and use the front panel to turn on the appropriate emulation mode.

PostScript and PDF jobs only

e Select CMYK source profile: you can choose from a selection of CMYK source profiles recognized by the
printer. Default: US Coated SWOP v2.

e Selectrendering intent: you can select the rendering intent. Default: Perceptual.
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e  Black point compensation: you can turn black point compensation on or off. Default: On.

e  HPProfessional PANTONE Emulation: you can turn HP Professional PANTONE Emulation on or off.
Default: On.
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Practical printing examples

° Print a draft for revision with the correct scale

° Print a project

° Print a presentation

° Print and scale from Microsoft Office
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Print a draft for revision with the correct scale

This section demonstrates how to print a draft for revision with the correct scale from Adobe Acrobat.

Using Adobe Acrobat

1. Inthe Acrobat window, bring the mouse cursor to the bottom left corner of the document pane to check
the page size.

] HP Designjet Z5400 User's Guide pdf - Adobe Acrobat Pro =AY X
File Edit View Window Help x
@Crnw'|@g%‘@@@®@) E}

‘ D (1 of197) ‘ O ‘ T, + = Tools Comment Share

1] ‘Beokmarls 5
B3~ B

[P itroduction
[P Installing the software
[P setting up the printer

@ Designjet 25400 PostScript ePrinter
| d

m

&%]ﬁ

[y Personalizing the printer User's Guide

[P paper handling

[P working with two rolls
[P Printing

[P web-connected printing

I Job queue management
[P color management
I practical printing examples

F Retrieving printer usage
information at 827 x1169in

2. Select File > Print and ensure that Page Scaling is set to None.

E/?NOTE: The page size will not be automatically selected according to the drawing size.

3. Pressthe Properties button and then select the Paper/Quality tab.

4. Choose whatever Document Size and Print Quality you want to use. If you want to define a new custom
paper size, press the Custom button.

Custom Paper Size Il 2x]
The: custom paper size you have just defined will not become available for selection
until you have exited and re-entered the Printing Preferences/Properties.

Name
“Estnml Save ‘
- Paper Size Units
i 8150 @ Inches
(3.00 - 44.25)
Length: 11.00 € Milimeters
(5,51 - 3582.68)
of. Cancel

5. Select the Features tab, and then Autorotate.

6. Click OK, and check that the print preview in the Print dialog box seems correct.

Print a project

This section demonstrates how to print a project from AutoCAD and the Embedded Web Server.

Using AutoCAD

1.  The AutoCAD window can show a model or layout. Normally a layout is printed rather than the model.
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" Enter nev value for TILENODE <1>: O Regenerating layout.
Command: QVDRAVING

9Bl @O« [Li= 48]

Corarnard :

2. Click the Plot icon at the top of the window.

D SkaC oL - A

Plot... (Ctrl+P)
Prints a drawing to a plotter, printer, or file

[ PLOT

| [?] Press F1 for more help |

3. ThePlot window opens.

4. You can see further options by pressing the circular button in the lower right corner of the window.

?‘ NOTE: The Quality option here does not refer to the final print quality but to the quality of AutoCAD
viewport objects that are sent for printing.

5. Press the Properties button.
6. Select the Device and Document Settings tab, and press the Custom Properties button.

7. Inthe Paper/Quality tab, check the Show preview before printing box, and select the paper type that
you intend to use.

=7 NOTE: If you select neither the paper source nor the paper type, the printer will not print on any
protected roll (see Roll protection on page 62).

8. Select the print quality (your own choice between speed and quality of printing).

9. Ifyouintend to print on roll paper, you must decide where the printer should cut the paper. Press the
Margins/Layout button and select Clip contents by margins.

Layout and Margins option 21x|

~Layout Mode [ Preview

{5 Brint with margins

~Layout Options —————————————— Application visw:

€ Standard

© Oversize

" Borderless
~Image Enlargement

Prirt: preview:

& fitomatically by printer:

7 Maniuially in application

[ Usage:
Use this setting when the coniterts to be printed have white borders
and a size equal to that of the paper you have selected in the driver.
The printer will use the: white border for its margins and you wil get a
page of size equal to that which is selected in the driver.

10. Select the Features tab, then select the Autorotate and Crop lines options. Autorotation can help to
avoid wasting paper, and the crop lines will show you where to cut the paper after printing.
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11. Press the OK button and save your configuration changes to a PC3 file.
12. When you have pressed the OK button in the Plot window, the printer will construct a print preview.

Plot Job Progress n

Mow Processing Sheet: Layoutl (tower dwg - Read Only) :g
Status: < Regenerating sheet >

Progress:

[ ]

Preview in progress

Status: Waiting to recetve the job
AARSSYSSYSSSSRSRWRSRRNY

Hatemt Job quEUE » b preview

Using the Embedded Web Server to submit files

From the HP Utility or the Embedded Web Server, select Job Center > Submit Job. With some Web browsers,
you will see the window below; with other Web browsers, the mechanism for adding files is slightly different.

Submit job [+ |
Bt o [ s |
3 ] ]
===
|

a Halp about the Submit Job page

s it St 508 5080 bl s 9 40 e 5 s i 14 50 st

Press the Add files button (or Choose File, Add another file) to choose the files from your computer that you
want to print. The files must be in one of the following formats:

° PDF

e  PostScript

e TIFF

e JPEG

e  HP-GL/2
e RTL
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E”%NOTE: When you print to a file, the file should be in one of the above formats, but its name may have an
extension such as .plt or .prn.

If the files are not in one of these formats, they will not be printed successfully.

If the jobs have been generated with the appropriate settings (such as page size, rotation, resizing and
number of copies), you can just press the Print button and the project will be sent to the printer.

If you need to specify printing settings, go to the Job settings section and select the options you need. Each
option has explanatory text on the right, so that you can understand the behavior of each setting. Remember
that, if you leave the setting as Default, the setting saved in the job will be used. If the job contains no
setting, the setting in the printer will be used.

Using printer emulation

Printer emulation can be requested by selecting Advanced settings > Color > Color management > Printer
emulation.

You can select Off (no printer emulation) or the name of the printer model that you want to emulate.

This setting will apply to jobs that do not contain any printer emulation setting saved in the job.

Using clip contents by margins

You can select this margins option from Advanced settings > Paper > Layout/Margins > Print with margins
> Layout > Clip contents by margins.

Use this option when the contents to be printed have white borders and a size equal to that of the paper you
have selected. The printer will use the white border for its margins and you will get a page of size equal to
that which is selected in the driver.

Print a presentation

This section demonstrates how to print a presentation from AutoCAD and from Photoshop.

Using AutoCAD

1.  Open the AutoCAD file and select a layout.

" Enter nev value for TILENODE <1>: O Regenerating layout.
Command: QVDRAVING

Corarnard :

Plat... (Ctri+P)
Frints a drawing to a plotter, printer, or file

[ PLOT

| [?] Press F1 for more help |
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3. Ensure that the correct printer is selected, then press the Properties button.
4. Select the Device and Document Settings tab, and press the Custom Properties button.

5. Inthe Paper/Quality tab, check the Show preview before printing box, and select the paper type that
you intend to use.

E’/{’NOTE: If you select neither the paper source nor the paper type, the printer will not print on any
protected roll (see Roll protection on page 62).

6. Select the print quality (your own choice between speed and quality of printing).

7. Ifyouintend to print on roll paper, you must decide where the printer should cut the paper. Press the
Margins/Layout button and select Clip contents by margins.

Layout and Margins option x|

[ Layouk Mode [ Preview

(& Print with margins

~Layout Options ————————————— Application view:

€ Standard

T Oversize

& Clip contents by margins;

" Borderless
~Image Enlargement

Prink: preview:

& piitomatically by, prinker

€7 Manually in application

- Usage:
Use this setting when the contents to be printed have white barders
and 2 size squal ta that of the paper you have selected in the driver.
The printer will use the white border For its margins and you wil get a
page of size equal to that which is selected in the driver.

8. Ifyou are using photo or glossy paper, you can select Borderless printing.

Layout and Margins option x|
- Layouk Mods ~Preview

€ Prink with margins

Layout Opions ——————————— Application view:
& Standard
° Oversize

7 clin eantents by marains

& Borderiess:
~Image Enlargement —————— Print preview:

* Automatically by prinker

" Manually in application

- Usage:
Use this setting to prink without borders and with a slight
magnification of the contents done by the prinker. This magnification
is done to avoid possible paper alignment problems leading to white
areas in the border of the paper. As 3 result of this, some of the
cantents (less than 2% on all sides) wil be cipped and the scale of
the plat will ot be maintained.

9. Select the Features tab, then select the Autorotate and Crop lines options. Autorotation can help to
avoid wasting paper, and the crop lines will show you where to cut the paper after printing.

10. Press the OK button and save your configuration changes to a PC3 file.
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11. When you have pressed the OK button in the Plot window, the printer will construct a print preview.

Plot Jab Progress

How Frocessing Shest: Layout] (tower.dwg - Read Orly) ‘g—
Status: < Regenerating sheet >
Progress:

Preview in progress

Status: Waiting to receive the job
ARSI YSSSRRNWNY

Job queue » Job preview B

Using Adobe Photoshop
1. InPhotoshop (S5, select File > Print and then select your printer.
2. Choose from the available paper sizes.

If you do not find the paper size that you intend to use, press the Custom button. Enter the width, the
length and the name of your custom paper size. Press the Save and OK buttons.

Custom Paper Size (2 [ |

Units

) Inches

@ filimeters

Faper size

Width 53410 176.20-1123.95)

Length: 24099 [140.00 - 31000.00)

Hame

Custom

3. Select Show preview before printing. You may also wish to change the default paper source, paper
type and print quality.

4. Inthe Color tab, the default color management option is Printer managed colors, and this is the correct
option because you have already selected Printer Manages Colors in Photoshop.

Print and scale from Microsoft Office

This section demonstrates how to print and scale from Microsoft Office 2007.
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Using PowerPoint
1.  Select the Office Button, then Print, and select the name of your printer.
2. Select Properties > Features > Print document on to scale the document to a particular size.
3. Select the Paper/Quality tab, then select Paper Source and Paper Type.

4. Select Margins/Layout, then select Clip contents by margins to keep the size.

P v T — i 2]

- Layout Mode Previe

% Brink with marging;

layotOptions— | Application view:
" standard

" Oversige

& Clip contents by margins

JJC Borderless
Image Enlargement — | Print preview:

& plitomaticaly By printer

€ Wantialy fiapplcation

[ Usage:
Use this setting when the conkents ko be printed have white borders
and a size equal to that of the paper you have selected in the driver,
The: printer will use the white border For its margins and yau wil get a
page of size equal to that which is selected in the driver.

Using Project

1. Select File > Page Setup > Print.

Page Setup - Gantt Chart 2x]
Bas: | Margns | reader | Footer | Legend | tiew
-

 por P

scaling

€ Adjust to: o0 3: Soriaringl size
Getto: |1 = pageswideby [T =] tal

Other

Paper Size: |Envel0pe az =

First pags number:  [Auto

print Preview... | options.. | et | ok | cancel

2. Select your printer's name, then Close.

3. Select Page Setup, and choose the Paper Size you want.

Page Setup - Gantt Chart ) 2l x|
Page | Margns | Header | Footer | Legend | tiew

ol

P s

scaling

" Adjust to: 39 3: o urie e
Gtto; |1 = pageswideby [T =] tal

Other
Paper 5ze: | -
First pags number:  [Auto

print Preview... | options.. | et | ok | | cancel
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4. Select Options to go to the printer driver. The default options in the Paper/Quality tab are probably
suitable: Paper source: Printer auto select and Paper Type: Use Printer Settings.

5. Select Features > Print document on to scale the document to a particular size. Alternatively, you can
scale the document in Project.

Using Excel
1.  Select the Office Button, then Print. Select your printer's name, then click Close.
2. Select the Page Layout tab, then Size, and choose the paper size you want.

Page layout | Formulas  Data  Review  View

T Ty = =l =
J = M Jju = |l 7
gins Orientation| Size | Print Breaks Background Print
B - - laa- - tles

A2 a E
iy e 42.emx59.4 m
ey ARCHA ==

22,86 cm x 3043 cm n

ARCHB

30.48 em x 45.72 cm =
ARCHC

4572 em x 60,96 cm
ARCHD

60,96 em x 91,44 cm

ARCHE
9144 emx 12192 em

ARCH E1
76.2 cm x 106.68 cm

ARCH E2
66.04 ecm % 96.52 cm

ARCH E3
68.58 em % 99.06 cm

Al
59.4 cm x 84.1 cm

A0
841 cm x 118.88 cm

AS_IP
148 emx 21 cm

Iare Paper Sizes...

3.  Select the Office Button, then Print > Properties to go to the printer driver. In the Paper/Quality tab,
select Paper source, Paper Type and Print Quality.

4. Select Features > Print document on to scale the document to a particular size. Alternatively, you can
scale the document in Excel.
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12 Retrieving printer usage information

° Get printer accounting information

e  Check usage statistics

° Check usage statistics for a job

° Request accounting data by email
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Get printer accounting information

There are various different ways of getting accounting information from your printer.

e View printer usage statistics for the whole lifetime of the printer, see Check usage statistics
on page 93.

e Viewink and paper usage for each of your recent jobs by using the HP Utility, see Check usage statistics

for ajob on page 93. If the HP Utility is not available, see Access the HP Utility on page 29.

e  Request accounting data by email. The printer sends data in XML at regular intervals to a specified email

address; the data may be interpreted and summarized by a third-party application, or displayed as an
Excel spreadsheet. See Request accounting data by email on page 94.

e  Use athird-party application to request printer status, printer usage or job accounting data from the
printer through the Internet. The printer provides data in XML to the application whenever requested.
HP provides a Software Development Kit to facilitate the development of such applications.

Check usage statistics

There are various ways of checking your printer's usage statistics.

r__*:")f’NOTE: The accuracy of the usage statistics is not guaranteed.

From the Embedded Web Server

1.  Access the Embedded Web Server, see Access the Embedded Web Server on page 29.

2. Gotothe Main tab.

3. Select History > Usage.

From the HP Utility

1. Access the HP Utility, see Access the HP Utility on page 29.

2. Under Windows, go to the Overview tab and click on the Printer usage link.

Under Mac 0S X, select Information > Printer Usage and click on the Lookup button.

From the front panel

1. press [
2. Press.

3. Press Internal prints.
4. Press Userinformation prints.

5. Press Print usage report.

Check usage statistics for a job

There are two ways to check usage statistics for a particular job.

r__i”%NOTE: The accuracy of the usage statistics is not guaranteed.

ENWW Get printer accounting information
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Accounting statistics with the HP Utility

1.

2.

3.

Access the HP Utility, see Access the HP Utility on page 29.

Select Job center to view information regarding the most recent jobs.
Under Windows, click on the Accounting link.

Under Mac 0S X, select Job Accounting and click on the Look Up button.

Accounting statistics with the Embedded Web Server

1.
2.

3.

Access the Embedded Web Server, see Access the Embedded Web Server on page 29.

Go to the Main tab.

Select History > Accounting.

Request accounting data by email

1.

10.

11.

12.

13.

Obtain the IP address of the outgoing mail server (SMTP) from your IT department; this is required in
order to send email messages.

Ensure that the outgoing email server is configured to enable relaying of email messages that the
printer will send.

Open your Web browser and connect to the printer’'s Embedded Web Server.
Select the Setup tab.

From the Configuration menu in the left-hand column, select Date & Time.
Ensure that the printer's date and time have been set correctly.

From the Configuration menu, select Email server.

Enter the IP address of the outgoing mail server (SMTP).

Specify an email address for the printer. The latter does not need to be a valid email address, because
the printer will not receive messages; but it should have the form of an email address. It serves to
identify the printer when it sends email messages.

From the Configuration menu, select Printer settings.

In the Accounting section, if you set Require account ID to On, then every time someone sends a print
job to the printer, he or she must provide an account ID: for example, an ID corresponding to his or her
department or to a specific project or client. If someone sends a job without providing an account ID, the
printer will hold the unidentified job in the queue without printing it until an account ID is provided.

If you set Require account ID to Off, then the printer will print all jobs whether or not they have an
account ID.

Set Send accounting files to Enabled.

Set Send accounting files to to the email address (or addresses) to which you want the accounting
information sent. This may be an address that you have created specifically to receive automatically
generated messages from the printer.
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14. Set Send accounting files every to the frequency with which you want the information sent, choosing a
specific number of days or prints.

15. You may want to set Exclude personal information from accounting email to On, so that the
accounting messages will not contain personal information. If this option is Off, information such as
user name, job name, and account ID will be included.

When you have completed the above steps, the printer will send accounting data by email with the frequency
that you specified. The data are provided in XML and can easily be interpreted by a third-party program. The
data provided on each print job include when the job was submitted, when the job was printed, the printing
time, the type of image, the number of pages, the number of copies, the paper type and size, the amount of
each color of ink used and various other attributes of the job. Accounting data are also provided on scan and
copy jobs.

You can download an Excel template from HP's Web site (http://www.hp.com/go/designjet/accounting) that
will enable you to display the XML data more readably in the form of a spreadsheet.

Analysis of the accounting data will enable you to bill customers precisely and flexibly for the use of your
printer. You can, for instance:

e  Bill each customer for the total amount of ink and paper used by that customer over a particular period.
e  Bill each customer separately per job.

e  Bill each customer separately for each project, broken down by job.

E’%NOTE: In some circumstances Excel may lose or misplace the decimal point in a number: for instance, the
number 5.1806 may be misunderstood as 51806 and displayed as 51,806. This is an Excel problem that
cannot be solved by HP.
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13 Handling ink cartridges and printheads

° About the ink cartridges

e  (Check the ink cartridges status

° Remove an ink cartridge

° Insert an ink cartridge

° About the printheads

° Check the printhead status

° Remove a printhead

° Insert a printhead
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About the ink cartridges

Ink cartridges store the ink and are connected to the printheads, which distribute the ink on the paper. To
purchase additional cartridges, see Accessories on page 111.

A CAUTION: Observe precautions when handling ink cartridges because they are ESD-sensitive devices (see
the Glossary on page 168). Avoid touching pins, leads and circuitry.

Check the ink cartridges status

To view the ink levels of your ink cartridges, press [J[{J] on the front panel, then . There is a Replace ink

cartridges option on the ink information page in case you want to do so (see also Remove an ink cartridge
on page 97).

To get more information on your ink cartridges, you can press the color of the cartridge on which you want
information.

You can also get this information from the HP Utility.

For an explanation of the ink cartridge status messages, see Ink cartridge status messages on page 145.

HP Utility procedures

e Inthe HP Utility for Windows, go to the Overview tab, each cartridge's status is under Supplies Status >
Cartridges.

e Inthe HP Utility for Mac OS X, select Printer Status in the Information group.

Remove an ink cartridge

There are two occasions when you need to remove an ink cartridge.

e  Theink cartridge is very low and you want to replace it with a full cartridge for unattended printing (you
can use up the remaining ink in the first cartridge at a more convenient time).

e Theink cartridge is empty or faulty, and you must replace it to continue printing.

/\ CAUTION: Do not try to remove an ink cartridge while printing.

CAUTION: Remove anink cartridge only if you are ready to insert another one.

CAUTION: Make sure the printer wheels are locked (the brake lever is pressed down) to prevent the printer
from moving.

E‘/,"NOTE: When a cartridge runs out of ink, the current job is not automatically cancelled: unless you cancel it
manually, it will resume printing when the empty cartridge has been replaced. If there is a delay in replacing
the cartridge, you may see some banding on the print.

1. From the front panel, press [J[i then , then Replace ink cartridges.

Alternatively, press [J[iJ§ then , then Ink > Replace ink cartridges.
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2. Opentheink cartridge cover on the left-hand side of the printer.

3.  Grip the cartridge you wish to remove.

4.  Pull the cartridge straight up.

r__f"%NOTE: Avoid touching the end of the cartridge that is inserted into the printer, as there may be ink on
the connection.

E‘/l"NOTE: Avoid storing partially used ink cartridges.

5. The front-panel display identifies the missing ink cartridge.

Insert an ink cartridge

1. Before removing the cartridge from its wrapping, shake it vigorously.

2. Unwrap the new ink cartridge, find the label identifying the ink color. Check that the letter or letters (in
these illustrations, M for magenta) marking the empty slot, matches the letter or letters on the
cartridge label.
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3. Insert theink cartridge into its slot.

4. Push the cartridge into the slot until it snaps into position. You should hear a beep and see confirmation
that the cartridge has been inserted.

If you have difficulty, see Cannot insert an ink cartridge on page 145.

5. Whenall cartridges have been inserted, close the cover.

6. The front-panel display confirms that all cartridges have been correctly inserted.

About the printheads

The printheads are connected to the ink cartridges and jet ink onto the paper.

A CAUTION: Observe precautions when handling printheads because they are ESD-sensitive devices (see the
Glossary on page 168). Avoid touching pins, leads and circuitry.
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Check the printhead status

The printer automatically checks and services the printheads after each print. Follow the steps below to get
more information on your printheads.

1. From the front panel, press “ then m then the printhead on which you want information.

2. The front panel displays:
e  (Colors
e  Productname
e  Product number
e  Serial number

° Status, see Front-panel error messages on page 157

e  Volume of ink it has used
e  Warranty status
You can also get most of this information from the HP Utility.

For an explanation of the printhead status messages, see Printhead status messages on page 150.

If the warranty status is See warranty note, this indicates that non-HP ink is being used. See the Legal
Information document provided with your printer for details of the warranty implications.

Remove a printhead

/\ CAUTION: Make sure the printer wheels are locked (the brake lever is pressed down) to prevent the printer
from moving.

A CAUTION: Printhead replacement must be performed with the printer powered on.

1. From the front panel, press W then m then Replace printheads.

Alternatively, press [J[iJ§ then , then Ink > Replace printheads.

2. The printer moves the carriage into the correct position.

/\ CAUTION: If the carriage is left in the removal position for more than three minutes without inserting
or removing any printheads, it tries to move back to its normal position in the right-hand end.
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3. When the carriage has stopped moving, the front-panel display asks you to open the window.

4. Locate the carriage on the right side of the printer.

5.  Pull the handle up and toward you to release the wire loop.
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7. This gives you access to the printheads.

8. Toremove a printhead, lift up the blue handle.

9. Using the blue handle, use steady force to disengage the printhead.
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10. Pull the blue handle upward until the printhead is released from the carriage.

A CAUTION: Do not pull abruptly because this can damage the printhead.

11. The front-panel display identifies the missing printhead.

Insert a printhead

E/?NOTE: You cannot insert a new printhead successfully if either of the connected ink cartridges is empty, or
nearly empty. In this case, you should replace the ink cartridge before inserting the new printhead.

1. Remove the orange protective caps by pulling them down.

2. The printhead is designed to prevent you from accidentally inserting it into the wrong slot. Check that
the colored label on the printhead matches the colored label of the carriage slot into which the
printhead is to be inserted.
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3. Insert the new printhead into its correct slot in the carriage.

A CAUTION: Insert the printhead slowly and vertically, straight down. It may be damaged if you insert it
too fast, or at an angle, or if you rotate it as you insert it.

4. Push down as indicated by the arrow shown below.

4

A CAUTION: When installing the new printhead there may be some resistance, so you need to press it
down firmly but smoothly. You should hear a beep and see confirmation on the front-panel display that
the printhead has been inserted. If you have difficulty, see Cannot insert a printhead on page 145.

5. Insert all other printheads that need to be installed, and close the carriage lid.

B
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6. Ensure the end of the blue handle catches the wire loop on the near side of the carriage.

7. Lower the handle to rest on the carriage cover.

When all the printheads have been inserted correctly and are accepted by the printer, the printer beeps.

= NOTE: If the printer does not beep when you insert the printhead and the Replace message appears
on the front-panel display, the printhead may need to be reinserted.

8. Close the window.

9. The front-panel display confirms that all printheads are correctly inserted. The printer starts checking
and preparing the printheads. The default routine process, when all printheads are changed, takes 10
minutes. If the printer finds problems in preparing the printheads, it takes longer, up to 45 minutes. For
a single printhead insertion, the times vary between 2 and 40 minutes. After all printheads are checked
and prepared, the printhead realignment procedure runs automatically if paper is loaded, see Align the
printheads on page 148.

10. You are recommended to perform a color calibration after inserting a new printhead. See Color
calibration on page 73.
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14 Maintaining the printer

° Check printer status

e  C(lean the exterior of the printer

° Maintain the ink cartridges

e  Move or store the printer

° Update the firmware

° Update the software

° Printer maintenance kits

e  Secure Disk Erase
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Check printer status

You can check the current status of the printer in various ways:

e If youstart the HP Utility and select your printer, you see a page of information describing the status of
the printer and its paper and ink supplies.

e Ifyouaccess the Embedded Web Server, you see information about the general status of the printer.
The Supplies page in the Main tab describes the status of the paper and ink supplies.

e  Atthe front panel, you can press “ for information about paper, ink levels, ink cartridges, and
printheads. If there is a current problem, you are taken automatically to the area with the most urgent
problem.

If there are any current alerts, the upper row of the home screen shows the top-priority alert. Press the
alert message to see a list of all current alerts.

Clean the exterior of the printer

Clean the outside of the printer and all other parts of the printer that you regularly touch as part of normal
operation with a damp sponge or a soft cloth and a mild household cleaner such as non-abrasive liquid soap.

A WARNING! To avoid an electric shock, make sure that the printer is turned off and unplugged before you
cleanit. Do not let water get inside the printer.

A CAUTION: Do not use abrasive cleaners on the printer.

Maintain the ink cartridges

During the normal lifetime of a cartridge, no specific maintenance is required. However, in order to maintain
the best print quality, replace a cartridge when it reaches its expiration date. The printer's front panel notifies
you when any cartridge reaches its expiration date.

You can also check a cartridge's expiration date at any time: see Check printer status on page 107.

See also Handling ink cartridges and printheads on page 96.

Move or store the printer

If you need to move or store the printer, prepare it correctly to avoid possible damage to it. To prepare the
printer, follow the instructions below.

1. Do not remove the ink cartridges or printheads.

2. Make sure that no paper is loaded.

3. Make sure that the printer is idle.

4. Disconnect any cables connecting the printer to a network or a computer.

If you need to leave the printer turned off for a long time, follow the additional steps below.
1. Turn off the power using the Power key on the front panel.

2. Also turn off the power switch at the rear of the printer.

3. Disconnect the printer's power cable.

A CAUTION: If you turn the printer upside down, ink could escape into the printer and cause serious damage.
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When the printer is turned back on, it takes about three minutes to initialize itself and to check and prepare
the printheads. Preparing the printheads normally takes just over a minute. However, if the printer has been
off for a six weeks or more, preparing the printheads could take up to 45 minutes.

A CAUTION: If the printer remains off for a long period of time, the printheads may become unusable. In this
case, you need to replace the printheads with new ones.

*O-TIP: Because preparing and purging the printheads uses both time and ink, you are strongly recommended

"*" to leave the printer always on or in sleep mode, whenever possible, to maintain the health of the printheads.
In both cases, the printer wakes up from time to time to maintain the printheads. Thus you can avoid going
through lengthy preparation processes before using your printer.

=?NOTE:  If the printer is left on without printing, every six hours it advances the paper slightly to avoid the
pinchwheels leaving marks on the paper.

Update the firmware

The printer's various functions are controlled by firmware that resides in the printer.

From time to time firmware updates will be available from HP. These updates increase the printer's
functionality, enhance its features, and may correct minor problems.

@IMPORTANT: You are strongly recommended to update the firmware periodically in order to take
advantage of the latest developments.

There are various ways of downloading and installing firmware updates; you can choose whichever you find
most convenient. They can be divided into two categories: automatic and manual updates.

@NOTE: The firmware includes a set of the most commonly used paper presets. Extra paper presets can be
downloaded separately; see Paper presets on page 43.

Automatic firmware updates

Automatic firmware updates are a convenience that is possible with Web-connected printers. Your printer
can automatically download the latest firmware release and install it for you.

Important notes

e  Your printer must be connected to the Internet; see Set up your Web-connected printer on page 21.

e  To configure automatic firmware updates, you can use the front panel or the Embedded Web Server;
see Set up your Web-connected printer on page 21.

e If an administrator password has been set, it will be required to change these settings.

e Afirmware update package can be large; you may want to consider whether there are any implications
for your network or Internet connection. Downloads made with a Jetdirect adaptor are slower than
those made with the built-in Ethernet adaptor.

e Afirmware update is downloaded in the background: the printer can be printing at the same time.
However, it cannot be installed in the background: printing must stop.

Manual firmware updates
Manual firmware updates can be performed in the following ways:

e  Using the Embedded Web Server, select the Firmware update maintenance tab and then Firmware
update. Press Check now to check whether new firmware is available. If new firmware is available,
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some information about the new firmware is displayed, and you are given the opportunity to download
and install it.

e  Using the HP Utility under Windows, select your printer, the Support tab and then Firmware Update.
e  Using the HP Utility under Mac 0S X, select Firmware Update in the Support group.

e  Using HP Web Jetadmin, with which you can make manual firmware updates or request automatic
updates.

e  Using a USB flash drive. Download the firmware file from http://www.hp.com/go/Z5400ps/firmware
into the USB flash drive and insert it into the Hi-Speed USB host port beside the front panel. A firmware
update assistant will appear on the front panel to guide you through the update process.

Update the software

To update printer drivers and other software for your printer, go to http://www.hp.com/go/Z5400ps/drivers.

If your operating system is Windows, HP Software Update regularly offers to update your software
automatically.

Printer maintenance kits

Four maintenance kits are available for your printer, containing components that may need to be replaced
after long use. When one of them is needed, a message is displayed on the front panel and by the HP Utility.

When you see the message, you should contact HP Support (see Contact HP Support on page 163) and
request the maintenance kit. The kits are installed by service engineers only.

Secure Disk Erase

The printer's hard disk is used as a temporary storage area for print jobs. The Secure Disk Erase facility can
completely erase your information from the hard disk to protect it from unauthorized access. You can choose
to erase particular files, or the whole hard disk.

Secure Disk Erase provides three different levels of security:

e Non-Secure Fast Erase: all pointers to the information are erased. The information itself remains on
the hard disk until the disk space it occupies is needed for other purposes, and it is then overwritten.
While it remains on the disk, it is difficult for most people to access, but may be accessed using software
designed for the purpose. This is the normal method in which files are erased on most computer
systems; it is the fastest method but the least secure.

e Secure Fast Erase: all pointers to the information are erased, and the information itself is also
overwritten with a fixed character pattern. This method is slower than Non-Secure Fast Erase, but more
secure. It may still be possible to access fragments of the erased information by using special tools to
detect residual magnetic traces.

e  Secure Sanitizing Erase: all pointers to the information are erased, and the information itself is
repetitively overwritten using an algorithm designed to eliminate any residual traces. This is the
slowest method, but the most secure. Secure Sanitizing Erase meets the US Department of Defense
5220-22.m requirements for clearing and sanitization of disk media. This is the default security level
when using Secure Disk Erase.

Secure Disk Erase is one of the facilities provided by Web JetAdmin, which is HP's free Web-based print
management software: see http://www.hp.com/go/webjetadmin.

If you have difficulty in using Secure Disk Erase from Web JetAdmin, please contact HP Support: see Contact
HP Support on page 163.
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=2 NOTE: If you choose to erase the whole hard disk, you may be asked to restart the printer several times
during the process, which will take about 6 hours with Secure Disk Erase or 24 hours with Secure Sanitizing
Erase.
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15 Accessories

° How to order supplies and accessories

° Introduction to the accessories
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How to order supplies and accessories

There are two alternative ways to order supplies or accessories for your printer:

e  Visit http://www.hp.com/go/Z5400ps/accessories on the Web.

e  Contact HP Support (see Contact HP Support on page 163).

The rest of this chapter lists the available supplies and accessories, and their part numbers.

Order ink supplies
The following ink supplies can be ordered for your printer.

Table 15-1 Ink cartridges

Cartridge Part number
HP 70 Matte Black 130 ml Ink Cartridge C9448A
HP 70 Photo Black 130 ml Ink Cartridge C9449A
HP 70 Light Gray 130 ml Ink Cartridge C9451A
HP 70 Cyan 130 ml Ink Cartridge C9452A
HP 70 Magenta 130 ml Ink Cartridge C9453A
HP 70 Yellow 130 ml Ink Cartridge C9454A
HP 70 Matte Black 130 ml Ink Cartridge Twin Pack CB339A
HP 70 Photo Black 130 ml Ink Cartridge Twin Pack CB340A
HP 70 Light Gray 130 ml Ink Cartridge Twin Pack CB342A
HP 70 Cyan 130 ml Ink Cartridge Twin Pack CB343A
HP 70 Magenta 130 ml Ink Cartridge Twin Pack CB344A
HP 70 Yellow 130 ml Ink Cartridge Twin Pack CB345A
HP 772 300 ml Magenta DesignJet Ink Cartridge CN629A
HP 772 300 ml Yellow DesignJet Ink Cartridge CN630A
HP 772 300 ml Photo Black DesignJet Ink Cartridge CN633A
HP 772 300 ml Light Gray DesignJet Ink Cartridge CN634A
HP 772 300 ml Matte Black DesignJet Ink Cartridge CN635A
HP 772 300 ml Cyan DesignJet Ink Cartridge CN636A

Table 15-2 Printheads

Printhead Part number
HP 70 Matte Black and Cyan Printhead C9404A
HP 70 Magenta and Yellow Printhead C9406A
HP 70 Photo Black and Light Gray Printhead C9407A
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Order paper

The following paper types are currently provided for use with your printer.

|*__*:"’49N0TE: This list is likely to change over the course of time. For the latest information, see
http://www.hp.com/go/Z5400ps/accessories.

E‘%NOTE: Paper types that HP does not support may nevertheless be compatible with your printer.

Key to availability:

e (A)indicates papers available in Asia (excluding Japan)

e (0 indicates papers available in China

e (E)indicates papers available in Europe, the Middle East and Africa

e  (J)indicates papers available in Japan

e (L) indicates papers available in Latin America

e (N)indicates papers available in North America

If the part number is not followed by parentheses, the paper is available in all regions.

Table 15-3 Roll paper

Paper type g/m2 Length Width Part numbers
HP Photographic Paper
HP Universal Instant-dry Gloss Photo 200 30.5m (100 ft) 610 mm (24 in) Q6574A
Paper
914 mm (36 in) Q6575A
1067 mm (42 in) Q6576A
61 m (200 ft) 1067 mm (42 in) Q8754A (ELN)
HP Universal Instant-dry Satin Photo 200 30.5m (100 ft) 610 mm (24 in) Q6579A
Paper
914 mm (36in) Q6580A
1067 mm (42 in) Q6581A
61 m (200 ft) 1067 mm (42 in) Q8755A (ELN)
HP Everyday Instant-dry Gloss Photo 235 30.5m (100 ft) 610 mm (24 in) Q8916A
Paper
914 mm (36 in) Q8917A
1067 mm (42 in) Q8918A
HP Everyday Instant-dry Satin Photo 235 30.5m (100 ft) 610 mm (24 in) Q8920A
Paper
914 mm (36 in) Q8921A
1067 mm (42 in) Q8922A
HP Premium Instant-dry Gloss Photo 260 22.9m (75 ft) 610 mm (24 in) Q7991A
Paper
30.5m (100 ft) 914 mm (36 in) Q7993A
1067 mm (42 in) Q7995A
HP Premium Instant-dry Satin Photo 260 22.9m (75 ft) 610 mm (24 in) Q7992A
Paper
30.5m (100 ft) 914 mm (36in) Q7994A
1067 mm (42 in) Q7996A
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Table 15-3 Roll paper (continued)

Paper type g/m2 Length Width Part numbers
HP Professional Instant-dry Satin 300 15.2m (50 ft) 610 mm (24 in) Q8759A
Photo Paper

1118 mm (44 in) Q8840A (AEN)

TIP: Theinks used by your printer will fade very quickly on instant-dry photo papers. If you plan to display the prints for more than
two weeks, you should laminate them to achieve longer life.

HP Premium Matte Photo Paper 210 30.5m (100 ft) 610 mm (24 in) CG459B
914 mm (36 in) CG460B
HP Backlit Material
HP Premium Vivid Color Backlit Film 285 30.5m (100 ft) 914 mm (36 in) (8747A
1067 mm (42 in) (8748A (AEN)
HP Self-Adhesive Material
HP Everyday Adhesive Matte 120 22.9m (75 ft) 610 mm (24 in) COF18A
Polypropylene
168 with 914 mm (36 in) COF19A
liner
1067 mm (42 in) COF20A
HP Everyday Adhesive Gloss 120 22.9m (75 ft) 914 mm (36 in) COF28A
Polypropylene
168 with 1067 mm (42 in) COF29A
liner
HP Colorfast Adhesive Vinyl 190 12.2 m (40 ft) 914 mm (36 in) COF08A
345 with
liner
HP Universal Adhesive Vinyl 150 20 m (66 ft) 914 mm (36 in) C2T51A (EN)
290 with 1067 mm (42 in) C2T52A (EN)
liner
HP Banner and Sign Material
HP Durable Banner with DuPont Tyvek 133 22.9m (75 ft) 914 mm (36 in) COF12A
1067 mm (42 in) COF13A
HP Opaque Scrim 460 15.2 m (50 ft) 610 mm (24 in) Q8675A (N)
914 mm (36 in) Q1898B (AEN)
1067 mm (42 in) Q1899B (AEN)
HP Everyday Matte Polypropylene 120 30.5m (100 ft) 610 mm (24 in) CHO22A (EN)
914 mm (36 in) CHO23A (EN)
1067 mm (42 in) CHO25A (EN)
61 m (200 ft) 914 mm (36 in) CHO024A (N)
HP Premium Matte Polypropylene 140 22.9m (75 ft) 914 mm (36 in) C2T53A (AEN)
1067 mm (42 in) C2T54A(AEN)

HP Bond and Coated Paper
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Table 15-3 Roll paper (continued)

Paper type g/m2 Length Width Part numbers
HP Coated Paper 90 45.7 m (150 ft) 420 mm (16.54 in) (A2) Q1443A(J)
594 mm (23.391in) (A1) Q1442A (E))
610 mm (24 in) C6019B
841 mm (33.11 in) (AO) Q1441A (E))
914 mm (36 in) C6020B
1067 mm (42 in) C6567B
91.4 m (300 ft) 914 mm (36 in) C6980A
HP Heavyweight Coated Paper 130 30.5m (100 ft) 610 mm (24 in) €6029C (AEJN)
914 mm (36 in) €6030C
1067 mm (42 in) €6569C
67.5m (225 ft) 1067 mm (42 in) Q1956A (EN)
HP Super Heavyweight Plus Matte 210 30.5m (100 ft) 610 mm (24 in) Q66268
Paper
914 mm (36 in) Q6627B
1067 mm (42 in) Q6628B
HP Yellow Colored Paper 92 45.7 m (150 ft) 914 mm (36 in) Q1760A (EN)
90 m (295.3 ft) 594 mm (23.391in) (A1) Q6596A (E)
HP Technical Paper
HP Special Inkjet Paper 90 45.7 m (150 ft) 610 mm (24 in) 51631D (ELN)
914 mm (36 in) 51631E
HP Natural Tracing Paper 90 45.7 m (150 ft) 594 mm (23.39in) (A1) Q1439A(J)
610 mm (24 in) (3869A (AEN)
914 mm (36 in) (3868A (AELN)
HP Film (Technical and Graphic)
HP Clear Film 174 22.9m (75 ft) 610 mm (24 in) (3876A (AEN)
914 mm (36 in) C3875A
HP Matte Film 160 38.1 m (125 ft) 610 mm (24 in) 51642A (AEJN)
914 mm (36 in) 51642B
HP Fine Art Printing Material
HP Professional Matte Canvas 430 15.2m (50 ft) 610 mm (24 in) Q8673B (ELN)
914 mm (36 in) Q8671A (ELN)
1067 mm (42 in) Q8674A (ELN)
HP Collector Satin Canvas 400 15.2 m (50 ft) 610 mm (24 in) Q8708B
914 mm (36 in) Q8709A
1067 mm (42 in) Q8710A
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Table 15-3 Roll paper (continued)

Paper type g/m? Length Width Part numbers
HP Artist Matte Canvas 380 6 m (20 ft) 610 mm (24 in) Q8707A
15.2m (50 ft) 914 mm (36 in) Q8705A
1067 mm (42 in) Q8706A
HP Universal Matte Canvas 350 15.2 m (50 ft) 610 mm (24 in) C2T50A
914 mm (36 in) Q8713A (EN)
1067 mm (42 in) Q8714A (EN)
HP Matte Litho-realistic Paper 270 30.5m (100 ft) 610 mm (24 in) Q7972A (ELN)
914 mm (36 in) Q7973A (ELN)
Order accessories

The following accessories can be ordered for your printer.

Name Product number
HP DesignJet 44-inch Roll Feed Spindle Q6709A
HP DesignJet 3-in Spindle Adaptor Kit CN538A
HP Jetdirect 640n Print Server J8025A
HP DesignJet HD Scanner €Q654C

Introduction to the accessories

Spindle

With extra spindles, you can change rapidly from one paper type to another.

Jetdirect print server

Jetdirect print servers support extra connectivity and security options beyond those provided in the standard

Ethernet interface built into the printer.
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16 Troubleshooting paper issues

e  The paper cannot be loaded successfully

° The paper type is not in the driver

° The printer printed on the wrong paper type

e  Automatic cut not available

° On hold for paper

° The roll paper will not advance

e  The paper has jammed

e  Astrip stays on the output tray and generates jams

° The printer displays out of paper when paper is available

° Prints do not fall neatly into the basket

° The sheet stays in the printer when the print has been completed

e  The paper is cut when the print has been completed

° The cutter does not cut well

e Therollis loose on the spindle

° Recalibrate the paper advance
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The paper cannot be loaded successfully

e  Ensure that no paper is already loaded.
e  Ensure that the paper is far enough inside the printer: you should feel the printer grab the paper.

e Do not attempt to straighten the paper during the aligning process, unless instructed to do so by the
front-panel display. The printer automatically attempts to straighten the paper.

e  The paper may be crumpled, or warped, or may have irregular edges.

e |t can be difficult to insert a particularly stiff paper from the upper roll. Try moving it to the lower roll.

General unsuccessful roll load issues

e |If the paper does not load, the leading edge of the paper may not be straight or clean and needs to be
trimmed. Remove the initial 2 cm (1 in) from the roll and try again. This may be necessary even with a
new roll of paper.

e  Ensure the roll ends are tight against the spindle ends.

e  Check that the spindle is correctly inserted.

e  Check that the paper is correctly loaded on the spindle, and that it loads over the roll towards you.
e  Check that all roll end plugs have been removed.

e  Check that the paper is wound tightly on the roll.

e Do not touch the roll or paper at during the alignment process.

e  When loading a roll, the roll cover must remain open until the front panel prompts you to close it.

e  When loading the upper roll, avoid inserting the paper into the cut sheet slot.

nE

/

7
W

Unsuccessful roll load
If the paper has not been inserted straight, the front panel displays the following instructions.

1.  When prompted by the front-panel display, lift the blue lever on the left. The printer attempts to
straighten the roll.

2.  When prompted by the front-panel display, lower the blue lever. The printer checks the alignment. If
therollis aligned, the printer prompts you to close the roll cover, and you are now ready to print.

If the rollis still not aligned, the front panel displays an error and instructions to start again.

If you would like to start the load process again, cancel the process on the front panel and rewind the
roll from the end of the spindle until the edge is removed from the printer.
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E‘%NOTE: If the roll has become loose around the core, the printer cannot load the paper.

Unsuccessful sheet load

e  Guide the sheet, especially thick papers, when the printer initially feeds the sheet.

e  Ensure that the sheet is aligned with the reference line on the roll cover.

e Do not attempt to straighten the sheet during the loading process, unless instructed to by the front-

panel display.

e Do not use hand-cut sheets, which may be of irregular shapes. Use only purchased sheets.

In case of any problem, please follow the instructions given on the front-panel display.

If you would like to start the load process again, cancel the process on the front panel; the printer ejects the

sheet from the front of the printer.

Paper loading error messages

Here is a list of front-panel messages related to paper loading, with the suggested corrective action.

Front-panel message

Suggested action

Close the roll cover when the paper load is
finished

Close the roll cover when the paper load is finished.

Lever lifted

During the load process the blue lever was lifted. This prevents the printer from loading
the paper. Follow the instructions on the front-panel display.

Paper incorrectly loaded

The paper has not been loaded correctly. Lift the blue lever, remove the paper and
lower the lever.

Paper loaded with too much skew

During the paper load process the printer detected that the paper had too much skew.
Follow the instructions on the front-panel display.

Paper loose around core

The end of the roll has become loose around the core. Tighten the paper to the core or
insert a new roll.

Paper not detected

During the paper load process the printer did not detect any paper. Ensure the paper is
inserted fully and is not transparent.

Roll cover closed during paper load process

Do not close the roll cover until you are prompted to do so by the front panel.

Sheet too big

During the load process the printer has detected that the sheet of paper is either too
wide or too long to be loaded correctly. Press . to stop the load process. See
Functional specifications on page 165.

Sheet too small

During the load process the printer detected that the sheet of paper is too narrow or too
short to be loaded in the printer. Press . to stop the load process. See Functional
specifications on page 165.

Upper roll load and paper is inserted
through the single sheet path

Avoid inserting roll paper into the cut sheet slot.

The paper type is not in the driver

To work with a paper not in the driver, you can use your paper as one of the presets already in the driver,
however, you must identify whether your paper is transparent or translucent, glossy or matte.

ENWwW

glossy paper.

=7 NOTE: For glossy paper, it is important to use a glossy paper type, as matte black ink does not print well on
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Transparent or translucent paper

If your paper is a transparent film (for example, a transparency), select paper type Film > Transparent/Clear
film.

If your paper is a translucent paper (for example, technical paper), select paper type Technical paper >
Natural Tracing Paper, Vellum or Translucent bond.

Glossy paper

If your paper is a photo paper, use the Photo Paper category. For glossy or high-gloss paper select paper
type Photo Gloss Paper. For Semi-gloss, Satin, Pearl or Luster finishes, select paper type Semi-gloss/Satin
Paper.

To increase gamut on photo paper, select paper type HP Universal High-gloss Photo Paper or HP Universal
Semi-gloss Photo Paper, depending on the finish.

Matte Paper

Your paper type selection for matte paper depends on the paper’s ink absorption capacity. To select a paper
category and type, first identify if your paper is general purpose or photographic. Then select the
recommended paper types.

General-purpose paper

e  For natural tracing papers, select paper type Natural Tracing Paper < 65 g/m2 or Natural Tracing
Paper > 65 g/m2, depending on the weight of the paper.

e  For thin papers (< 90 g/m?) uncoated papers (for example plain paper or bright white paper) select
paper type Bond and Coated Paper > Plain Paper.

®  For light coated papers (< 110 g/m?), select paper type Bond and Coated Paper > HP Coated Paper.

e  For heavyweight coated papers (< 200 g/m?), select paper type Bond and Coated Paper > Heavyweight
Coated Paper.

®  For cockle-free very thick coated papers (> 200 g/m?), select paper type Bond and Coated Paper >
Super Heavyweight Coated Paper.

Photographic paper

For photographic paper, select paper type Photo Paper > Photo Matte Paper.

Black ink is easily removed when touched

This happens when your paper is incompatible with matte black ink. To use non-matte black ink, select paper
type Photo Paper > Photo Gloss Paper.

After printing, the paper has wrinkles or there is too much ink

This happens when too much ink is used. To use less ink, select a thinner category. Matte paper categories
from thinnest to thickest are:

e  Plain Paper
e  (Coated Paper
e  Heavyweight Coated Paper

° Super Heavyweight Coated Paper
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For other image quality problems, see Troubleshooting print-quality issues on page 129.

The printer printed on the wrong paper type

If the printer prints your job before you were able to load your desired paper, you may have Use Printer
Settings selected for the Paper Type in the printer driver. When Use Printer Settings is selected the printer
will print immediately on whichever paper is loaded. Load your desired paper, see Paper handling on page 33,
and select your paper type specifically in the driver.

e Inthe Windows driver dialog: select the Paper/Quality tab, then select your paper type from the Paper
Type list.

e Inthe Mac 0S X Print dialog: select the Paper/Quality panel, then select your paper type from the
Paper Type list.

E‘%NOTE: Use Printer Settings is the driver default.

Automatic cut not available

Some paper types, such as canvas, cannot be cut by the automatic cutter. When such a paper type is loaded
and active, the printer cannot switch automatically to the other roll: the active roll must first be unloaded
manually.

On hold for paper

Based on a set of conditions that you can set when sending a job (see Paper mismatch action on page 23), the
printer will decide which of the loaded rolls of paper is more suitable to print the job. If there is no roll of
paper available that meets all the conditions, the printer will put the job on hold for paper. You can manually
resume the job, forcing it to print on a paper other than the one originally specified, otherwise it will stay on
hold.

E‘%NOTE: When an uncuttable roll is active, every job sent to any other paper source is put on hold until you
manually unload the uncuttable roll.

Which criteria are used to decide on which roll a job will be printed?

When a user sends a job, the desired paper type can be set (in the driver or in the Embedded Web Server). The
printer will print the job on a roll of paper of the chosen paper type that is large enough to print the drawing
without clipping. If there is more than one roll on which the job could be printed meeting all the criteria, the
roll will be chosen according to your preferences. These can be set from the front panel: see Roll switching
options on page 23.

When is a job put on hold for paper?

If the paper mismatch action is set to Put job on hold (see Paper mismatch action on page 23), ajob is put on
hold for paper in the following cases:

e  The paper type that has been selected by the user is not currently loaded on the specified roll—or on
either of the rolls, if no roll has been specified.

e  The paper type that has been selected by the user is loaded on the specified roll, but the drawing is too
large to fit on the roll—or on either of the rolls, if no roll has been specified.
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If | load a new roll of paper, will jobs that were on hold for paper be automatically
printed?

Yes. Every time a new roll of paper is loaded, the printer will check if there are any jobs on hold for paper that
could be printed on the loaded roll.

I don’t like jobs being put on hold for paper. Can | prevent it?

Yes, this can be done from the front panel: see Paper mismatch action on page 23.

| set the option “Paper mismatch action” to Print anyway, but some jobs are still
put on hold

If the Show print preview option is selected in the driver or the Embedded Web Server, jobs are put on hold
until you have checked the preview and resumed the job. Check that the Show print preview option is not
checked in the driver, and that there are no pending preview windows waiting for confirmation to continue
printing.

My job is exactly as wide as the roll of paper that is loaded on the printer, but is put
on hold for paper

Margins are managed in different ways depending on the file type:

e  For HP-GL/2 and HP RTL files, by default, margins are included inside the drawing, so a 914 mm (36 in)
HP-GL/2 and HP RTL file can be printed on a 914 mm (36 in) roll of paper and will not be put on hold for

paper.

e  For other file formats, such as PostScript, PDF, TIFF, or JPEG, the printer assumes that margins need to
be added outside the drawing (as, in many cases, these formats are used for photographs and other
images that do not include margins). This means that, to print a 914 mm (36 in) TIFF, the printer needs
to add margins, and the drawing needs 925 mm (36.4 in) of paper to be printed; this would cause the job
to be put on hold if the paper that is loaded on the printer is only 914 mm (36 in) wide.

If you wish to print these file formats without adding extra margins outside of the drawing, the Clip
contents by margins option can be used. This option will force the margins to be set inside of the
drawing, so a 914 mm (36 in) TIFF can be printed on a 914 mm (36 in) roll of paper without being put on
hold. However, if there is no white space already included in the drawing’s borders, some contents could
be clipped because of the margins.

The roll paper will not advance

If you have pushed the printer up against a wall, the roll may be touching the wall at the rear of the printer.
Use the wall spacers to ensure a minimum distance between printer and wall. See The wall spacers

onpage7.

The paper has jammed

When a paper jam occurs, you normally see the Possible paper jam message in the front-panel display.

1.  Power off the printer at the front panel and also switch it off at the rear.
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2. Openthe window.

3. Try to move the printhead carriage out of the way.

4. Lift the blue lever as far up as it will go.
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5. Carefully remove any of the jammed paper that you can lift up and out from the top of the printer.

A CAUTION: Do not move the paper sideways, as it could damage the printer.

6. Rewind the roll. If the paper is stuck and cannot be rewound further, cut it from the roll.

7. Remove all pieces of paper from the rear of the printer.
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8. Lower the blue lever.

10.

11. Reload theroll, or load a new sheet see Paper handling on page 33.

r__f%NOTE: If you find that there is still some paper causing an obstruction within the printer, restart the
procedure and carefully remove all pieces of paper.

A strip stays on the output tray and generates jams

If a small piece of paper (200 mm or smaller) has been cut, such as before (if new roll) and after a full-bleed
print or after the front-panel option Form feed and cut has been used, the cut strip remains in the output
tray. Only when the printer is not printing, reach into the tray and remove the strip.
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The printer displays out of paper when paper is available

If the roll has become loose from its core, it will not feed correctly and the printer will not load the paper. If
possible, tighten the paper to its core or load a new roll.

Prints do not fall neatly into the basket

e  Ensure the basket is correctly installed.
e  Ensure the basket is open.
° Ensure the basket not full.

e  Paper often tends to curl near the end of aroll, which can cause output problems. Load a new roll, or
remove prints manually as they are completed.

The sheet stays in the printer when the print has been
completed

The printer holds the paper to allow the print to dry after printing, see Change the drying time on page 46. If
the paper is only partially ejected after the drying time, gently pull the sheet out of the printer. If the
automatic cutter is disabled, use the Form feed and cut option in the front panel, see Feed and cut the paper

on page47.

The paper is cut when the print has been completed

By default the printer cuts the paper after the drying time has been completed, see Change the drying time
on page 46. You can disable the cutter, see Turn the automatic cutter on and off on page 46.

The cutter does not cut well

By default, the printer is set to cut the paper automatically after the drying time has been completed.
However, there are some paper types that cannot be cut, such as canvas or very thick paper, even when the
front-panel option Form feed and cut is used; and the printer will not attempt to cut such paper types.

If the cutter is turned on but not cutting correctly, check that the cutter rail is clean and clear of any
obstacles.

If the selected paper type is canvas, Form feed and cut only advances the paper. Use it to move the print far
enough out of the front of the printer, until it is convenient to cut it manually with a straight edge or scissors.
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Therollis loose on the spindle

The roll may need to be replaced or reloaded.

Recalibrate the paper advance

Accurate paper advance is important to image quality because it is part of controlling the proper placement
of dots on the paper. If the paper is not advanced the proper distance between printhead passes, light or dark
bands appear in the print and image grain may increase.

The printer is calibrated to advance correctly with all the papers appearing in the front panel. When you
select the type of loaded paper, the printer adjusts the rate at which to advance the paper while printing.
However, if you are not satisfied with the default calibration of your paper, you may need to recalibrate the
rate at which the paper advances. See Troubleshooting print-quality issues on page 129 for steps to
determine if paper advance calibration will solve your issue.

You can check the paper advance calibration status of the currently loaded paper from the front panel at any
time by pressing [ then , then Image-quality maintenance > Calibration Status. The status may
be one of the following.

e  DEFAULT: This status appears when loading any paper that has not been calibrated. HP papers in the
Front Panel have been optimized by default and unless you experience image quality problems in your
printed image such as banding or graininess it is not recommended to recalibrate the paper advance.

e  OK:This status indicates that the loaded paper has been calibrated before. However you may need to
repeat the calibration if you experience image quality problems such as banding or graininess in your
printed image.

;“—“‘ NOTE: Whenever you update the printer’s firmware, the paper advance calibration values are reset to
factory default, see Update the firmware on page 108.

A CAUTION: Transparent papers and films must be calibrated by pressing “, then , then Image-

quality maintenance > Paper advance calibration > Adjust paper advance, from step four in Recalibrating
the paper advance procedure.

Recalibrating the paper advance procedure

1. From the front panel, press “ then , then Image-quality maintenance > Paper advance

calibration > Calibrate paper advance. The printer automatically recalibrates the paper advance and
prints a paper advance calibration image.

2.  Wait until the front panel displays the status screen and re-print your print.

=7 NOTE: The recalibration procedure takes approximately three minutes. Do not worry about the paper
advance calibration image. The front-panel display shows any errors in the process.

If you are satisfied with your print continue using this calibration for your paper type. If you see
improvement in your print, continue with step three. If you are dissatisfied with the recalibration, return
to the default calibration, see Return to default calibration on page 128.

3. If you would like to fine-tune the calibration or are using a transparent paper, press “, then ,
then Image-quality maintenance > Paper advance calibration > Adjust paper advance.
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4. Select the percentage of change from —100% to +100%. To correct light banding, decrease the
percentage.

To correct dark banding, increase the percentage.

5. Press OK on the front panel, to save the value.

6.  Wait until the front panel displays the status screen and reprint your print.

Return to default calibration

Returning to the default calibration sets all the corrections made by the paper advance calibration to zero. To
return to the default paper advance calibration value, you must reset the calibration.

1. From the front panel, press [ then , then Image-quality maintenance > Paper advance
calibration > Reset paper advance.

2.  Wait until the front panel displays the operation has completed successfully.
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Troubleshooting print-quality issues

General advice

Print quality troubleshooting wizard

Horizontal lines across the image (banding)

Thin vertical lines across the image

The whole image is blurry or grainy

The paper is not flat

The print is scuffed or scratched

Ink marks on the paper

Black ink comes off when you touch the print

Edges of objects are stepped or not sharp

Edges of objects are darker than expected

Bronzing

Horizontal lines at the end of a cut sheet print

Vertical lines of different colors

White spots on the print

Colors are inaccurate

The image is incomplete (clipped at the bottom)

The image is clipped

Some objects are missing from the printed image

Lines are too thick, too thin or missing

Lines appear stepped or jagged

Lines print double or in the wrong colors

Lines are discontinuous

Lines are blurred

Line lengths are inaccurate

The Image Diagnostics Print

If you still have a problem
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General advice

When you have any print-quality problem:

To achieve the best performance from your printer, use only genuine manufacturer's supplies and
accessories, whose reliability and performance have been thoroughly tested to give trouble-free
performance and best-quality prints. For details of recommended papers, see Order paper on page 113.

Make sure that the paper type selected in the front panel is the same as the paper type loaded into the
printer (see View information about the paper on page 42). At the same time, check that the paper type
has been calibrated. Also make sure that the paper type selected in your software is the same as the
paper type loaded into the printer.

A CAUTION: If you have the wrong paper type selected, you could experience poor print quality and

incorrect colors, and perhaps even damage to the printheads.

Check that you are using the most appropriate print-quality settings for your purposes (see Printing
on page 50). You are likely to see lower print quality if you have moved the print-quality slider to the
'Speed' end of the scale, or set the custom quality level to Fast.

Check that your environmental conditions (temperature, humidity) are in the recommended range. See
Environmental specifications on page 167.

Check that your ink cartridges and printheads have not passed their expiration dates: see Maintain the
ink cartridges on page 107.

Print quality troubleshooting wizard

The Print Quality Troubleshooting Wizard can help with the following problems:

Horizontal lines across the image (banding)
The whole image is blurry or grainy
Lines are too thick, too thin or missing

Colors are inaccurate

To start the wizard:

From the HP Utility for Windows: go to the Support tab, and select Print quality troubleshooting.
From the HP Utility for Mac 0S X: select Print quality troubleshooting in the Support group.

From the Mac 0S X Print dialog: go to the Services panel, select Device Maintenance, then select Print
quality troubleshooting from the list of maintenance tasks.

From the Embedded Web Server: go to the Support tab, select Troubleshooting, then select Print
quality troubleshooting.
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Most common print quality issues resolution

Select defect

You may be experiencing banding, graininess, poor line quality or color inaccuracy problems similar to the
ones shown in the images below. Please select the option that best represents your problem and press the Next
button to enter the correspending troubleshooting process.

Defect detail

= Roll over the imagss to obtain
more specific information about
the corresponding defect

O Banding O Graininess O Poor line quality O Color inaccuracy

It you see other image quality problems such as non-flat paper, ink blseds from lines, print smudges when
touched, etc., pleass refer to the:

= Printer User's Guide

If you want to dovinload detailed step-by-step guides that wil help you to get the right layout and color for
your prints, please refer to the

= HP Knowledge Center

Alternatively, or if you have other print quality problems, you can continue reading this chapter.

Horizontal lines across the image (banding)

If your printed image suffers from added horizontal lines as shown (the color may vary):

ENWwW

1. Check that the paper type you have loaded corresponds to the paper type selected in the front panel
and in your software. See View information about the paper on page 42.

2. Check that you are using appropriate print-quality settings for your purposes (see Printing on page 50).
In some cases, you can overcome a print-quality problem merely by selecting a higher print-quality
level. For instance, if you have set the Print Quality slider to Speed, try setting it to Quality. If you
change the print-quality settings, you may wish to reprint your job at this point in case the problem has

been solved.

3.  Print the Image Diagnostics Print. See The Image Diagnostics Print on page 141.

4. Ifthe printheads are working correctly, go to the front panel and press i ], then , then Image-

quality maintenance > Calibration Status to see the paper advance calibration status. If the status is
DEFAULT, try performing paper advance calibration: see Recalibrate the paper advance on page 127.

If the problem persists despite all the above actions, contact your customer service representative for

further support.
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Thin vertical lines across the image

If you see thin, straight, vertical lines separated by about 5 cm (2 in), across the whole width of the rollin
prints with dark area fills, try selecting sensitive-paper mode for that roll. See Sensitive-paper mode
on page 42.

The whole image is blurry or grainy

1. Check that the paper type you have loaded corresponds to the paper type selected in the front panel
and in your software. See View information about the paper on page 42.

2. Check that you are printing on the correct side of the paper.

3. Check that you are using appropriate print-quality settings (see Printing on page 50). In some cases,
you can overcome a print-quality problem merely by selecting a higher print-quality level. For instance,
if you have set the Print Quality slider to Speed, try setting it to Quality. If you change the print-quality
settings, you may wish to reprint your job at this point in case the problem has been solved.

4. Go to the front panel and press i then , then Image-quality maintenance > Calibration

Status to see the printhead alignment status. If the status is PENDING, you should align the printheads.
See Align the printheads on page 148. After alignment, you may wish to reprint your job in case the
problem has been solved.

5. Goto the front panel and press [JJ[iJ then , then Image-quality maintenance > Calibration

Status to see the paper advance calibration status. If the status is DEFAULT, you should perform paper
advance calibration: see Recalibrate the paper advance on page 127.

If the problem persists despite all the above actions, contact your customer service representative for
further support.

The paper is not flat

If the paper does not lie flat when it comes out of the printer, but has shallow waves in it, you are likely to see
defects in the printed image, such as vertical stripes. This can happen when you use thin paper that becomes
saturated with ink.
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1. Check that the paper type you have loaded corresponds to the paper type selected in the front panel
and in your software. See View information about the paper on page 42.

2. Try changing to a thicker paper type, such as HP Heavyweight Coated Paper or HP Super Heavyweight
Plus Matte Paper.

3. Select a paper type that is slightly thinner than the paper you have loaded; this will persuade the printer
to use less ink. Here are some example paper types in ascending order of thickness: Plain Paper, Coated
Paper, Heavyweight Coated Paper, Super Heavyweight Plus Matte Paper.

The print is scuffed or scratched

The black ink pigment can be scuffed or scratched when touched by a finger, a pen or some other object. This
is particularly noticeable on coated paper.

Glossy paper may be extremely sensitive to the basket or to anything else that it contacts soon after printing,
depending on the amount of ink used and the environmental conditions at the time of printing.

To reduce the risk of scuffs and scratches:
e  Handle prints carefully.
e  Avoid stacking prints on top of each other.

e  Catch your prints as they are cut from the roll and do not let them fall into the basket. Alternatively,
leave a sheet of paper in the basket so that freshly printed sheets do not make direct contact with the
basket.

Ink marks on the paper

This problem can occur for several different reasons.

Horizontal smears on the front of coated paper

If a lot of ink is used on plain or coated paper, the paper absorbs the ink quickly and expands. As the
printheads move over the paper, the printheads may come into contact with the paper and smear the printed
image. This problem is normally seen only on cut sheets of paper (not on roll paper).
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Whenever you notice this problem, cancel the printing job immediately. Press il and also cancel the job from
your computer application. Soaked paper can damage the printheads.

Try the following suggestions to avoid this problem:

1.  Check that the paper type you have loaded corresponds to the paper type selected in the front panel
and in your software. See View information about the paper on page 42.

2. Use arecommended paper type (see Order paper on page 113) and the correct print settings.

3. Ifusing sheet paper, try rotating the sheet 90 degrees. The orientation of the paper fibers may affect
performance.

4. Try changing to a thicker paper type, such as HP Heavyweight Coated Paper and HP Super Heavyweight
Plus Matte Paper.

5. Select a paper type that is slightly thinner than the paper you have loaded; this will persuade the printer
to use less ink. Here are some example paper types in ascending order of thickness: Plain Paper, Coated
Paper, Heavyweight Coated Paper, Super Heavyweight Plus Matte Paper.

6. Trytoincrease the margins by relocating the image to the center of the page using your software
application.

Ink marks on the back of the paper

This can happen after a lot of borderless printing, especially with non-standard paper sizes. Ink residues on
the platen are likely to mark the back of the paper.

Clean the platen with a soft cloth. Clean each rib separately without touching the foam between the ribs.

Black ink comes off when you touch the print

This problem may be caused by printing with matte black ink on glossy paper. The printer will not use matte
black ink if it knows that the paper will not retain it. To be sure of avoiding matte black ink, you can select
Photo Glossy Paper as the paper type (in the Photo Paper category).

Edges of objects are stepped or not sharp

If edges of objects or lines appear to be poorly defined or lighter in density, and you have already set the
print-quality slider to Quality in the driver dialog, select the custom print-quality options, and try setting the
quality level to Normal. See Printing on page 50.
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Edges of objects are darker than expected
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If edges of objects seem darker than expected, and you have already set the print-quality slider to Quality in
the driver dialog, select the custom print-quality options, and try setting the quality level to Normal. See
Printing on page 50.

Bronzing

If you are printing on photo paper in grayscale, and you experience a gloss differential problem when
fluorescent light is directly reflected towards you from the print, producing ‘bronzed' reflections from the ink,
try one of the following:

e If using standard print quality options, ensure that the slider is set to Quality (see Printing on page 50).

e  Tryselecting in the driver the Full set of inks option instead of Black and gray inks only.

e  Display the print vertically or behind glass.

Horizontal lines at the end of a cut sheet print

This type of defect affects only the end of a print, within approximately 30 mm of the trailing edge of the
paper. You may see some very thin horizontal lines across the print.

To avoid this problem:

1.  Print the Image Diagnostics Print. See The Image Diagnostics Print on page 141.

2.  Consider printing with roll paper.

3. Consider using larger margins around your image.

Vertical lines of different colors

If your print has vertical bands of different colors alongiit:

1. Tryusing thicker paper, choosing from the recommended paper types such as HP Heavyweight Coated
Paper and HP Super Heavyweight Paper. See Order paper on page 113.

2. Tryusing higher print-quality settings (see Printing on page 50). For instance, if you have set the Print
Quality slider to Speed, try setting it to Quality.

White spots on the print

You may notice white spots on the print. This is probably due to paper fibers, dust or loose coating material.
To avoid this problem:
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1.
2.

3.

Try cleaning the paper manually with a brush before printing, to remove any loose fibers or particles.
Always keep the cover of your printer closed.

Protect your paper rolls and sheets by storing them in bags or boxes.

Colors are inaccurate

If the colors of your print do not match your expectations, try the following:

1.

Check that the paper type you have loaded corresponds to the paper type selected in the front panel
and in your software. See View information about the paper on page 42. Also, press i then ,
then Image-quality maintenance > Calibration Status to check the color calibration status. If the

status is PENDING or OBSOLETE, you should perform color calibration: see Color calibration on page 73.
If you have made any changes, you may wish to reprint your job in case the problem has been solved.

Check that you are printing on the correct side of the paper.

Check that you are using appropriate print-quality settings (see Printing on page 50). If you have
selected the Speed or Fast options, you may not get the most accurate colors. If you change the print-
quality settings, you may wish to reprint your job at this point in case the problem has been solved.

If you are using Application Color Management, check that the color profile you are using corresponds
to the selected paper type and print-quality settings. If you have doubts about which color settings to
use, see Color management on page 72.

If the problem consists of color differences between your print and your monitor, please follow the
instructions in the “How to calibrate your monitor” section of the HP Color Center. At this point, you may
wish to reprint your job in case the problem has been solved.

Print the Image Diagnostics Print. See The Image Diagnostics Print on page 141.

Try using the color adjustment options to produce the colors you want. See Color adjustment options
on page 75.

If the problem persists despite all the above actions, contact your customer service representative for
further support.

The image is incomplete (clipped at the bottom)

Did you press Jjl before all the data were received by the printer? If so, you have ended the data
transmission and will have to print the page again.

The I/0 timeout setting may be too short. This setting determines how long the printer waits for the
computer to send more data, before deciding that the job is finished. From the front panel, increase the

1/0 timeout setting to a longer period and then send the print again. Press “, then , then Setup
> Connectivity > Advanced > Select 1/0 timeout.
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e  There may be a communications problem between your computer and the printer. Check your USB or
network cable.

e  Check to make sure that your software settings are correct for your current page size (for example,
long-axis prints).

e If youare using network software, make sure it has not timed out.

The imageiis clipped

Clipping normally indicates a discrepancy between the actual printable area on the loaded paper and the
printable area as understood by your software. You can often identify this kind of problem before printing by
previewing your print (see Preview a print on page 57).

e  Check the actual printable area for the paper size you have loaded.
printable area = paper size —margins

e  Check what your software understands to be the printable area (which it may call "printing area" or
"imageable area"). For example, some software applications assume standard printable areas that are
larger than those used in this printer.

e If you have defined a custom page size with very narrow margins, the printer may impose its own
minimal margins, clipping your image slightly. You may want to consider using a larger paper size, or
borderless printing (see Select margins options on page 55).

e If yourimage contains its own margins, you may be able to print it successfully by using the Clip
Contents by Margins option (see Select margins options on page 55).

e Ifyouare trying to print a very long image on a roll, check that your software is capable of printing an
image of that size.

e  You may have asked to rotate the page from portrait to landscape on a paper size that is not wide
enough.

e If necessary, reduce the size of the image or document in your software application, so it fits between
the margins.

There is another possible explanation for a clipped image. Some applications, such as Adobe Photoshop,
Adobe Illustrator and CorelDRAW, use an internal 16-bit coordinate system which means that they cannot
handle an image of more than 32,768 pixels.

E’%NOTE: An image 32,768 pixels long would print at a length of 1.39 m (54.61 in) if you select Best or Quality

in the driver, 2.78 m (109.23 in) if you select Fast, Normal or Speed in the driver.

If you try to print an image larger than this from these applications, the bottom of the image may be clipped.
To print the whole image, try these suggestions:

e  Save the file in another format, such as TIFF or EPS, and open it with another application.

e UseaRIPto print the file.

Some objects are missing from the printed image

ENWW

Large quantities of data may be necessary to print a high-quality large-format print job, and in some specific
workflows there may be issues that can lead to some objects missing from the output. Here are some
suggestions to help you to avoid this problem.

e  Select a smaller page size and scale to the desired final page size in the driver or in the front panel.

e  Save the file in another format, such as TIFF or EPS, and open it with another application.
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e  UseaRIPto print the file.
e  Reduce the resolution of bitmap images in your application software.

e  Select a lower print quality in order to reduce the resolution of the printed image.

=?NOTE:  If you are working under Mac 0S X, not all of these options are available.

These options are suggested for troubleshooting purposes and may adversely affect the final output quality
or the time necessary to generate the print job. Therefore, they should be cancelled if they do not help to
solve the problem.

Lines are too thick, too thin or missing

by —
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1. Check that the paper type you have loaded corresponds to the paper type selected in the front panel
and in your software. See View information about the paper on page 42.

2. Check that you are using appropriate print-quality settings for your purposes (see Printing on page 50).
Select the custom print-quality options in the driver dialog, and try turning on the Maximum detail
option (if available). You may wish to reprint your job at this point in case the problem has been solved.

3. If theresolution of your image is greater than the printing resolution, you may notice a loss of line
quality.

4. Iflines are too thin or missing, print the Image Diagnostics Print. See The Image Diagnostics Print
on page 141.

3. If the problem remains, go to the front panel and press [} then , then Image-quality

maintenance > Calibration Status to see the printhead alignment status. If the status is PENDING, you
should align the printheads. See Align the printheads on page 148. After alignment, you may wish to
reprint your job in case the problem has been solved.

6. Go to the front panel and press “ then , then Image-quality maintenance > Calibration

Status to see the paper advance calibration status. If the status is DEFAULT, you should perform paper
advance calibration: see Recalibrate the paper advance on page 127.

If the problem persists despite all the above actions, contact your customer service representative for
further support.

Lines appear stepped or jagged

If lines in your image appear stepped or jagged when printed:
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1. The problem may be inherent in the image. Try to improve the image with the application you are using
to edit it.

2. Check that you are using appropriate print-quality settings. See Printing on page 50.

3. Select the custom print-quality options in the driver dialog, and turn on the Maximum detail option (if
available).

Lines print double or in the wrong colors

This problem can have various visible symptoms:

e  Colored lines are printed double, in different colors.

/s

N\

e  Theborders of colored blocks are wrongly colored.

To correct this kind of problem:

1.  Reseat the printheads by removing them and then reinserting them. See Remove a printhead
on page 100 and Insert a printhead on page 103.

2.  Align the printheads. See Align the printheads on page 148.

Lines are discontinuous

If your lines are broken in the following way:
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1. Check that you are using appropriate print-quality settings. See Printing on page 50.

2. Reseat the printheads by removing them and then reinserting them. See Remove a printhead
on page 100 and Insert a printhead on page 103.

3.  Align the printheads. See Align the printheads on page 148.

Lines are blurred

Humidity can cause ink to soak into the paper, making the lines blurred and fuzzy. Try the following:

1.  Check that your environmental conditions (temperature, humidity) are suitable for high-quality printing.
See Environmental specifications on page 167.

2. Check that the paper type selected in the front panel is the same as the paper type you are using. See
View information about the paper on page 42.

3. Trychanging to a heavier paper type, such as HP Heavyweight Coated Paper or HP Super Heavyweight
Plus Matte Paper.

4. Select a paper type that is slightly thinner than the paper you have loaded; this will persuade the printer
to use less ink. Here are some example paper types in ascending order of thickness: Plain Paper, Coated
Paper, Heavyweight Coated Paper, Super Heavyweight Plus Matte Paper.

5. If you are using glossy paper, try changing to a different type of glossy paper.

6. Align the printheads. See Align the printheads on page 148.

Line lengths are inaccurate

If you have measured your printed lines and find that the lengths are not sufficiently accurate for your
purposes, you can try to improve line length accuracy in the following ways.

1.  Print on HP Matte Film, for which your printer's line length accuracy is specified. See Functional
specifications on page 165.

Polyester film is about ten times more dimensionally stable than paper. However, using film that is
thinner or thicker than HP Matte Film will reduce line length accuracy.

2. Set the Print Quality slider to Quality.

140 Chapter 17 Troubleshooting print-quality issues ENWW



Maintain the room at a steady temperature between 10 and 30°C (50 and 86°F).
Load the roll of film and let it rest for five minutes before printing.

If you are still not satisfied, try recalibrating the paper advance. See Recalibrate the paper advance
on page 127.

The Image Diagnostics Print

The Image Diagnostics Print consists of patterns designed to highlight printhead reliability problems. It helps
you to check the performance of the printheads that are currently installed in your printer, and whether any
printhead suffers from clogging or other problems.

ENWw

To print the Image Diagnostics Print:

1.

2.

Use the same paper type that you were using when you detected a problem.

Check that the selected paper type is the same as the paper type loaded into the printer. See View
information about the paper on page 42.

At the printer's front panel, press “ then , then select Image-quality maintenance > Print
diagnostic image.

It takes about two minutes to print the Image Diagnostics Print.

The print is divided into two parts, both of which test printhead performance.

Part 1 (top) consists of rectangles of pure colors, one for each printhead. This part represents the print
quality that you will get from each color.

Part 2 (bottom) consists of small dashes, one for each nozzle on each printhead. This part complements
the first, and aims more specifically to detect how many faulty nozzles each printhead has.

Please look carefully at the print. The names of the colors are shown above the rectangles and in the center
of the patterns of dashes.

M-Y

PK - LG MK - C

= M-Y

1 ]
FLEFI T FLLLT,

. PR-LG

m MK-C
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First look at the upper part of the print (part 1). Each colored rectangle should be a uniform color without any
horizontal lines across it.

Then look at the bottom part of the print (part 2). For each individual colored pattern, check that most of the
dashes are present.

If you see horizontal lines in part 1 and also missing dashes in part 2 for the same color, the printhead
responsible needs cleaning. However, if the rectangles look solid, do not worry about just a few missing
dashes in part 2; these are acceptable because the printer can compensate for a few clogged nozzles.

Here is an example of a gray printhead in a good state:

G

And here is an example of the same printhead in a bad state:

G

Corrective action

1. Clean any faulty printheads (see Clean the printheads on page 146). Then reprint the Image Diagnostics
Print to see whether the problem has been solved.

2. If the problem remains, clean the printheads again, and reprint the Image Diagnostics Print to see
whether the problem has been solved.

3. If the problem remains, consider cleaning your printheads manually (see Clean the printheads
on page 146). You could also try reprinting your current print job, in case it now prints satisfactorily.
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4. If the problem remains, try cleaning the printhead drop detector. The printer normally notifies you when
this is necessary, but it may be worth trying even if the printer has not suggested it. See Clean the
printhead drop detector on page 146.

5. If the problem still remains, replace any persistently faulty printheads (see Handling ink cartridges and
printheads on page 96), or contact HP Support (see Contact HP Support on page 163).

If you still have a problem

If you still experience print-quality problems after applying the advice in this chapter, here are some further
things that you can do:

e  Tryusing a higher print-quality option. See Printing on page 50.

e  Check the driver you are using to print with. If it is a non-HP driver, consult the driver vendor about the
problem. You could also try using the correct HP driver, if feasible. The latest HP drivers can be
downloaded from http://www.hp.com/go/Z5400ps/drivers.

e Ifyouare using a non-HP RIP, its settings may be incorrect. See the documentation that came with the
RIP.

e  Check that your printer's firmware is up to date. See Update the firmware on page 108.

e  (Check that you have the right settings in your software application.
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18 Troubleshooting ink cartridge and
printhead issues

° Cannot insert anink cartridge

° Ink cartridge status messages

° Cannot insert a printhead

e The front-panel display recommends reseating or replacing a printhead

° Clean the printheads

o  (lean the printhead drop detector

° Align the printheads

° Printhead status messages
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Cannot insert an ink cartridge

1. Check that you have the correct type of cartridge (model number).
2. Check that the colored label on the cartridge is the same color as the label on the slot.

3. Check that the cartridge is correctly oriented, with the letter or letters marking the cartridge label right-
side up and readable.

A CAUTION: Never clean inside the ink cartridge slots.

Ink cartridge status messages

These are the possible ink cartridge status messages:

e  OK: The cartridge is working normally, with no known problems.

e  Missing: Thereis no cartridge present, or it is not correctly connected to the printer.
e Low: Theinklevelis low.

e Verylow: Theink levelis very low.

e  Empty: The cartridge is empty.

e  Reseat: You are recommended to remove the cartridge and then reinsert it.

e  Replace: You are recommended to replace the cartridge with a new cartridge.

e  Expired: It is past the cartridge's expiration date.

e  Non-HP ink: The cartridge contains ink not made by HP.

Cannot insert a printhead

1.  Check that you have the correct type of printhead (model number).

2. Check that you have removed the two orange protective caps from the printhead.

3. Check that the colored label on the printhead is the same color as the label on the slot.
4. Check that the printhead is correctly oriented (compare with the others).

5. Check that you have correctly closed and latched the printhead cover, see Insert a printhead
on page 103.

The front-panel display recommends reseating or replacing a
printhead

1.  From the front panel, turn the power off then on.

2. Check the front-panel display message, if it shows the ready message, the printer is ready to print. If
the problem remains continue with the next step.

3. Remove the printhead, see Remove a printhead on page 100.
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4. Clean the electrical connections on the backside of the printhead with a lint free cloth. You can carefully
use a mild rubbing alcohol if moisture is needed to remove residue. Do not use water.

A CAUTION: This is a delicate process and may damage the printhead. Do not touch the nozzles on the
bottom side of the printhead, especially not with any alcohol.

5. Reinsert the printhead, see Insert a printhead on page 103.

6. Check the front-panel display message. If the problem remains, try a new printhead.

Clean the printheads

As long as the printer is kept turned on, automatic cleaning is performed periodically. This ensures there is
fresh ink in the nozzles and prevents nozzle clogs, which ensures color accuracy. If you have not already
done so, please see The Image Diagnostics Print on page 141 before proceeding.

To clean the printheads, go to the front panel and press “ then , then Image-quality maintenance

> Clean printheads. If you have gone through the Image Quality Diagnostic print process, you know which
colors are failing. Select the pair of printheads which contain the failing colors. If you are not sure which
colors to clean, you can also select to clean all printheads. Cleaning all printheads takes about nine minutes.
Cleaning a single pair of printheads takes about six minutes.

%’NOTE: Cleaning all printheads uses more ink than cleaning a single pair.

Clean the printhead drop detector

The printhead drop detector is a sensor that detects which nozzles on the printheads are not printing in order
to substitute them for good printing nozzles. If particles, such as fibers, hair or paper pieces, block the sensor
print-quality is affected.

When the front panel displays a warning message that the clean process is needed, you are recommended to
clean the printhead drop detector. If you do not clean the printhead drop detector immediately, the printer
continues working normally, however, the front panel display continues to show the warning.

A CAUTION: Wear gloves to avoid getting ink on your hands.
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Turn off the printer at the front panel.

2. Toavoid an electric shock, switch the printer off and unplug it.
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5. Remove any debris blocking the printhead drop detector.

6. Withadry, lint-free cloth, wipe the surface of the drop detector to remove any non-visible debris.

r F
Ay

7. Close the window.

9. Power the printer on at the front panel.

Align the printheads

Precise alignment between printheads is essential for accurate colors, smooth color transitions and sharp
edges in graphical elements. Your printer has an automatic printhead alignment process which runs
whenever a printhead has been accessed or replaced.

In cases where the paper has jammed or you are experiencing problems with color accuracy, see Color
management on page 72; you may need to align the printheads.
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E‘%NOTE: If the paper has jammed, it is recommended that you reinsert the printheads and initiate the
realignment procedure by pressing “ then , then Image-quality maintenance > Align printheads.

A CAUTION: Do not use transparent or semi-transparent paper to align the printheads.

Reinsert printheads procedure

1.  If the realignment process is running and the wrong paper is loaded, press il on the front panel.

A CAUTION: Do not print if the realignment process has been canceled. You can restart the alignment by
pressing i then , then Image-quality maintenance > Align printheads.

2. Load the paper you wish to use, see Paper handling on page 33. You can use aroll that is at least 610
mm (24 in) wide or a cut sheet that is A2 landscape or larger.

A CAUTION: Do not use transparent or semi-transparent paper to align the printheads.

3. Remove and re-insert all the printheads, see Remove a printhead on page 100 and Insert a printhead
on page 103. This starts the printhead alignment procedure.

4. Ensure the window is closed, as a strong light source near the printer during printhead realignment can
affect alignment.

5. The process takes about six minutes. Wait until the front-panel display shows the process complete
before using the printer.

?‘ NOTE: The printer prints a calibration image. Do not worry about the image. The front-panel display
shows any errors in the process.

Image-quality maintenance menu procedure

1. Load the paper you wish to use, see Paper handling on page 33. You can use aroll or cut sheet,
however, it must be A3 landscape or larger (420 by 297 mm).

A CAUTION: Do not use transparent or semi-transparent paper to align the printheads.

2. From the front panel, press “ then , then Image-quality maintenance > Align printheads.
The printer checks to see if it has enough paper to run the realignment.
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3. Ifthe loaded paper is satisfactory, the printer runs the realignment and prints a realignment pattern.
Ensure the window is closed, as a strong light source near the printer during printhead realignment can
affect alignment.

4. The process takes about five minutes. Wait until the front-panel display shows the process complete
before using the printer.

Scanning errors during alignment

If the alignment process fails, a Scanning problems message appears on the front panel. This means that the
alignment has not completed successfully. Therefore the printer is not aligned and the alignment should be
repeated before printing with good image quality. The problem may be due to:

e  The paper used was not valid, repeat the alignment with valid paper

e  Printhead health problems, clean printheads, see Clean the printheads on page 146

e  Thealignment was done with the window open, repeat the alignment with the window closed

If the problem persists after using valid paper, cleaning the printheads and keeping the window closed, there
may be a failure in the scanning system needing repair; or the printheads, although clean, may not work and
need to be replaced.

Printhead status messages

These are the possible printhead status messages:
e  OK: the printhead is working normally, with no known problems
e  Missing: there is no printhead present, or it is not correctly installed in the printer.

e  Test printhead separately: you are recommended to test the printheads individually to find the failing
printhead. Remove all the printheads and insert them alone one by one, closing the latch and the
carriage cover after every insertion. The front-panel display indicates the failing one showing the reseat
or replace message.

e  Reseat: you are recommended to remove the printhead and then reinsert it. If that fails, clean the
electrical connections, see The front-panel display recommends reseating or replacing a printhead
on page 145. If that fails, replace the printhead with a new printhead, see Remove a printhead
on page 100 and Insert a printhead on page 103.

e  Replace: the printhead is failing. Replace the printhead with a working printhead, see Remove a
printhead on page 100 and Insert a printhead on page 103.

e  Replacement incomplete: a printhead replacement process has not completed successfully, re-launch
the replacement process and let it finish completely (it is not needed to change the printheads).

e  Remove: the printhead is not a suitable type for use in printing.
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19 Troubleshooting general printer issues

° The printer will not start

e  The printer does not print

° The printer seems slow

° Communication failures between computer and printer

° Cannot access the HP Utility

° Cannot access the Embedded Web Server

° Cannot connect to the Internet

e  Web Services issues

e  Automatic file system check

e Alerts
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The printer will not start

If the printer will not start (the front panel is blank or the diagnostic LEDs are all off), you are recommended
to replace the firmware, in the following way.

1.

2.

Go to the Knowledge Center (see Knowledge Center on page 161) and download the firmware.

Save the firmware on a USB flash drive. Ideally, the USB flash drive should be empty and formatted with
the FAT filesystem.

Ensure that the printer is turned off. Connect the USB flash drive to the Hi-Speed USB host port beside
the front panel, then turn the printer on.

The printer takes about a minute to read the firmware file, then asks you to remove the USB flash drive.

The printer automatically installs the new firmware and restarts.

The printer does not print

If allis in order (paper loaded, all ink components installed and no file errors), there are still reasons why a
file you have sent from your computer may not start printing when expected:

You may have an electrical power problem. If there is no activity at all from the printer, and the front
panel does not respond, check that the power cable is connected correctly and that there is power
available at the socket.

You may be experiencing unusual electromagnetic phenomena, such as strong electromagnetic fields or
severe electrical disturbances, which can cause the printer to behave strangely or even stop working. In
this case, turn off the printer using the Power key on the front panel and unplug the power cord, wait
until the electromagnetic environment has returned to normal, then turn it on again. If you still
experience problems, please contact your customer service representative.

Nesting may be on, and the printer is waiting for the specified nest wait time before calculating the
appropriate nests. In this case, the front panel shows the remaining time needed for nesting.

You may have the wrong graphic language setting, see Change the graphic language setting on page 32.

You may not have installed in your computer the correct driver for your printer, see the Assembly
instructions.

If you are printing on a sheet, you must specify Manual Feed as the paper source in your printer driver.

The printer may be holding the job for paper or accounting information, see Job status messages
on page 70.

You may have requested a print preview from your printer driver. This is a function you can use to check
that the image is the one you want. In this case, the preview is displayed on your screen, and you must
click the Print button to start printing.

If you are using Mac 0S X with a USB connection, you may find that you need to change the data
encoding. Press [J[iJ then , then Setup > Printing preferences > PS > Select encoding > ASCII.
Then configure your application to send ASCII data.

The printer seems slow

Here are some possible explanations.
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e  Didyou set the print-quality to Best or Max Detail? Best-quality and maximum detail prints take longer.

e Didyou specify the correct paper type when loading the paper? Some paper types require more time for
printing; for example, photo and coated papers require more drying time between passes. To find out
the printer's current paper type setting, see View information about the paper on page 42.

e If your printer is connected by network, check that all components used in the network (network
interface cards, hubs, routers, switches, cables) are capable of high-speed operation. Is there a lot of
traffic from other devices on the network?

e If your printer is connected by USB, make sure that the USB host controller and the USB hubs used (if
any) are USB 2.0; and check that the USB cables are USB 2.0 certified.

e Didyou specify Extended drying time in the front panel? Try changing the drying time to Optimal.

Communication failures between computer and printer

Some symptoms are:

e  The front-panel display does not show the Receiving message when you have sent an image to the
printer.

e  Your computer displays an error message when you are trying to print.
e  Your computer or printer hangs (stays idle), while communication is taking place.
e  Your printed output shows random or inexplicable errors (misplaced lines, partial graphics etc.)

To solve a communication problem:

e  Ensure that you have selected the correct printer in your application, see Printing on page 50.
e  Ensure that the printer works correctly when printing from other applications.
e  Remember that very large prints may take some time to receive, process and print.

e If the printer is connected to a network, try using it when connected directly to your computer through a
USB cable.

e  If your printer is connected to your computer through any other intermediate devices, such as switch
boxes, buffer boxes, cable adapters, cable converters, etc., try using it when connected directly to your
computer.

e  Tryanother interface cable.

e  Ensure that the graphic language setting is correct, see Change the graphic language setting
on page 32.

e If the printer is connected by network, check that your printer has a static IP address. If it is using DHCP,
the IP address may change every time it is turned on, in which case the driver may not be able to find it.

e |f the printer is connected by USB cable, try disconnecting and reconnecting the USB cable. Also try
using a different USB port on the computer.

Cannot access the HP Utility

If you have not done so already, please read Access the HP Utility on page 29.

From the front panel, press [J[iJ then , then Setup > Connectivity > Advanced > Web Services >
Printer utility software > Enabled.

If you still cannot connect, switch the printer off and back on with the Power key on the front panel.
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Cannot access the Embedded Web Server

If you have not done so already, please read Access the Embedded Web Server on page 29.

=7 NOTE: If you connect directly to your printer with a USB cable, use the HP Utility.

From the front panel, press i then , then Setup > Connectivity > Advanced > Embedded Web
Server > Allow EWS > On.

If you are using a proxy server, try bypassing the server and accessing the Web server directly.

e InInternet Explorer 6 for Windows, go to Tools > Internet Options > Connections > LAN Settings, and
check the Bypass proxy server for local addresses box. Alternatively, for more precise control, click
the Advanced button and add the printer's IP address to the list of exceptions, for which the proxy
server is not used.

e InSafarifor Mac 0S X, go to Safari > Preferences > Advanced and click the Proxies: Change Settings
button. Add the printer's IP address or its domain name to the list of exceptions, for which the proxy
server is not used.

If you still cannot connect, switch the printer off and back on with the Power key on the front panel.

Cannot connect to the Internet

If your printer has difficulty in connecting to the Internet, it may start the Connectivity Wizard automatically.
You can also start the wizard manually at any time.

e  Fromthe Embedded Web Server: select Support > Connectivity troubleshooting > Connectivity
wizard.

E‘%NOTE: You cannot change connectivity settings from the Embedded Web Server.

®  From the front panel: Press ﬂ then , then Connectivity > Connectivity wizard.

®  From the front panel: Press “ then , then Internal prints > Service information prints > Print
connectivity config. In this case, the results are printed out.

E”%"NOTE: The results printed out are from the last run of the Connectivity wizard, so you must already
have run the Connectivity wizard in order to get any results.

The Connectivity Wizard performs a series of tests automatically. You can also choose to perform individual
tests. From the front panel, press [ then , then Connectivity > Diagnostics & troubleshooting >
Diagnostics & troubleshooting. The following options are available.

e  Alltests

e  Network connectivity test: Check the printer's connection to the local area network.

e Internet connectivity test: Check the printer's connection to the Internet.

e  HP ePrint Center test: Check the printer's connection to the HP ePrint Center.

e  Firmware update test: Check the printer's connection to HP's firmware update servers.

If any test fails, the printer describes the problem and recommends how to solve it. You can modify settings
and rerun the test, unless you are using the Embedded Web Server or the settings are protected.
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Web Services issues

For any issues with HP ePrint, please refer to the HP ePrint Center: http://www.hp.com/go/eprintcenter.

Automatic file system check

When you turn on the printer, you will occasionally see a front panel display similar to the one shown below.

) File System Check

A file system check is taking place; it can take up to 40 minutes. Please wait until it finishes.

A CAUTION: If you turn the printer off before the file system check has finished, the file system could be
seriously damaged, making the printer's hard disk unusable. In any case, the file system check will restart
from the beginning whenever you turn the printer on again.

A file system check is scheduled every 90 days, in order to maintain the hard disk's file system integrity.

__%7NOTE: When the printer is powered back on, it takes about three minutes to initialize and check and
prepare the printheads. However, it can take up to 40 under some conditions, for example, when the printer
has not been used for a long period of time and requires more time to prepare the printheads.

Alerts

Your printer can communicate two types of alerts:

e  Errors: Mainly alerting you to the fact that the printer is unable to work normally. However, in the
printer driver, errors can also alert you to conditions that could ruin the print, such as clipping, even if
the printer is able to print.

e  Warnings: Alert you when the printer needs attention either for an adjustment, such as a calibration or
for a possible unprintable situation, such as a preventive maintenance or low ink.

There are four different alerts communicators within your printer's system.

e  Front-panel display: The front panel shows only the most relevant alert at a time. In the case of a
warning, it disappears after a timeout. There are permanent alerts, such as "ink cartridge low on ink",
that reappear when the printer becomes idle and there is not another more severe alert.

:{;’. TIP:  From the front panel display you can configure paper mismatch alerts, see Paper suitability
® options on page 23.

e Embedded Web Server: The upper-right corner of the Embedded Web Server window shows the printer
status. If there is an alert in the printer, the status shows the alert text.
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e  Driver: The driver shows alerts. The driver warns about job configuration settings that may produce a
problem in the final output. If the printer is not ready to print, it displays a warning.

e  HP Utility: To see alerts, go to the Overview tab and review the ltems needing attention list on the
right-hand side.

By default, alerts are displayed only when you are printing. If alerts are enabled and there is a problem
that prevents a job from completing, you see a pop-up window, which explains the reason for the
problem. Follow the instructions to achieve your required result.

E‘%NOTE: There are environments that do not support bidirectional communication, for example: a
Windows computer connected to the printer with USB. In those cases, alerts do not reach the job owner.
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20 Front-panel error messages

Occasionally you may see one of the following messages appear on the front-panel display. If so, please
follow the advice in the Recommendation column.

If you see an error message that does not appear here, and you feel in doubt about the correct response, or if
the recommended action does not seem to solve the problem, contact HP Support. See Contact HP Support

on page 163.

Table 20-1 Text messages

Message Recommendation

[Color] cartridge altered Check the cartridge.

[Color] cartridge has expired Replace the cartridge. See Handling ink cartridges and printheads
on page 96.

[Color] cartridge is low on ink Ensure that you have a new cartridge of the same color ready.

[Color] cartridge is missing Insert a cartridge of the correct color. See Handling ink cartridges

and printheads on page 96.

[Color] cartridge is out of ink Replace the cartridge. See Handling ink cartridges and printheads
on page 96.

[Color] cartridge is very low on ink Ensure that you have a new cartridge of the same color ready.

[Color] printhead #[n] error: not present Insert the correct printhead. See Handling ink cartridges and

printheads on page 96.

[Color] printhead #[n] error: please remove Remove the incorrect printhead and insert a new printhead of the
correct type (color and number). See Handling ink cartridges and
printheads on page 96.

[Color] printhead #[n] error: replace Remove the non-functional printhead and insert a new printhead
of the correct type (color and number). See Handling ink
cartridges and printheads on page 96.

[Color] printhead #[n] error: reseat Remove and reinsert the same printhead, or try cleaning the
electrical connections. If necessary, insert a new printhead. See
The front-panel display recommends reseating or replacing a
printhead on page 145.

Cutter replacement advised Contact HP Support to replace the cutter. See Contact HP Support
on page 163.

Job queue notification Cancel, resume or delete the job. See Job queue management
on page 65.

Maintenance #1 advised Contact HP Support. See Contact HP Support on page 163.

Maintenance #2 advised Contact HP Support. See Contact HP Support on page 163.

Paper loaded incorrectly: remove paper Remove the paper and try to reload it.

Paper mispositioned: remove paper Remove the paper and try to reload it.

Paper path error: incorrectly loaded Unload and reload the paper.
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Table 20-1 Text messages (continued)

Message

Recommendation

Paper path error: misaligned

Unload and reload the paper.

Printhead replacement incomplete. Restart it.

Restart the printhead replacement process.

Printheads need individual testing. Do replacement

Check the printheads using the Image Diagnostics Print (see The
Image Diagnostics Print on page 141) and replace any that are
not working correctly.

Replace [color] cartridge

Replace the cartridge. See Handling ink cartridges and printheads
on page 96.

Reseat [color] cartridge

Remove and reinsert the same cartridge. See Handling ink
cartridges and printheads on page 96.

Table 20-2 Numerical error codes

Error code Recommendation

01.0,01.1,01.2 Restart the printer.

06:03 Restart the printer.

08:04 Restart the printer. If the problem persists, update the printer's firmware. See Update the firmware
on page 108.

08:08 Retry the operation that you were attempting. If it fails again, restart the printer. If the problem

persists, update the printer's firmware. See Update the firmware on page 108.

21,21.1,21:03, 21.1:03, 21:13,

21.2:13,22.0,22.1,22.2,22.3,
22.x:03, 24

Restart the printer.

26:01, 26.x:01 Bad contact detected in an ink cartridge (if present, x refers to the cartridge in slot x). Remove and
reinsert the cartridge. If necessary, insert a new cartridge.

26:14 Update your printer's firmware. See Update the firmware on page 108.

27:01, 27.x:01 Too many printhead nozzles are not working (if present, x refers to the printhead in slot x). Remove
and reinsert the printhead, or try cleaning the electrical connections. If necessary, insert a new
printhead. See The front-panel display recommends reseating or replacing a printhead on page 145.

27:03 Printhead error. Restart the printer.

27:14 Update your printer's firmware. See Update the firmware on page 108.

31:03, 41:03, 42:03, 45.1:03,
45.2:03,47:03, 56:03

Restart the printer.

61:01

The file format is wrong and the printer cannot process the job. If the job is password-protected, try
sending it without password protection. Otherwise, update your printer's firmware and try again.
See Update the firmware on page 108.

61:04.1,61:04.2

Update your printer's firmware. See Update the firmware on page 108.

61:08.1 Resend the job without password protection.

66:08 The job cannot be printed on the paper type that is loaded.

68:03 Restart the printer.

71.04 Out of memory.

71:03 Restart the printer.

74:04,74.1:04 The firmware update has failed. Press OK and try again. See Update the firmware on page 108.
74.1 Try the firmware update again. Do not try to use your computer while the update is in progress.
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The system error log

Table 20-2 Numerical error codes (continued)

Error code Recommendation

74.8:04 The firmware update has failed. Your firmware file may be incorrect; try to download it again. See
Update the firmware on page 108.

76:03 Restart the printer.

77:04,78.1:04 Update your printer's firmware. See Update the firmware on page 108.

78:08 Borderless printing not possible; setting ignored..

79:03 Restart the printer.

79:04,79.1:04 Update your printer's firmware. See Update the firmware on page 108.

81:01 Please follow the instructions on the front panel. You may be asked to run a test procedure and
write down a numeric code before contacting HP Support. See Contact HP Support on page 163.

81:03, 84:03 Restart the printer.

86:01 Please follow the instructions on the front panel. You may be asked to run a test procedure and
write down a numeric code before contacting HP Support. See Contact HP Support on page 163.

94,94.1,94:08 Restart color calibration. See Color calibration on page 73.

94:02 Color calibration failed. Check that the paper type that is loaded corresponds to the paper type that

you have selected.

The printer saves a log of system errors that you can access in the following ways.

Using a USB flash drive

Using the Embedded Web Server

ENWw

1.  Create an empty file named pdipu_enable.log in a USB flash drive.

2. Insert the USB flash drive into the Hi-Speed USB host port at the front of the printer. The log will be
automatically copied into the drive.

1. Inyour Web browser, go to http://printer IP address/hp/device/webAccess/log.html.

2. The Embedded Web Server will send you a file called log.tar.gz containing the system error log.
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21 HP Customer Care

° Introduction

° HP Professional Services

° HP Proactive Support

° Customer Self Repair

° Contact HP Support
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Introduction

HP Customer Care offers award-winning support to ensure you get the most from your HP DesignJet,
providing comprehensive, proven support expertise and new technologies to give you unique end-to-end
support. Services include setup and installation, troubleshooting tools, warranty upgrades, repair and
exchange services, phone and Web support, software updates and self-maintenance services. To find out
more about HP Customer Care, please visit us at:

http://www.hp.com/go/graphic-arts

or call us on the telephone (see Contact HP Support on page 163). To register your warranty:

http://register.hp.com/

HP Professional Services

Knowledge Center

Enjoy a world of dedicated services and resources to ensure you always get the best performance from your
HP DesignJet printers and solutions.

Join the HP community at the Knowledge Center, your large-format printing community, for 24x7 access to:
e  Multimedia tutorials

e  Step-by-step how-to guides

e  Downloads: the latest printer firmware, drivers, software, paper presets, etc.

e  Technical support: online troubleshooting, customer care contacts and more

e  Workflows and detailed advice for completing various printing tasks from particular software
applications

e  Forums for direct contact with the experts, both HP and your colleagues
e  Warranty tracking online, for your peace of mind

e Latest product information: printers, supplies, accessories, software, etc.
e  Supplies Center for all you need to know about ink and paper

The Knowledge Center can be found at http://www.hp.com/go/Z5400ps/knowledgecenter.

By customizing your registration for the products you have purchased and your type of business, and by
setting your communication preferences, you decide the information you need.

HP Start-Up Kit

The HP Start-Up Kit is the CD that comes with your printer; it contains the printer's software and
documentation.

HP Care Packs and Warranty Extensions

HP Care Packs and Warranty Extensions allow you to extend your printer's warranty beyond the standard
period.

They include remote support. On-site service is also provided if necessary, with two alternative response-
time options.

ENWW Introduction 161


http://www.hp.com/go/graphic-arts
http://register.hp.com/
http://www.hp.com/go/Z5400ps/knowledgecenter

e  Next business day
e Same business day, within four hours (may not be available in all countries)

For more information on HP Care Packs, please visit http://www.hp.com/go/printservices.

HP Installation
The HP Installation service unpacks, sets up and connects the printer for you.

This is one of the HP Care Pack services; for more information, please visit http://www.hp.com/go/
printservices.

HP Proactive Support

HP Proactive Support helps reduce costly printer downtime by preemptively identifying, diagnosing and
resolving printer issues before they become problems for you. HP's Proactive Support tool is designed to
help businesses of all sizes reduce support costs and maximize productivity—all with the click of a mouse.

A component of the HP Imaging and Printing suite of services, Proactive Support helps you gain control of
your printing environment—with a clear focus on maximizing the value of your investment, increasing
printer uptime and reducing printer management costs.

HP recommends that you enable Proactive Support right away to save you time and prevent problems before
they occur, reducing costly downtime. Proactive Support runs diagnostics and checks for software and
firmware updates.

You can enable Proactive Support in the HP Utility for Windows or the HP Printer Monitor for Mac 0S X, where
you can specify the frequency of connections between your computer and HP's Web server, and the
frequency of diagnostic checks. You can also choose to run the diagnostic checks at any time. To change
these settings:

e Inthe HP Utility for Windows, select the Tools menu, then HP Proactive Support.
e  Inthe HP Printer Monitor for Mac 0S X, select Preferences > Monitoring > HP Proactive Support.

If Proactive Support finds any potential problem, it notifies you with an alert, which will explain the problem
and recommend a solution. In some cases, the solution may be applied automatically; in other cases, you
may be asked to perform some procedure to solve the problem.

Customer Self Repair

HP's Customer Self Repair program offers our customers the fastest service under either warranty or
contract. It enables HP to ship replacement parts directly to you (the end user) so that you can replace them.
Using this program, you can replace parts at your own convenience.

Convenient, easy to use

e  AnHP Support Specialist will diagnose and assess whether a replacement part is required to address a
defective hardware component.

e  Replacement parts are express-shipped; most in-stock parts are shipped the very same day you contact
HP.

e  Available for most HP products currently under warranty or contract.
e  Available in most countries.

For more information about Customer Self Repair, see http://www.hp.com/go/selfrepair.
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Contact HP Support

HP Support is available to you by telephone. What to do before you call:

e  Review the troubleshooting suggestions in this document.

e  Review therelevant driver documentation.

e If you have installed third-party software drivers and RIPs, see their documentation.

e Ifyou call one of the HP offices, please have the following information available to help us answer
your questions more quickly:

° The product you are using (the product number and the serial number, found on the label at the
back of the product)

° If there is an error code on the front panel, note it down; see Front-panel error messages
on page 157

The product's Service ID: at the front panel, press [ then , then E

o The computer you are using

° Any special equipment or software you are using (for example, spoolers, networks, switch-boxes,
modems or special software drivers)

° The cable you are using (by part number) and where you purchased it
° The type of interface used on your product (USB or network)
° The software name and version you are currently using

° If possible, print out the following reports; you may be asked to fax them to the support center
helping you: Configuration, Usage Report and “all pages above” from Service Information (see The
printer’s internal prints on page 11)

Telephone number

Your HP Support telephone number is available on the Web: please visit http://welcome.hp.com/country/us/
en/wwcontact_us.html.

ENWW Contact HP Support 163


http://welcome.hp.com/country/us/en/wwcontact_us.html
http://welcome.hp.com/country/us/en/wwcontact_us.html

22 Printer specifications

° Functional specifications

° Physical specifications

° Memory specifications

° Power specifications

° Ecological specifications

° Environmental specifications

° Acoustic specifications
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Functional specifications

ENWw

Table 22-1 HP ink supplies

Printheads

Two inks in each printhead: matte black and cyan, magenta and yellow, photo black and

light gray

Ink cartridges

Cartridges containing 130 ml of ink: matte black, photo black, light gray, cyan, magenta,

yellow

Cartridges containing 300 ml of ink: matte black, photo black, light gray, cyan, magenta,

yellow
Table 22-2 Paper sizes
Minimum Maximum
Roll width 279 mm (11 in) 1118 mm (44 in)
Roll length 91 m (300 feet)

Roll diameter

135mm (5.3 in)

Roll weight 11.9kg (26.3 Ib)
Sheet width 210 mm (8.26in) 1118 mm (44 in)
Sheet length 279 mm (11in) 1676 mm (66 in)

Paper thickness

0.8 mm (31.5 mil)

Paper weight 60 g/m2 328 g/m?
Table 22-3 Printing resolutions

Print quality Maximum Extra Rendering resolution  Printing resolution 1 Printing resolution 2
detail passes (ppi) (dpi) (dpi)

Best On On 600 x 600 2400 x 1200 * 1200 x 1200
On/Off On 600 x 600 1200 x 1200 1200 x 1200
On/Off off 600 x 600 600 x 1200 1200 x 1200

Normal On 600 * 600 600 x 1200 1200 x 1200
Off 300 = 300 600 x 1200 1200 x 1200

Fast On 600 x 600 600 x 1200 1200 x 1200
Off 300 x 300 600 x 1200 1200 x 1200

Economode On 600 x 600 600 x 1200 1200 x 1200
off 300 x 300 600 x 1200 1200 x 1200

The printing resolution depends on the paper type, as follows.

e  Printing resolution 1 applies to plain, coated, heavyweight coated, super heavyweight coated, satin
and glossy paper.
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* Satin and glossy paper only.

e  Printing resolution 2 applies to canvas, adhesive vinyl, scrim banner, backlit, proofing matte, proofing
gloss and digital fine arts paper.

Table 22-4 Margins

Top, right and left margins 5mm (0.2in)

Bottom margin (trailing edge) 5 mm (0.2 in) (roll)

17 mm (0.67 in) (sheet)

Table 22-5 Mechanical accuracy

+0.1% of the specified vector length or 0.2 mm (whichever is greater) at 23°C (73°F), 50-60% relative humidity, on E/AO printing
material in Best or Normal mode with HP Matte Film roll feed.

Table 22-6 Graphic languages supported

HP DesignJet Languages

75400 HP-PCL3GUI, HP-GL/2 and HP RTL, CALS G4, TIFF, JPEG, Adobe PDF 1.7, Adobe PostScript 3

Physical specifications

Table 22-7 Printer physical specifications

Weight 86 kg (189 1b)
Width 1770 mm (69.7 in)
Depth Minimum: 692 mm (27.2 in)

Maximum: 721 mm (28.4 in)

Height 1050 mm (41.3in)

The depth is measured without the upper spindle; wall spacers up; ink cover opened; roll covers and basket
closed.

Memory specifications

Table 22-8 Memory specifications

HP DesignJet Dedicated file-processing memory * Hard disk
75400 64 GB 320GB
* 640 MB physical DRAM
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Power specifications

Table 22-9 Printer power specifications

Source 100-240V ac £10%, auto-ranging
Frequency 50-60 Hz

Current <2A

Consumption <120wW

Ecological specifications

This product complies with European Union WEEE and RoHS Directives. To determine the ENERGY STAR
qualification status of these product models, please go to http://www.hp.com/go/energystar.

Environmental specifications

Table 22-10 Printer environmental specifications

Operating temperature 5 to 40°C (41 to 104°F)

Recommended operating temperature 15 to 35°C (59 to 95°F), depending on paper type
Storage temperature —25t055°C(-13 to 131°F)

Recommended operating humidity 20 to 80% RH, depending on paper type

Storage humidity 0t095%RH

Acoustic specifications
Printer acoustic specifications (declared according to IS0 9296).

Table 22-11 Printer acoustic specifications

Idle sound power level 4.1B(A)
Operating sound power level 6.7 B (A)
Idle sound pressure at bystander position 23 dB(A)
Operating sound pressure at bystander position 45 dB (A)
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Glossary

AppleTalk
A suite of protocols that Apple Computer developed in 1984 for computer networking. Apple now recommends TCP/IP
and Bonjour networking instead. HP DesignJet products no longer support AppleTalk.

Bonjour

Apple Computer's trade name for its implementation of the IETF Zeroconf specification framework, a computer network
technology used in Apple's Mac 0S X from version 10.2 onwards. It is used to discover services available on a local area
network. It was originally known as Rendezvous.

Color accuracy
The ability to print colors that match the original image as closely as possible, bearing in mind that all devices have a
limited color gamut and may not be physically capable of matching certain colors precisely.

Color consistency
The ability to print the same colors from a particular print job from print to print and from printer to printer.

Color model
A system of representing colors by numbers, such as RGB or CMYK.

Color space

A color model in which each color is represented by a specific set of numbers. Many different color spaces can use the
same color model: for instance, monitors generally use the RGB color model, but they have different color spaces,
because a particular set of RGB numbers results in different colors on different monitors.

Cutter
A printer component that slides back and forth across the platen to cut the paper.

ESD

ElectroStatic Discharge. Static electricity is common in daily life. It is the spark when touching the car door, or the cling
of clothing. Although controlled static electricity has some useful applications, uncontrolled electrostatic discharges are
one of the main hazards to electronic products. Therefore, to prevent damage some precautions are needed when
setting up the printer, or handling ESD sensitive devices. This type of damage may reduce the life expectancy of the
device. One way to minimize uncontrolled ESDs, and therefore reduce this type of damage is by touching any exposed
grounded part of the printer (mainly metal parts) before handling ESD sensitive devices (such as the printheads or ink
cartridges). Additionally, to reduce the generation of electrostatic charge in your body try to avoid working in a carpeted
area, and keep your body movements to a minimum when handling ESD sensitive devices. Also, avoid working in low
humidity environments.

Ethernet
A popular computer networking technology for local area networks.

Firmware
Software that controls your printer's functionality and is stored semi-permanently in the printer (it can be updated).

Gamut
The range of colors and density values reproducible on an output device, such as a printer or monitor.
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Gigabit Ethernet
An Ethernet network capable of transferring data at up to 1,000,000,000 bits/second. Gigabit Ethernet interfaces are
capable of negotiating slower speeds when required for compatibility with older Ethernet devices.

Hi-Speed USB
A version of USB, sometimes called USB 2.0, that can run 40 times faster than original USB, but is otherwise compatible
with original USB. Most personal computers today use Hi-Speed USB.

HPRTL
HP Raster Transfer Language: a language defined by HP to describe raster (bitmap) graphics.

HP-GL/2
HP Graphics Language 2: a language defined by HP to describe vector graphics.

1/0
Input/Output: this term describes the passing of data between one device and another.

1CC
The International Color Consortium, a group of companies that have agreed on a common standard for color profiles.

Ink cartridge
A removable printer component that stores ink of a particular color and provides it to the printhead.

IP address
May mean an IPv4 address (most likely) or an IPv6 address.

IPSec

A sophisticated mechanism for providing network security by authenticating and encrypting IP packets sent between
nodes on a network. Each network node (computer or device) has an IPSec configuration. Applications are usually
unaware whether IPSec is being used or not.

IPv4 address
A unique identifier that identifies a particular node on an IPv4 network. An IPv4 address consists of four integers
separated by full stops. Most networks in the world use IPv4 addresses.

IPv6 address

A unique identifier that identifies a particular node on an IPv6 network. An IPv6 address consists of up to 8 groups of
hexadecimal digits separated by colons. Each groups contains up to 4 hexadecimal digits. Only a few new networks in
the world use IPv6 addresses.

Jetdirect
HP's brand name for its series of print servers that allow a printer to be connected directly to a local area network.

LED
Light-Emitting Diode: a semiconductor device that emits light when electrically stimulated.

MAC address
Media Access Control address: a unique identifier used to identify a particular device on a network. It is a lower-level
identifier than the IP address. Thus, a device may have both a MAC address and an IP address.

Network

A network is a set of connections that pass data between computers and devices. Every device is able to communicate
with every other device in the same network. This allows data to be moved between computers and devices, and allows
devices such as printers to be shared between many computers.

Nozzle
One of many tiny holes in a printhead through which ink is deposited onto the paper.

Paper
A thin, flat material made to be written or printed on; most commonly made from fibers of some kind which are pulped,
dried and pressed.
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Platen
The flat surface within the printer over which the paper passes while it is being printed on.

Printer driver
Software that converts a print job in a generalized format into data suitable for a particular printer.

Printhead

A removable printer component that takes ink of one or more colors from the corresponding ink cartridge(s) and
deposits it on the paper, through a cluster of nozzles. In the HP DesignJet Z5400, each printhead prints two different
colors.

Spindle
Arod that supports a roll of paper while it is being used for printing.

TCP/IP
Transmission Control Protocol/Internet Protocol: the communications protocols on which the Internet is based.

USB
Universal Serial Bus: a standard serial bus designed to connect devices to computers. Your printer supports Hi-Speed
USB (sometimes called USB 2.0).

USB device port
A square USB socket found on USB devices, though which a computer can control the device. For a computer to print to
your printer using a USB connection, the computer must be connected to the printer's USB device port.

USB host port
A rectangular USB socket such as those on found on computers. A printer can control USB devices that are connected to
such a port. Your printer has two USB host ports, which it uses to control accessories and USB flash drives.

170 Glossary ENWW



Index

A
access control 25
accessories
order 116
account ID
requiring 26
accounting 93
accounting data by email 94
acoustic specifications 167
alerts
errors 155
turnonand off 25
warnings 155

B
banding problems 127
basket

output problems 126
black and white 76
black point compensation 80
blurred lines 140
brightness in front panel 30
buzzer on/off 30

C
calibration
color 73
cannot load paper 118
cleanthe platen 134
clean the printer 107
clipped at bottom 136
clippedimage 137
color
adjustment options 75
advantages 73
calibration 73
CMYK 73
emulation 78
inaccurate 136
printer emulation 75
profile 73
RGB 73

ENWW

color management
fromdrivers 74
fromEWS 79
from front panel 81
from printer driver 77
options 74
process 73
communication ports 7
components of printer 5
computer communication
printer/computer
communications issues 153
configure 30
connect the printer
choose amethod 13
general 13
Mac 0S X network 16
MacOSXUSB 18
Windows network 14
Windows USB 15
create paper preset 44
crop lines 59
Customer Care 161
Customer Self Repair 162
cutter
on/off 46

D
delete paper preset 43
disk erase, secure 109
draft for revision, print 84
draft printing 57
driver preferences 27
drying time

change 46

E
ecological specifications 167
economize

onink 62

onpaper 60
email notifications 25
email printing 64

Embedded Web Server

access 29
cannot access 154
job preview 68
job queue 68
language 30
usage perjob 93
usage statistics 93

environmental specifications 167
erase hard disk securely 109
error messages

front panel 157
log 159

features of printer 4
file system check 155
firmware update 108

manual setup 22
setup 21

front panel 8

brightness 30
job preview 65
job queue 65
language 29
units 30

frontview 5
front-panel option

adjust paper advance 127
align printheads 149

allow EWS 154

black point compensation 82
calibrate color 74

calibrate paper advance 127
clean printheads 146

CMYK source profile 81
color/grayscale 81
connectivity wizard 21, 154
emulate printer 81

enable buzzer 30

enable crop lines 60

enable cutter 47

Index 171



enable economode 58

enable maximum detail 59

enable merge 57

form feed and cut 47

Internet connectivity 21

modify configuration 31

move paper 46

PANTONE emulation 82

paper mismatch action 23

print connectivity config. 154

print diagnosticimage 141

print quality 53

Printer utility software 153

printhead information 100

rendering intent 81

replace ink cartridges 97

replace printheads 100

reset paper advance 128

resize 57

RGB source profile 81

roll protection 62

roll switching options 23

select display brightness 30

select drying time 46

select graphics language 32

select1/0 timeout 136

select language 29

select papersize 54

select paper type 120

select units 30

select wait time 62

sleep mode wait time 30

unload paper 39
functional specifications 165

G

graininess 132
graphic languages 166
gray shades 76

H
hard disk specification 166
HP Care Packs 161
HP Customer Care 161
HP ePrint Center
disable 26
HP Installation 162
HP Proactive Support 162
HP Start-Up Kit 161
HP Start-Up KitCD 2 HP
Support 163
HP Utility
access 29

172 Index

cannot access 153
language 30
HP-GL/2 32

|
image diagnostics print 141
image problems
clipped at bottom 136
clippedimage 137
missing objects 137
import paper preset 43
ink
economical use of 62
usage 93
ink cartridge
about 97
cannotinsert 145
insert 98
maintenance 107
order 112
remove 97
specification 165
status 97
status messages 145
internal prints 11
Internet connection
manual setup 21
setup 21
troubleshooting 154
IP address 29
IPSec 14
IPv6 14

J

Jetdirect print server 116

job preview
Embedded Web Server 68
front panel 65

job queue
Embedded Web Server 68
front panel 65

K
Knowledge Center 161

L

language 29

line length accuracy 140

line thickness 138

load paper
cannotload 118
general advice 34
paper notindriver 119
roll cannot load 118

roll into printer 36

roll onto spindle 34

sheet 40

sheet cannotload 119
loading paper problems 118

M
maintenance kits 109
margins 55

none 59

specification 166
mechanical accuracy 166
memory specifications 166
Microsoft Office

print from 89
misaligned colors 139
move the printer 107
multiroll printer 48

N
nesting 60

turn on and off 23
Network settings 30

0
on hold for paper 121
enable/disable 122
order
accessories 116
ink cartridges 112
paper 113
printheads 112
overlapping lines 57
overnight printing 62

P
pagesize 54
PANTONE emulation 77
PANTONE swatch book 80
paper
advance 47
calibrate the paper advance
cannotload 118
cut after printing 126
delete preset 43
displaying information 45
download presets 43
economical use of 60
feedand cut 47
incorrect out of paper 126
jamduetocutstrip 125
jammed 122

127

loading error messages 119

maintenance 46

ENWW



movement 46
not cutwell 126
not flat 132

output problems in basket 126

paper notindriver 119
preset creation 44
presets 43
print on loaded paper 56, 121
printed on wrong paper 121
retained by printer 126
roll loose on spindle 127
select type 56
sensitive 42
size 54
sizes (max and min) 165
usage 93
view information 42
paper mismatch action 23
paper notindriver 119
paper suitability 23
paper types 113
physical specifications 166
platencleaning 134
ports 7
power
on/off 10
power specifications 167
preferences, Windows driver 27
presentation, print 87
preview aprint 57
print by email 64
print from
Embedded Web Server 52
HP Utility 52
printer driver 53
USB flash drive 51
print job
nesting 60
print preview 57
print quality
select 53
print-quality problems
banding 131
black ink comes off 134
blurred lines 140
bottom of print 135
bronzing 135
discontinuous lines 139

edges darker than expected 135
edges stepped or notsharp 134

general 130

graininess 132
horizontal lines 131
inaccurate line lengths 140

ENWW

ink marks 133
line thickness 138
misaligned colors 139
paper not flat 132
scratching 133
scuffing 133
stepped lines 138
thin vertical lines 132
vertical lines of different colors
135
white spots 135
wizard 130
printer does not print 152
printer software 9
Mac 0S X uninstall 18

Windows uninstall 16
printer status 107

printer willnot start 152
printer's main components 5
printer's main features 4
Printer's security 32

printhead
about 99
align 148

cannotinsert 145
clean; purge 146
insert 103
order 112
remove 100
replace, reseat 145
specification 165
status 100
status messages 150
printhead cleaner
specification 165

printhead drop detector
clean 146

printing 50

printing resolutions 165
Proactive Support 162
project, print 84
protectaroll 62

Q
quality, high 58

R
rearview 6
remote printing

set preferences 22
renderingintent 80
rescaleaprint 56
roll paper

load 36

spindleload 34
unload 39

roll protection 62

roll switching options 23

S
safety precautions 2
scaleaprint 56
scratched prints 133
scuffed prints 133
secure disk erase 109
security 25
sensitive-paper mode 42
sheet paper
load 40
unload 41
sleep mode wait time 30
slow printing 152
software 9
software update 109
specifications
acoustic 167
ecological 167
environmental 167
functional 165
graphic languages 166
hard disk 166
ink supplies 165
margins 166
mechanical accuracy 166
memory 166
papersize 165
physical 166
power 167
printing resolutions 165
spindle 116
rollload 34
statistics
ink cartridge 97
usage 93
usage perjob 93
stepped lines 138
store the printer 107
support services
HP Care Packs 161
HP Customer Care 161
HP Proactive Support 162
HP Start-Up Kit 161
HP Support 163
Knowledge Center 161
printer installation 162
warranty extensions 161

Index 173



T
telephone number 163
tworolls 48

U
unattended printing 62
unload paper
roll 39
sheet 41
usage information
turnonand off 24
using this document 2

w
wall spacers 7
warranty extensions 161
Web connection
setup 21
Web Services
introduction 10
web services troubleshooting 155

174 Index ENWW



	Introduction
	Safety precautions
	HP Start-Up Kit
	Using this document
	Introduction
	Use and maintenance
	Troubleshooting
	Accessories, support and specifications
	Glossary
	Index
	Warnings and Cautions

	The printer’s main features
	The printer’s main components
	Front view
	Rear view
	Communication ports
	The wall spacers

	The front panel
	Printer software
	Web Services
	Turn the printer on and off
	The printer’s internal prints

	Installing the software
	Choose which connection method to use
	Connect the printer to your network
	Network configuration
	Using IPv6
	Using IPSec

	Connect a computer to the printer by network (Windows)
	Connect a computer to the printer by USB cable (Windows)
	Printer sharing considerations

	Uninstall the printer software (Windows)
	Connect a computer to the printer by network (Mac OS X)
	Bonjour connection
	TCP/IP connection

	Connect a computer to the printer by USB cable (Mac OS X)
	Sharing the printer

	Uninstall the printer software (Mac OS X)

	Setting up the printer
	Introduction
	Set up your Web-connected printer
	Web Services manual configuration
	Configure the printer’s Internet connection
	Configure firmware updates
	Set remote printing preferences

	Paper suitability options
	Paper mismatch action
	Roll switching options

	Turn nesting on and off
	Turn usage information on and off
	Turn email notifications on and off
	Turn alerts on and off (Windows only)
	Control access to the printer
	Front-panel security settings
	Embedded Web Server security settings
	Disable your HP ePrint Center connection

	Require account ID
	Set Windows driver preferences

	Personalizing the printer
	Change the language of the front-panel display
	Access the HP Utility
	Access the Embedded Web Server
	Change the language of the HP Utility
	Change the language of the Embedded Web Server
	Change the sleep mode setting
	Turn the buzzer on and off
	Change the front-panel display brightness
	Change the units of measurement
	Configure network settings
	Change the graphic language setting
	Manage ePrinter security
	Change your printer’s email address

	Paper handling
	General advice
	Load a roll onto the spindle
	Load a roll into the printer
	Unload a roll
	Quick procedure with paper on the roll
	Front panel procedure with paper on the roll
	Roll out of paper procedure
	Manual unload procedure

	Load a single sheet
	Unload a single sheet
	Sensitive-paper mode
	View information about the paper
	Paper presets
	To install a downloaded paper preset
	To create your own paper preset

	Printing paper info
	Move the paper
	Maintain paper
	Change the drying time
	Turn the automatic cutter on and off
	Feed and cut the paper

	Working with two rolls
	The uses of a multiroll printer
	How the printer allocates jobs to paper rolls

	Printing
	Introduction
	Print from a USB flash drive
	Print from a computer using the Embedded Web Server or HP Utility
	Print from a computer using a printer driver
	Advanced print settings
	Select print quality
	Select paper size
	Custom paper sizes

	Select margins options
	Print on loaded paper
	Rescale a print
	Change the treatment of overlapping lines
	Preview a print
	Print a draft
	High-quality printing
	If you have a high-resolution image

	Print in gray shades
	Print with no margins
	Print with crop lines
	Use paper economically
	Nest jobs to save roll paper
	When does the printer try to nest pages?
	What pages can be nested?
	Which pages qualify for nesting?
	How long does the printer wait for another file?

	Use ink economically
	Roll protection
	Unattended printing/overnight printing


	Web-connected printing
	Print by email

	Job queue management
	The job queue in the front panel
	Job queue page
	Job preview
	Select when to print a job in the queue
	Prioritize a job in the queue
	Pause a job in the queue
	Reprint a job from the queue
	Delete a job from the queue
	Delete all jobs
	Turn off the job queue

	The job queue in the Embedded Web Server or HP Utility
	Job queue page
	Job preview
	Select when to print a job in the queue
	Prioritize a job in the queue
	Delete a job from the queue
	Reprint or copy a job in the queue
	Job status messages
	Reactivate a job on hold

	Turn off the job queue


	Color management
	Introduction
	How colors are represented
	A summary of the color management process
	Color calibration
	Color management from printer drivers
	Color management options
	Printer emulation
	Color adjustment options
	Printing in color
	Printing in grayscale


	Color management from the printer driver
	HP Professional PANTONE Emulation
	Color emulation
	CMYK color emulation
	RGB color emulation


	Color management from the Embedded Web Server
	Submit Job options
	Rendering intent
	Perform black point compensation

	Printing PANTONE swatch books

	Color management from the front panel

	Practical printing examples
	Print a draft for revision with the correct scale
	Using Adobe Acrobat

	Print a project
	Using AutoCAD
	Using the Embedded Web Server to submit files
	Using printer emulation
	Using clip contents by margins

	Print a presentation
	Using AutoCAD
	Using Adobe Photoshop

	Print and scale from Microsoft Office
	Using PowerPoint
	Using Project
	Using Excel


	Retrieving printer usage information
	Get printer accounting information
	Check usage statistics
	Check usage statistics for a job
	Accounting statistics with the HP Utility
	Accounting statistics with the Embedded Web Server

	Request accounting data by email

	Handling ink cartridges and printheads
	About the ink cartridges
	Check the ink cartridges status
	HP Utility procedures

	Remove an ink cartridge
	Insert an ink cartridge
	About the printheads
	Check the printhead status
	Remove a printhead
	Insert a printhead

	Maintaining the printer
	Check printer status
	Clean the exterior of the printer
	Maintain the ink cartridges
	Move or store the printer
	Update the firmware
	Automatic firmware updates
	Manual firmware updates

	Update the software
	Printer maintenance kits
	Secure Disk Erase

	Accessories
	How to order supplies and accessories
	Order ink supplies
	Order paper
	Order accessories

	Introduction to the accessories
	Spindle
	Jetdirect print server


	Troubleshooting paper issues
	The paper cannot be loaded successfully
	General unsuccessful roll load issues
	Unsuccessful roll load
	Unsuccessful sheet load
	Paper loading error messages

	The paper type is not in the driver
	Transparent or translucent paper
	Glossy paper
	Matte Paper
	General-purpose paper
	Photographic paper

	Black ink is easily removed when touched
	After printing, the paper has wrinkles or there is too much ink

	The printer printed on the wrong paper type
	Automatic cut not available
	On hold for paper
	Which criteria are used to decide on which roll a job will be printed?
	When is a job put on hold for paper?
	If I load a new roll of paper, will jobs that were on hold for paper be automatically printed?
	I don’t like jobs being put on hold for paper. Can I prevent it?
	I set the option “Paper mismatch action” to Print anyway, but some jobs are still put on hold
	My job is exactly as wide as the roll of paper that is loaded on the printer, but is put on hold for ...

	The roll paper will not advance
	The paper has jammed
	A strip stays on the output tray and generates jams
	The printer displays out of paper when paper is available
	Prints do not fall neatly into the basket
	The sheet stays in the printer when the print has been completed
	The paper is cut when the print has been completed
	The cutter does not cut well
	The roll is loose on the spindle
	Recalibrate the paper advance
	Recalibrating the paper advance procedure
	Return to default calibration


	Troubleshooting print-quality issues
	General advice
	Print quality troubleshooting wizard
	Horizontal lines across the image (banding)
	Thin vertical lines across the image
	The whole image is blurry or grainy
	The paper is not flat
	The print is scuffed or scratched
	Ink marks on the paper
	Horizontal smears on the front of coated paper
	Ink marks on the back of the paper

	Black ink comes off when you touch the print
	Edges of objects are stepped or not sharp
	Edges of objects are darker than expected
	Bronzing
	Horizontal lines at the end of a cut sheet print
	Vertical lines of different colors
	White spots on the print
	Colors are inaccurate
	The image is incomplete (clipped at the bottom)
	The image is clipped
	Some objects are missing from the printed image
	Lines are too thick, too thin or missing
	Lines appear stepped or jagged
	Lines print double or in the wrong colors
	Lines are discontinuous
	Lines are blurred
	Line lengths are inaccurate
	The Image Diagnostics Print
	Corrective action

	If you still have a problem

	Troubleshooting ink cartridge and printhead issues
	Cannot insert an ink cartridge
	Ink cartridge status messages
	Cannot insert a printhead
	The front-panel display recommends reseating or replacing a printhead
	Clean the printheads
	Clean the printhead drop detector
	Align the printheads
	Reinsert printheads procedure
	Image-quality maintenance menu procedure
	Scanning errors during alignment

	Printhead status messages

	Troubleshooting general printer issues
	The printer will not start
	The printer does not print
	The printer seems slow
	Communication failures between computer and printer
	Cannot access the HP Utility
	Cannot access the Embedded Web Server
	Cannot connect to the Internet
	Web Services issues
	Automatic file system check
	Alerts

	Front-panel error messages
	The system error log

	HP Customer Care
	Introduction
	HP Professional Services
	Knowledge Center
	HP Start-Up Kit
	HP Care Packs and Warranty Extensions
	HP Installation

	HP Proactive Support
	Customer Self Repair
	Contact HP Support
	Telephone number


	Printer specifications
	Functional specifications
	Physical specifications
	Memory specifications
	Power specifications
	Ecological specifications
	Environmental specifications
	Acoustic specifications

	Glossary
	Index

